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Preface

This chapter describes the purpose and organization of this guide. The Preface 
contains the following information:
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■ Audience

■ How this Guide is Organized

■ Documentation Set

■ Related Publications

■ Conventions Used in this Guide
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Purpose of this Guide
This guide explains how to configure Oracle® Enterprise Manager Release 2.2. 

Oracle Enterprise Manager is a system management tool which provides an 
integrated solution for managing your heterogeneous environment. The product 
combines a graphical console, agents, common services, and tools to provide an 
integrated, comprehensive systems management platform for managing Oracle 
products.

For program updates and important notes on using Oracle Enterprise Manager, 
refer to the Oracle Enterprise Manager Readme.

After you have completed the configuration procedures, refer to the Oracle 
Enterprise Manager online help or the Oracle Enterprise Manager Administrator’s 
Guide for information on how to use Oracle Enterprise Manager.

Audience
This guide is written for DBAs and system administrators who wish to configure 
Oracle Enterprise Manager. You should already be familiar with Oracle and the 
administrative tasks you wish to perform.

For general information about the Oracle8i and how it works, refer to the Oracle8i 
Concepts Guide. For information about database administration procedures, refer to 
the Oracle8i documentation set. The Oracle8i documentation set contains specific 
and thorough descriptions of the database administration tasks you can perform 
with Oracle Enterprise Manager tools. In addition, the Oracle8i documentation set 
provides recommendations on how to administer your database optimally.

You should also be familiar with the operation of your specific Microsoft Windows 
or Unix system. Refer to the documentation for your Windows or Unix system, if 
necessary.
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How this Guide is Organized
This guide is comprised of the following chapters:

Chapter Description

Chapter 1, "Introducing Oracle Enterprise 
Manager"

This chapter provides an overview of 
Oracle Enterprise Manager 
configuration.

Chapter 2, "Creating a Release 2.2 Repository" This chapter describes how to create a new 
repository using Enterprise Manager 
Configuration Assistant. 

Chapter 3, "Controlling the Management 
Server"

This chapter describes how to start, stop, 
and check the status of the Oracle 
Management Server.

Chapter 4, "Adding Additional Management 
Servers"

This chapter describes how to add an 
additional Management Server to manage 
an already existing repository.

Chapter 5, "Starting and Stopping the 
Intelligent Agent"

This chapter describes how to start the 
Oracle Intelligent Agent.

Chapter 6, "Setting Up the Console" This chapter describes how to configure 
and start Oracle Enterprise Manager 
Release 2.2.

Chapter 7, "Migrating a Release 1.x Repository 
to a Release 2.2 Repository"

This chapter describes methods for 
migrating the user’s private Release 1.x 
repositories into a specific user in a new 
Release 2.2 repository.

For information about upgrading a Release 
2.0 or 2.1 repository to a Release 2.2 
repository, refer to "Upgrade a Release 2.0 
or 2.1 Repository to a Release 2.2 
Repository" on page B-1.

Chapter 8, "Setting Up DBA Studio" This chapter describes how to set up DBA 
Studio.

Appendix A, "Directory Structure" This appendix describes the directory 
structure of Oracle Enterprise Manager 
Release 2.2.
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Appendix B, "Configuration Assistant 
Operations"

This appendix describes how to upgrade a 
repository, how to drop a repository, and 
how to redirect the local Management 
Server to use a different repository or to 
respond to changes in the repository user’s 
password.

Appendix C, "Upgrading the Intelligent Agent 
and Data Gatherer"

This appendix describes the process for 
upgrading the Intelligent Agent and Data 
Gatherer.

Appendix D, "Troubleshooting" This appendix describes possible issues for 
troubleshooting.

Appendix E, "Repository Sizing" This appendix contains recommendations 
for repository sizing.

Appendix F, "Configuring the Webserver and 
Directory Mapping"

This appendix contains information about 
configuring your webserver and directory 
mapping if you did not install the Oracle 
HTTP Server that is packaged with 
Enterprise Manager by default.

Appendix G, "Keyboard Shortcuts" This appendix provides a list of general 
Windows keyboard shortcuts.

Chapter Description
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Documentation Set
The Oracle Enterprise Manager Release 2.2 documentation includes the following:

■ The Oracle Enterprise Manager Readme Release 2.2 provides important notes on 
updates to the software and other late-breaking news, as well as any differences 
between the product’s behavior and how it is documented.

■ The Oracle Enterprise Manager Configuration Guide Release 2.2 provides 
information about configuring the Oracle Enterprise Manager system.

■ The Oracle Enterprise Manager Concepts Guide Release 2.2 provides an overview 
of the Enterprise Manager system.

■ The Oracle Enterprise Manager Administrator’s Guide Release 2.2 describes the 
components and features of the Oracle Enterprise Manager system.

■ The Oracle Intelligent Agent Users Guide describes how to administer the Oracle 
Intelligent Agent.

■ The Oracle Enterprise Manager Messages Manual Release 2.2 contains probable 
causes and recommended actions for Oracle Enterprise Manager errors.

In addition to the Oracle Enterprise Manager documentation set, extensive on-line 
help is provided for components in Oracle Enterprise Manager.

To download free release notes or installation documentation, please visit the Oracle 
Documentation Center at http://docs.oracle.com/ 

Printed documentation is available for sale in the Oracle Store at 
http://oraclestore.oracle.com/ 
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Related Publications
The Oracle Enterprise Manager Configuration Guide refers to important information in 
the related publications. The related books referred to in this guide are listed below:

■ For general information about the Oracle8i and how it works, refer to Getting to 
Know Oracle8i and Oracle8i Concepts.

■ For information about administering the Oracle8i, refer to the Oracle8i 
Administrator’s Guide.

■ For the procedures for migrating a previous version of Oracle, refer to Oracle8i 
Migration.

■ For information on Oracle’s SQL commands and functions, refer to the Oracle8i 
SQL Reference.

■ For information about utilities bundled with the Oracle8i, refer to the Oracle8i 
SQL Reference.

■ For information about Oracle messages and codes, refer to Oracle8i Error 
Messages.

■ For information about the Oracle networking system, refer to your 
network-specific documentation.

■ For information on Oracle Parallel Server, refer to the Oracle8i Parallel Server 
Setup and Configuration Guide, which provides essential information for 
preparing Oracle8i for use with Oracle Parallel Server and Oracle Enterprise 
Manager. The "Introducing Oracle Parallel Server" chapter provides a 
conceptual and component overview of Oracle Parallel Server. This information 
will help you prepare and plan your Oracle Parallel Server installation and 
configuration in an Oracle8i environment. 
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Conventions Used in this Guide
The following sections explain the conventions used in this guide.

Examples
This guide contains code examples. Note that the text of examples appears in a 
different font than the text of the guide. This is an example of a SELECT statement: 

SELECT * FROM emp

Examples in this guide follow these case conventions: 

■ Keywords, such as CREATE and NUMBER, appear in uppercase. Keywords 
have special meanings. When you specify them, they can be in uppercase or 
lowercase, but they must be used exactly as they appear in the code example.

■ Names of database objects and their parts, such as emp and empno, appear in 
lowercase. However, in the text of this guide, names of database objects and 
their parts appear in uppercase.

■ Parameters act as place holders in examples. They appear in lowercase. 
Parameters are usually names of schema objects, Oracle datatypes, or 
expressions. When there is parameter in a syntax diagram, you should 
substitute an object or expression of the appropriate type. Note that parameter 
names appear in italics in the text of this guide.

Command Syntax
■ Italics is used for variables, such as application_name. Substitute an 

appropriate value. 

■ | denotes alternative choices

■ {param1 | param2 | ... } signifies that one of the parameters in {} must be used. 
Do not type the brackets.

■ [  ] identifies optional parameters. Do not type the brackets.
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                                                            Introducing Oracle Enterprise Ma
1

Introducing Oracle Enterprise Manager

Oracle Enterprise Manager is a system management tool which provides an 
integrated solution for centrally managing your heterogeneous environment. Oracle 
Enterprise Manager combines management applications such as the Console, 
Oracle Management Servers, Oracle Intelligent Agents, common services, and tools 
to provide an integrated, comprehensive systems management platform for 
managing Oracle products.

This introduction discusses the topics listed below:

■ Oracle Enterprise Manager’s Architecture

■ Basic Terminology

■ Oracle Enterprise Manager System and Hardware Requirements

■ Oracle Enterprise Manager Release 2.2 Certification

■ Overview of Oracle Enterprise Manager Configuration
nager 1-1



Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager is based on a highly scalable three-tier model.

Figure 1–1 Three-Tier Architecture
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Oracle Enterprise Manager’s Architecture
The first tier, the client, consists of a Java-based Console and integrated 
applications. 

Figure 1–2 First Tier
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Oracle Enterprise Manager’s Architecture
The second tier is the Management Server or designated group of Management 
Servers which manages the flow of information between the clients and targets.

Figure 1–3 Second Tier
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Oracle Enterprise Manager’s Architecture
The third tier is comprised of targets, such as databases, nodes, or other managed 
services. An Intelligent Agent resides on each target node and monitors the services 
in the target for registered events (potential problem occurrences) and executes jobs 
sent by the Console via the Oracle Management Server(s). Only one Intelligent 
Agent can run on a single machine, regardless of the number of services on that 
machine.

Figure 1–4 Third Tier
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Oracle Enterprise Manager’s Architecture
Oracle Enterprise Manager’s three main components are listed below: 

Figure 1–5 Oracle Enterprise Manager’s Components

Component Function

Console The Console gives you a central point of control for the Oracle 
environment through an intuitive graphical user interface (GUI) that 
provides powerful and robust system management. 

Management Server The Oracle Management Server authenticates the Oracle Enterprise 
Manager administrator, processes management functions, and 
provides a centralized data store of administrative information. The 
administrative information includes jobs, events, groups, and 
preferred credentials. Administrators who share responsibility for a 
managed target (for example, a database) can share administrative 
information for that target.

Intelligent Agent The Intelligent Agent is a process that runs on managed nodes in the 
network. It functions as the executor of jobs and events sent by the 
Console via the Management Servers. 
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Basic Terminology
Basic Terminology

What is a repository?
A repository is a set of tables in a database containing the internal state information 
of Enterprise Manager for the managed environment and information about the 
management packs. It is used as a back-end store by the Oracle Management 
Servers, providing distributed control between clients and managed nodes.

What is a repository user?
An Enterprise Manager repository is owned by a database user. During repository 
creation a repository’s user name is entered that will be used to create this database 
user. 

The name of the repository user will also be the name of this repository, and this 
name will be used throughout the network to identify all the objects in this 
repository. The name of the repository must be a unique schema name across the 
entire managed network.

If the repository user name and encrypted password are saved during repository 
creation, the Management Server uses them to login to the repository; if they are not 
saved, the Management Server prompts the user for a user name and password 
before it starts up.

What is an administrative user?
An Oracle Enterprise Manager administrative user is an account that provides users 
permission to perform administrative tasks and access administrative information. 
An administrative account is usually created for each person on an administrative 
team. Preferences, such as preferred credentials, login password, and email and 
paging notification schedules, must be set for each administrator. Generally each 
person has a single administrative user account through which he administers 
several to many targets. 

Administrative user accounts are created by the super administrator. Oracle 
Enterprise Manager is installed with a default super administrator account which 
can be used for the initial login. The super administrator account is sysman and the 
initial password is oem_temp. The password must be changed after the initial login. 
The super administrator account is similar to root on UNIX or Administrator 
on Windows NT and is a user which cannot be deleted or renamed.
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What is a Console?
The Console, a graphical interface for administrators and the central launching 
point for all applications (including the integrated applications), is a Java-based 
application that can be run as either a "thin" or "fat" client. Thin clients use a web 
browser to connect to a server where Console files are installed, whereas fat clients 
require Console files to be installed locally. 

However you run the Console, it relies on the Oracle Management Server and the 
Oracle Intelligent Agent to perform system management tasks. 

What is an Oracle Management Server?
The Management Server is the core of the Enterprise Manager framework. It 
provides administrative user accounts, processes management functions such as 
jobs and events, and manages the flow of information between the tiers.

As the number of nodes and managed services in your network increases or if the 
current Management Server is overloaded, you can add more Oracle Management 
Servers to the middle tier to share and balance the workload. These additional 
Management Servers provide fault-tolerance in the case where one Management 
Server becomes unavailable. All Management Servers administering the same set of 
managed nodes share a single Repository, which stores all system data, application 
data, and the state of managed nodes throughout the environment. 

What is the Oracle Intelligent Agent?
An Oracle Intelligent Agent is a process on a managed server, which monitors 
registered events and runs scheduled jobs against all discovered services on that 
server. Only one Intelligent Agent is required per node regardless of the number of 
services present on that machine. Intelligent Agents function independently of the 
database or services they support, as well as being independent of the Management 
Server and Console clients. 

Note: Administrator user accounts are specific to Oracle Enterprise 
Manager and are different than Oracle database users.
1-8 Oracle Enterprise Manager Configuration Guide                             



Basic Terminology
What is service discovery?
There are two types of discovery:

■ Automatic discovery performed by the Intelligent Agent to record the list of all 
services that it can manage

■ Service discovery performed by the Console to obtain the list of services from 
the Intelligent Agent so that the Console Navigator can display the services

Without the Intelligent Agent discovery, there is no Console discovery. Both 
discoveries must be successful and must happen in the correct order for the services 
to appear in the Console Navigator.

When you use the Discovery Wizard in the Console, the Management Server 
contacts the Intelligent Agent installed on that node to discover the Oracle services 
installed on the node.

When the Intelligent Agent starts, it performs its service discovery by scanning the 
system for Oracle services to manage. The Intelligent Agent records the service 
discovery. When the Console requests a discovery of the node, the Intelligent Agent 
transmits the service discovery information it has detected to the Management 
Server.

The Management Server then places the new information in the repository, and 
updates the Console Navigator, displaying a view of all nodes and their respective 
services.

Service discovery allows administrators to run jobs and monitor for events on those 
nodes and allows the information to be centrally managed by the Consoles.

What is a Managed Node?
A managed node is any machine that is being monitored by an Intelligent Agent 
that has been discovered by the Console.

What is a Managed Service/Managed Target?
Every service running on a managed node is a managed service or target. Multiple 
services (targets) can exist on a single machine (node).
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What are preferred credentials?
This section contains information about:

■ preferred credential saved through the Oracle Enterprise Manager Console

■ local preferred credentials saved through DBA Studio

Preferred Credentials Saved Through the Oracle Enterprise Manager Console
Each administrator can set up specific usernames, passwords, and roles (NORMAL, 
SYSOPER, or SYSDBA) for nodes, listeners, databases, and other services that you 
administer in the network.

After you set up preferred credentials, you are no longer prompted for credentials 
when connecting to the managed targets. 

The Preferred credentials you set up through the Console also allow you to use the 
job and event system for targets where credentials are required. All login credentials 
set up through the Console are encrypted in the repository. 

Local Preferred Credentials Saved Through DBA Studio
DBA Studio stores a list of databases that are displayed in the DBA Studio navigator 
tree. If preferred credentials are specified for any of these databases, the username, 
encrypted password, and role are added to a local file.

Saving or editing preferred credentials is an option which enables you to store login 
information, such as username, password, and role (NORMAL, SYSOPER, or 
SYSDBA). Passwords are always stored in encrypted format. This login information 
is used when a connection is established for the database instead of having to type a 
username and password each time.
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Oracle Enterprise Manager System and Hardware Requirements
You can run Oracle Enterprise Manager components in any configuration 
depending on your management environment. For example, you can run each tier 
on separate machines or run all three tiers on one machine.

Running Enterprise Manager components on separate machines requires the 
following:

Client-Only
Machine running only the Console and DBA Management Pack:

■ Pentium 266 MHz or SPARC 20

■ 128 MB RAM

■ 190 MB available hard disk space (on NTFS). FAT can consume as much as four 
times as much disk space as NTFS.

Client-Server
Running the entire Enterprise Manager bundle (Console, DBA Management Pack, 
Oracle Management Server and database repository) from a single machine requires 
the following:

■ Pentium II 400 MHz or SPARC Ultra 1

■ 256 MB RAM

■ 190 MB available hard disk space (on NTFS). FAT can consume as much as four 
times as much disk space as NTFS. 190 MB includes 6-26 MB for configuring the 
Repository. Refer to Appendix E, "Repository Sizing" for information on how 
much you can expect your repository to grow. 

Note: Examples of requirements for Windows-based machines are 
listed below.
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Running the Enterprise Manager Console from a web browser requires 128 MB 
RAM. 

Downloading Enterprise Manager from the webserver requires 50 MB of disk space.

The default Enterprise Manager package (using a single Oracle Management Server 
in your environment) is tuned to best support an environment with the following 
characteristics: 

■ Up to 64 managed nodes 

■ Up to 256 managed database instances or other managed targets (up to 10 
managed targets on any one node) 

■ Up to 15 Consoles actively being used at one time 

If the available Management Servers are CPU-bound (the CPU usage is exhausted), 
adding additional Management Servers is an alterative to increasing the capacity of 
the nodes that run the Management Servers.

To improve performance when the number of Consoles, jobs or events increases, 
Oracle recommends increasing resource capacity on the Repository database 
machine. 

Note: The requirements outlined above assume that a database for the 
Enterprise Manager Repository already exists. If a database has not 
already been installed, you must install one. For recommended system 
and hardware requirements for an Oracle database, refer to the 
installation guide provided with that database release.
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Oracle Enterprise Manager Release 2.2 Certification
Oracle Enterprise Manager Release 2.2 is certified on the following operating 
systems:

■ Windows 95

■ Windows 98

■ Windows NT, SP4 and higher

■ Windows 2000

■ Solaris 2.6

■ Solaris 2.7

The Management Server is not certified on Windows 95 or Windows 98.

Browser-based Oracle Enterprise Manager is only supported on the following 
operating systems: Windows 95, Windows 98, Windows NT, and Windows 2000.
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Overview of Oracle Enterprise Manager Configuration
The tables below outline the steps needed for various Enterprise Manager 
configurations:

■ Configuring Oracle Enterprise Manager Quickly (Quick Start)

■ Configuring Oracle Enterprise Manager for a Large Enterprise

■ Upgrading Your Oracle Enterprise Manager Framework and Management 
Packs

■ Migrating Your Repository

Details of the steps involved can be found in the indicated sections.

Configuring Oracle Enterprise Manager Quickly (Quick Start)
The following configuration may be used for most small to medium-sized 
environments. Small to medium-sized environments are environments which 
administer fewer than 64 managed nodes. 

In this configuration, the middle-tier and client-tier Oracle Enterprise Manager 
components are on the same node.

Note: The information below is for new installations. For guidelines to 
upgrading your Oracle Enterprise Manager framework and 
Management Packs from previous 2.x releases to Release 2.2, refer to 
"Upgrading Your Oracle Enterprise Manager Framework and 
Management Packs" on page 1-19. 
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Table 1–1 Quick Start—Target Node Tier Configuration

Procedure Refer to

1. Make sure you have installed an Intelligent Agent on the node to be 
managed. If not, install a version of the Intelligent Agent which is 
the same or higher than the highest version of the database present 
on the machine.

If the Intelligent Agent version is the same as the database version, 
you can install them in the same ORACLE_HOME, otherwise the 
Intelligent Agent will have to be installed in a separate 
ORACLE_HOME.

Refer to the installation guide 
provided with the database release.

2. Start the Intelligent Agent, and check that all services are recorded 
in the services.ora file which is located in the 
ORACLE_HOME/network/agent directory.

Refer to the Oracle Intelligent 
Agent User’s Guide for details if 
you encounter any problems.

Table 1–2 Quick Start—Middle Tier and Client Tier Configuration

Procedure Refer to

1. Use an existing database for the Oracle Management Server 
repository or install and use a new Oracle database.

Refer to the installation guide 
provided with the database release.

2. Install the Management Server, and the Oracle Enterprise Manager 
client software in a new ORACLE_HOME.

If you are installing from the database CD, choose the install type: 
Oracle8i Management and Integration->Oracle Management 
Server.

If you are installing from the separately licensable packs CD, 
choose the install type: Oracle Enterprise Manager Packs and 
Management Infrastructure.

Refer to the installation guide 
provided with the database release 
or the installation guide provided 
with the separately licensable 
packs.

3. At the end of installation, create a repository in your database. 
Depending on which installation type you have chosen, the Oracle 
Enterprise Configuration Assistant may be run automatically.

Refer to "Creating a Release 2.2 
Repository" on page 2-1 to create a 
repository using the Oracle 
Enterprise Configuration Assistant.

4. Make sure the Management Server is running.

Note: The repository database must be started and open and the 
listener must be started before starting the Management Server. 
Otherwise, an error occurs.

Refer to "Controlling the 
Management Server" on page 3-1.
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Configuring Oracle Enterprise Manager for a Large Enterprise
The following configuration is best for large environments with many managed 
databases and services. Large environments are environments which administer 
more than 64 managed nodes.

5. Launch the Console (client), and at the login, point to the 
Management Server on the same node.

Refer to "Starting the Enterprise 
Manager Console" on page 6-3.

Note: The information below is for new installations. For guidelines to 
upgrading your Oracle Enterprise Manager framework and 
Management Packs from previous 2.x releases to Release 2.2, refer to 
"Upgrading Your Oracle Enterprise Manager Framework and 
Management Packs" on page 1-19. 

Table 1–3 Large Enterprises—Target Node Tier Configuration—Machine A

Procedure Refer to

1. Make sure you have installed an Intelligent Agent on the node to be 
managed. If not, install a version of the Intelligent Agent which is 
the same or higher than the highest version of the database present 
on the machine.

If the Intelligent Agent version is the same as the database version, 
you can install them in the same ORACLE_HOME, otherwise the 
Intelligent Agent will have to be installed in a separate 
ORACLE_HOME.

Refer to the installation guide 
provided with the database release.

2. Start the Intelligent Agent, and check that all services are recorded 
in the services.ora file which is located in the 
ORACLE_HOME/network/agent directory.

Refer to the Oracle Intelligent 
Agent User’s Guide for details if 
you encounter any problems.

Table 1–2 Quick Start—Middle Tier and Client Tier Configuration(Cont.)

Procedure Refer to
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Table 1–4 Large Enterprises—Middle Tier (Repository) Configuration—Machine B

Procedure Refer to

Use an existing database for the Oracle Management Server repository 
or install and use a new Oracle database.

■ If you are using an existing database, run the Oracle Enterprise 
Configuration Assistant to create a repository.

■ If you are installing a new database, at the end of installation, create 
a repository in your database. Depending on which installation 
type you have chosen, the Oracle Enterprise Configuration 
Assistant may be run automatically.

Refer to the installation guide 
provided with the database release.

Refer to "Creating a Release 2.2 
Repository" on page 2-1 to create a 
repository using the Oracle 
Enterprise Configuration Assistant.

Table 1–5 Large Enterprises—Middle Tier (Management Server) 
Configuration—Machine C

Procedure Refer to

1. Install the Management Server in a new ORACLE_HOME.

If you are installing from the database CD, choose the install type: 
Oracle8i Management and Integration->Oracle Management 
Server.

If you are installing from the separately licensable packs CD, 
choose the install type: Oracle Enterprise Manager Packs and 
Management Infrastructure--> Custom-->Oracle Management 
Server.

Refer to the installation guide 
provided with the database release 
or the installation guide provided 
with the separately licensable 
packs.

2. Run the Oracle Enterprise Configuration Assistant to set up the 
Management Server to manage an already existing 
repository.

Refer to "Edit Configuration 
Parameters" on page B-9.

3. Make sure the Management Server is running.

Note: The repository database must be started and open and the 
listener must be started before starting the Management Server. 
Otherwise, an error occurs.

Refer to "Controlling the 
Management Server" on page 3-1.
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Table 1–6 Large Enterprises—Client Tier Configuration—Machine D

Procedure Refer to

Install the Oracle Enterprise Manager client software in a new 
ORACLE_HOME.

If you are installing from the database CD, choose the install type: 
Oracle8i Client->Administrator.

If you are installing from the separately licensable packs CD, choose the 
install type: Oracle Enterprise Manager Packs and Management 
Infrastructure.

Refer to the installation guide 
provided with the database release 
or the installation guide provided 
with the separately licensable 
packs.

Launch the Console (client), and at the login, point to the Management 
Server.

Refer to "Starting the Enterprise 
Manager Console" on page 6-3.

Note: If you want to have multiple clients working concurrently, install 
the client software on multiple clients. 

Table 1–7 Large Enterprises—Middle Tier (Additional Management Servers) 
Configuration—Machine E, F...

Procedure Refer to

1. If the current Management Server is overloaded, install additional 
Management Servers on different machines.

If you are installing from the database CD, choose the install type: 
Oracle8i Management and Integration->Oracle Management 
Server.

If you are installing from the separately licensable packs CD, 
choose the install type: Oracle Enterprise Manager Packs and 
Management Infrastructure--> Custom-->Oracle Management 
Server.

Refer to the installation guide 
provided with the database release 
or the installation guide provided 
with the separately licensable 
packs.

2. Run the Oracle Enterprise Configuration Assistant on each of the 
machines to set up the Management Server to manage an 
already existing repository.

Refer to "Adding Additional 
Management Servers" on page 4-1.
1-18 Oracle Enterprise Manager Configuration Guide                             



Overview of Oracle Enterprise Manager Configuration
Upgrading Your Oracle Enterprise Manager Framework and Management Packs
The upgrade of the Oracle Enterprise Manager framework (Console, Management 
Server, repository, and Intelligent Agent) and Management Packs from previous 2.x 
releases to Release 2.2 must be performed in the order documented below. 

3. Make sure the Management Server is running.

Note: The repository database must be started and open and the 
listener must be started before starting the Management Server. 
Otherwise, an error occurs.

Refer to "Controlling the 
Management Server" on page 3-1.

Important: The Enterprise Manager Console, DBA Management Pack, 
separately licensable Packs, Management Server and repository must all 
be of the same release. For example, you cannot use a Release 2.1 
Management Server and repository with a Release 2.2 Console nor can 
you use a Release 2.2 Management Server and repository with a Release 
2.1 Pack.

If the existing Management Server and repository are of a previous 
version, then you can migrate or upgrade them to the most recent 
version. In the case of migrating or upgrading a Management Server and 
repository to Release 2.2, ensure that all Enterprise Manager products 
you intend to use with the repository are of Release 2.2. For instance, do 
not upgrade the Management Server and repository to Release 2.2 if you 
are still using Diagnostics Pack Release 2.1 or Change Management Pack 
Release 2.1. 

Table 1–7 Large Enterprises—Middle Tier (Additional Management Servers) 
Configuration—Machine E, F...(Cont.)

Procedure Refer to
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Table 1–8 Upgrading Your Framework and Management Packs

Procedure Reference

1. Upgrade all components such as the Oracle Enterprise Manager 
Console, the Management Server, DBA Studio, and any other 
separately licensable packs you have installed.

Refer to the installation guide 
provided with the database release 
and the installation guide provided 
with the separately licensable 
packs.

2. Upgrade your repository from Release 2.x to Release 2.2. You 
should not schedule any repository upgrades until all Oracle 
Enterprise Manager components other than the Intelligent Agent 
have been upgraded to Oracle Enterprise Manager Release 2.2.

Refer to "Upgrade a Release 2.0 or 
2.1 Repository to a Release 2.2 
Repository" on page B-1

3. Upgrade the Intelligent Agent to Release 8.1.7 for each managed 
node. 

Note: If the 8.1.7 Intelligent Agent is installed in a new home, you 
must copy the .Q files over to the new home. 

Note: The Intelligent Agent and Agent Data Gatherer must be the 
last components to be upgraded because once the Intelligent Agent 
is upgraded to Release 8.1.7, the pre-2.2 components such as the 
Management Server will consider the Intelligent Agent invalid. 

Refer to "Upgrading the Intelligent 
Agent and Data Gatherer" on page 
C-1.

4. Upgrade the Agent Data Gatherer to Release 8.1.7 for each node 
that you have configured for collections.

Refer to "Upgrading the Intelligent 
Agent and Data Gatherer" on page 
C-1.
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Migrating Your Repository
An Oracle Enterprise Manager Release 1.x repository schema is not the same as an 
Oracle Enterprise Manager "shared" Release 2.2 repository schema. In Enterprise 
Manager Release 1.x, each administrator had a separate repository schema which 
contained the current view of the network and user-specific information. In 
Enterprise Manager Release 2.2, administrators have accounts within a single 
shared repository schema, and all individual preferences are stored in the 
administrator’s account.

Each Release 1.x repository must be separately migrated to a new Release 2.2 
repository.

The procedures below highlight the basic steps for migrating a repository.

Table 1–9 Create New Release 2.2 Repository

Procedure Refer to

1. Use an existing database for the new Oracle Management Server 
Release 2.2 repository or install and use a new Oracle database.

Refer to the installation guide 
provided with the database release.

2. Install the Management Server, Enterprise Manager Migration 
Assistant, and the Oracle Enterprise Manager client software in a 
new ORACLE_HOME.

If you are installing from the database CD, choose the install type: 
Oracle8i Management and Integration->Oracle Management 
Server.

If you are installing from the separately licensable packs CD, 
choose the install type: Oracle Enterprise Manager Packs and 
Management Infrastructure.

Refer to the installation guide 
provided with the database release 
or the installation guide provided 
with the separately licensable 
packs.

3. At the end of installation, create a new Release 2.2 repository in 
your database. Depending on which installation type you have 
chosen, the Oracle Enterprise Configuration Assistant may be run 
automatically.

Refer to "Creating a Release 2.2 
Repository" on page 2-1 to create a 
repository using the Oracle 
Enterprise Configuration Assistant.

4. Make sure the Release 2.2 Management Server is running.

Note: The Release 2.2 repository database must be started and open 
and the listener must be started before starting the Management 
Server. Otherwise, an error occurs.

Refer to "Controlling the 
Management Server" on page 3-1.

5. Launch the Release 2.2 Console (client), and at the login, point to 
the Management Server on the same node.

Refer to "Starting the Enterprise 
Manager Console" on page 6-3.
                                                                    Introducing Oracle Enterprise Manager 1-21



Overview of Oracle Enterprise Manager Configuration
Table 1–10 Prepare for Migration

Procedure Refer to

1. Create administrator accounts. Refer to"Creating Administrator 
Accounts" on page 6-6.

2. Refresh All Services in the Release 1.x Console. Refer to the Release 1.x Oracle 
Enterprise Manager 
Administrator’s Guide.

3. Shut Down the Release 1.x Console. Refer to the Release 1.x Oracle 
Enterprise Manager 
Administrator’s Guide.

4. Shut Down the Release 2.2 Management Server Refer to "Controlling the 
Management Server" on page 3-1.

5. Back Up the Existing Release 1.x Repository. For detailed information about the 
Export utility, refer to Oracle8i 
Release 2 (8.1.6) Utilities.

Table 1–11 Migrate Release 1.x Repository to Release 2.2 Repository

Procedure Refer to

Run the Release 2.2 Oracle Enterprise Manager Migration Assistant to 
migrate data you are using in your V1.x environment from one or 
multiple private repositories into a specific user in your new Release 2.2 
repository.

Refer to "Migrating a Release 1.x 
Repository to a Release 2.2 
Repository" on page 7-1.
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Creating a Release 2.2 Repository

In Oracle Enterprise Manager, a repository contains state information for the 
managed environment and information about the management packs. The 
repository is used as a back-end store by the Oracle Management Servers, providing 
distributed control between clients and managed nodes.

In Release 2.0, the Enterprise Manager Configuration Assistant only created the 
repository for the base Oracle Enterprise Manager product. Additional parts of the 
repository were only created when they were required.

In Release 2.1 and later, it now creates the repository for all Oracle Enterprise 
Manager products. No additional components need to be added to the repository 
later. The Oracle Enterprise Manager repository is treated by the Enterprise 
Manager Configuration Assistant as a single entity. Regardless of whether you have 
additional products installed, creating a repository will create all parts of a 
repository.

The Enterprise Manager Configuration Assistant provides a database administrator 
with repository creation, removal, upgrade, and configuration parameter 
maintenance. A repository is a schema, and several repositories can exist in one 
database since each repository is a different schema.

If you are using a Release 2.0 or 2.1 repository and want to upgrade your repository 
to Release 2.2, refer to "Upgrade a Release 2.0 or 2.1 Repository to a Release 2.2 

Note: For information on the recommended init.ora settings for the 
repository database, refer to "Recommended init.ora Settings for the 
Repository Database" on page 2-19. 

You can change the settings before or after repository creation.
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Repository" on page B-1. Existing pre-2.2 repositories are not upgraded 
automatically during installation.

If you are using a previous Enterprise Manager Release 1.x and want to migrate 
your 1.x repository or repositories directly to a Release 2.2 repository, you will need 
to perform additional steps using the Enterprise Manager Migration Assistant after 
creating your Release 2.2 repository. Refer to Chapter 7, "Migrating a Release 1.x 
Repository to a Release 2.2 Repository" for information about migrating one or 
more Release 1.x repositories into the shared Release 2.2 repository schema.

Note:   You should not schedule any repository upgrades until all 
Oracle Enterprise Manager components other than the Intelligent Agent 
have been upgraded to Oracle Enterprise Manager Release 2.2. For 
guidelines to upgrading your Oracle Enterprise Manager framework and 
Management Packs from previous 2.x releases to Release 2.2, refer to 
"Upgrading Your Oracle Enterprise Manager Framework and 
Management Packs" on page 1-19. 
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Important: The Enterprise Manager Console, DBA Management Pack, 
separately licensable Packs, Management Server and repository must all 
be of the same release. For example, you cannot use a Release 2.1 
Management Server and repository with a Release 2.2 Console nor can 
you use a Release 2.2 Management Server and repository with a Release 
2.1 Pack.   Any Enterprise Manager Release 2.2 product must use a 
Release 2.2 Management Server and repository, where product refers to 
any of the following:

■  Oracle Enterprise Manager Console

■  Oracle DBA Management Pack (in Management Server mode)

■  Oracle Tuning Pack

■  Oracle Diagnostics Pack

■  Oracle Change Management Pack

■  Oracle Management Pack for Oracle Applications

■  Oracle Management Pack for SAP R/3

■  Oracle Standard Management Pack

If the existing Management Server and repository are of a previous 
version, then you can migrate or upgrade them to the most recent 
version. In the case of migrating or upgrading a Management Server and 
repository to Release 2.2, ensure that all Enterprise Manager products 
you intend to use with the repository are of Release 2.2. For instance, do 
not upgrade the Management Server and repository to Release 2.2 if you 
are still using Diagnostics Pack Release 2.1 or Change Management Pack 
Release 2.1. If you upgrade your Management Server and repository to 
Release 2.2 before obtaining the Release 2.2 Pack software you intend to 
use, you will not be able to use the older Pack product(s).
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Creating a New Release 2.2 Repository
The Oracle Enterprise Manager Release 2.2 repository is not the same as a Release 
1.x repository. In Enterprise Manager Release 1.x, each administrator has his own 
repository schema, which contains a current view of the network and user-specific 
information. In Enterprise Manager Release 2.2, administrators have individual 
accounts and preferences within a single "shared" repository schema. Because all 
administrative data is stored in a central repository, administrators can share job 
definitions and obtain status on all machines in the network, including those 
monitored by other database administrators.

The Enterprise Manager Configuration Assistant will launch automatically during 
the post install configuration phase if you are performing one of the following 
installation scenarios:

■ Oracle8i Enterprise Edition 8.1.7.0.0-> Custom 

■ Oracle8i Management and Integration  8.1.7.0.0-> Oracle Management Server 

■ Oracle8i Management and Integration  8.1.7.0.0-> Custom 

The Enterprise Manager Configuration Assistant will not launch automatically if 
you are performing an Oracle8i Enterprise Edition-> Typical installation. In this 
type of installation, you must manually launch the Enterprise Manager 
Configuration Assistant in order to create, delete, edit, or update your repository.

Whenever you start the Enterprise Manager Configuration Assistant to create a new 
2.2 repository (whether during a post install configuration or from the standalone 
mode), it will perform the following tasks for you:

■ creates a new database user who will own the Enterprise Manager and 
management packs repository

■ assigns proper privileges and roles to the new database user

■ creates a new tablespace for the Enterprise Manager and management packs 
repository or uses an existing tablespace if available

■ sets up default and temporary tablespaces for the user

■ loads information, which is required when running Oracle Enterprise Manager, 
into the repository

■ creates and/or updates the local Management Server’s configuration file: 
ORACLE_HOME\sysman\config\omsconfig.properties 
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■ enters the necessary information into the client registry so that any Console 
which runs on the system has the Management Server already in its list of those 
to which it can connect

■ check if an Oracle Management Service already exists (Windows NT and 
Windows 2000 only). If one does not already exist, it will create the Oracle 
Management Server service. If one does exist, it will not create another. 

■ starts your Management Server service and sets the service to Manual 
(Windows NT and Windows 2000 only)
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Starting the Enterprise Manager Configuration Assistant

To start the Enterprise Manager Configuration Assistant, perform the following 
steps:

■ On Windows NT and Windows 2000:

You can start the Enterprise Manager Configuration Assistant from the 
Windows Start Menu->Programs->Oracle-<Oracle_Home_Name>-> Enterprise 
Manager->Configuration Assistant.

You can also start the Enterprise Manager Configuration Assistant from the 
command line using the command:

emca

■ On UNIX:

You can start the Enterprise Manager Configuration Assistant from the 
command line using the command:

emca

Note: A database must be installed and running before you can create 
the Oracle Enterprise Manager repository schema.

Note: You must be logged in as the owner of the 
omsconfig.properties file (have permission on the file) to execute 
the emca command.
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Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant as a standalone 
application, the “Configuration Operation” page appears. 

When the Configuration Assistant is launched from an installation session and you 
have selected to create a new repository from the install dialog, the Configuration 
Operation screen will not appear. The screen will be "Select Database for 
Repository." In this case, proceed to Step 2 of 5 on page 2-8.

Select “Create a new repository” from the list of repository operations and press 
Next. The "Select Database for Repository" page appears.

Figure 2–1 Configuration Operation
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Step 2 "Select Database for Repository"
Log in to the database where you want to create the repository. 

Figure 2–2 Select Database for Repository

When configuring your repository, choose a database that meets the following 
criteria: 

■ the database is always available. 

■ the database will not be shut down by other administrators. 

■ the database does not compete for resources on the machine where it is 
running. 

User name and Password: You must connect to the database as a user with DBA 
privileges. The Enterprise Manager Configuration Assistant asks for a DBA account 
in case a new user needs to be created in the database to contain the repository and 
to allow the Configuration Assistant to make queries about the database/repository.
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This is an individual database user account, not an Oracle Enterprise Manager 
administrator account.

For example, system/manager.

Service: The service may be specified using the form:

<host>:<port>:<sid> 

where

host is the machine name where the database is located

port is the database listener port address, usually 1521 or 1526

SID is the database system identifier

An example: 

my_em_machine:1521:em22

which connects to the em22 database using port 1521 on the my_em_machine machine. 

Press Next to continue. 

Refer to "Troubleshooting the Enterprise Manager Configuration Assistant" on page 
D-19 for information about error messages.

Note: Specifying the service as <host>:<port>:<sid> is the preferred 
method, but you may also use Net8 names if your Net8 client is properly 
configured.
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Step 3 "Repository Login Information"
An Enterprise Manager repository is owned by a database user. During repository 
creation, a database user (repository schema user) who owns the repository will be 
created by the Enterprise Manager Configuration Assistant with the username and 
password you enter on this page. 

Figure 2–3 Repository Login Information

User name: Enter the repository’s user name that will be used to create a database 
user that will own the repository. The repository’s user name must be unique across 
the network. The TCP/IP hostname of the machine is assumed to be unique; 
therefore it is used by default. If you choose another name, you must ensure that it 
is unique. 

The Intelligent Agent identifies each Management Server by its repository name. If 
two repositories existed with the same name in different databases, the Intelligent 
Agent would have difficulty contacting the Management Server. 

Password: Enter the password for that user.
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Confirm: Verify the password by typing it again.

You can choose whether to save the user name and encrypted password in the 
omsconfig.properties file, which is read by the Management Server on 
startup. If these repository credentials are stored in the file, the Management Server 
uses them to login to the repository. 

On Windows NT and Windows 2000, if they are not saved, you can enter them in 
the Control Panel’s Startup Parameters field when you start the Management 
Server. If you do not enter the repository credentials in the Startup Parameters field, 
you will be prompted for them in a dialog.

On UNIX, if they are not saved, the Management Server will prompt you for a user 
name and password before it starts up.

If you do not want to store the user name and encrypted password in the 
omsconfig.properties file, check the "Do not save username and password" 
checkbox. The option of not storing your repository credentials is referred to as the 
secure Management Server mode.

The repository account information will be used to perform the maintenance 
operations in the repository schema like create, upgrade, or drop.

The roles and privileges required by the repository schema user are listed below:

■ Roles: CONNECT 

■ Privileges: CREATE TRIGGER, CREATE PROCEDURE, EXECUTE ANY 
PROCEDURE, and SELECT ANY TABLE 

To avoid potential security issues and unnecessary access to objects outside of 
Oracle Enterprise Manager, do not grant more privileges to your repository schema 
user than is absolutely necessary. 
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Step 4 "Select Repository User Tablespaces"
The Select Repository User Tablespaces page does not appear:

■ If the repository user already exists and contains a complete and up-to-date 
Enterprise Manager repository

or

■ If the Enterprise Manager Configuration Assistant is run from an installation 
session and: 

■ If the OEM_REPOSITORY tablespace already exists, and: 

■ If the OEM_REPOSITORY tablespace has the appropriate size attributes

Note: Do not install the Oracle Enterprise Manager repository into the 
SYSTEM (especially the SYSTEM tablespace of your production 
database), ROLLBACK, or TEMPORARY tablespaces. 

The tablespace parameter settings used for the SYSTEM tablespace are 
not appropriate for Oracle Enterprise Manager use. You should only use 
the SYSTEM tablespace for "system" entities. Tools, users, and 
management products such as Oracle Enterprise Manager should be 
placed in other tablespaces. 

ROLLBACK tablespaces are used for creating rollback segments. 
Rollback segments are used by Oracle user processes to store rollback 
information. 

TEMPORARY tablespaces, which are assigned as TEMPORARY 
tablespaces for users, are used by Oracle user processes as a "scratch 
pad." Both of these tablespaces fluctuate in tablespace usage when the 
database is up and running. The TEMPORARY tablespace can be used as 
the user’s temporary tablespace. 

The Configuration Assistant does not allow you to use the SYSTEM 
tablespace either as a temporary tablespace or as a default tablespace.

For more details, refer to the Oracle8i Concepts Guide.
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In standalone mode, if the OEM_REPOSITORY tablespace already exists and you 
have enter the name of a different repository user than the one managing the 
repository in the "Repository Login Information" page, an error message appears, 
saying, "Do you wish to change it to manage the repository owned by user ’<user>’ 
on service ’<service>’?" If you click the "Yes" or the "No" button, the following 
screen appears.

Figure 2–4 Select Repository User Tablespaces if OEM_REPOSITORY Exists

Select the default and temporary tablespaces for the Enterprise Manager repository 
to use. 
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If the OEM_REPOSITORY tablespace does not exist, the following screen appears: 

Figure 2–5 Select Repository User Tablespaces if OEM_REPOSITORY Does Not Exist

Default Tablespace:

■ Create a new OEM_REPOSITORY tablespace (recommended).

Select this option if you want to create the OEM_REPOSITORY tablespace, 
which has specific characteristics for the Enterprise Manager repository, and use 
it as the repository user’s default tablespace. 

■ Override default datafile name. 

Select the checkbox if you want to change the default name of the datafile for 
the OEM_REPOSITORY tablespace. This is not normally recommended.

■ Use an existing tablespace

Select an existing tablespace from the pull-down list.
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Temporary Tablespace

Select a temporary tablespace from the pull-down list.

Click Next to continue.

If the Enterprise Manager Configuration Assistant detects that the default 
tablespace for the repository contains the required amount of free space, the “Create 
Repository Summary” page appears. Otherwise, errors will appear.
                                                                    Creating a Release 2.2 Repository 2-15



Creating a New Release 2.2 Repository
Step 5 "Create Repository Summary"
The “Create Repository Summary” page appears, showing a summary of the 
processing to be performed. Verify that all of the information supplied during the 
create repository wizard operation is accurate. 

Figure 2–6 Create Repository Summary

Click Finish to initiate repository creation or click Back to return to previous pages 
to make modifications.

When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. 
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Step 6 "Configuration Assistant Progress Window"
If you want to view detailed information about what is happening during the 
processing, including any errors that might occur, click the "Show Details" button to 
expand the dialog to show a text area. You can hide the detailed information by 
clicking the "Hide Details" button. 

Figure 2–7 Configuration Assistant Progress

The Cancel button changes to a Close button when processing is completed, 
whether it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. 

You must click the Close button to exit the Configuration Assistant.

Note: If you cancel the repository creation while it is in progress, the 
state of the repository is in doubt. In these circumstances, you should 
drop the repository using the Enterprise Manager Configuration 
Assistant.
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If the repository creation fails, drop the repository, turn on tracing for the 
Management Server by adding the appropriate tracing properties to the 
omsconfig.properties file, and perform the repository creation procedure 
again. For information on Management Server tracing and logging, refer to "Tracing 
and Logging for the Management Server" on page D-5.

For information on dropping the repository, refer to "Drop an Existing Repository" 
on page B-6.
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Recommended init.ora Settings for the Repository Database
You can change the settings before or after repository creation.

The following are recommended init.ora settings for the repository database. They 
are recommended particularly if you are using the Oracle Enterprise Manager 
Events system.

■ sessions = 200

■ open_cursors = 200

■ db_block_buffers = 23040

■ log_buffer = 524288

■ sort_area_size = 262144

■ sort_area_retailed_size = 262144

■ shared_pool_reserved_size = 0

■ db_block_lru_latches = 2

After editing the init.ora file with these settings, you must stop and restart the 
database in order for the changes to take effect. 

Tuning for specific sites may be necessary, and using Oracle Expert included as part 
of the separately licensable Oracle Tuning Pack for these cases is recommended.
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Controlling the Management Server

The Management Server provides distributed control between clients and managed 
nodes. A central engine for notification, it processes all system management tasks 
and administers the distribution of these tasks across the enterprise.

Specific topics discussed in this chapter are listed below:

■ Starting the Management Server

■ Checking the status of the Management Server

■ Stopping the Management Server

■ Tuning the Management Server
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Starting the Management Server
The repository database must be started and open and the listener must be started 
before starting the Management Server.

To start the Management Server, perform the following steps.

Starting the Management Server On Windows NT or Windows 2000
To start the Management Server on Windows NT or Windows 2000, follow the 
instructions below.

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. If you have chosen not to store your repository credentials during repository 
creation (referred to as the secure Management Server mode), you can enter the 
repository’s user name that was used to create the database user and the 
password for that user in the Control Panel’s Startup Parameters field when 
you start the Management Server. The Startup Parameters field is under the list 
of services. The database user and password must be in the format of 
<username>/<password>.

If you supply invalid or incomplete repository credentials in the Control Panel’s 
Startup Parameters field, the Management Server will not start, and an error 
message will appear.

If you are in secure mode and do not enter the repository credentials in the 
Startup Parameters field, you will be prompted for them later in a dialog.

For information on troubleshooting the Management Server if it does not start, 
refer to "Management Server Does Not Start" on page D-12.

3. Select the Oracle<Oracle_Home_Name>ManagementServer service.

4. Click the Startup push-button to access the Service Startup dialog box.

Note: Oracle Enterprise Manager does not support stopping or starting 
a remote Management Server from the local machine.

Note: Step 4 only needs to be performed once, not every time you start 
up the service.
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a. In the Startup Type section, specify how the Management Server service is 
started up by choosing Automatic or Manual. Manual allows the 
Management Server to be started by a user. Automatic allows the 
Management Server to start automatically whenever the user starts the 
system. Disabled does not allow the Management Server to start at all. By 
default, the Configuration Assistant sets the service to Manual.

b. In the Log On As section, check for the following settings:

* Ensure that the System Account option, which is the supported way to 
run the Management Server, is selected. The Management Server will 
not run if you use a local account.

* Ensure that the "Allow Service to Interact with Desktop" box is selected; 
otherwise, the Management Server will not run.

5. Click the Start push-button to start the Management Server. 

Note: Your Management Server service is started automatically and set 
to Manual on Windows NT or Windows 2000 during repository creation 
if you had launched the Enterprise Manager Configuration Assistant 
from an installation session and if you had chosen to save your 
repository credentials.

If you have chosen not to save your repository credentials, you can enter 
them in the Control Panel’s Startup Parameters field when you start the 
Management Server. If you do not enter the repository credentials in the 
Startup Parameters field, you will be prompted for them in a dialog.
                                                                    Controlling the Management Server 3-3



Starting the Management Server
Starting the Management Server On UNIX
To start the Management Server on UNIX, at the command line, enter

% oemctrl start oms

When you are prompted, enter the repository’s user name that was used to create 
the database user and the password for that user if you have chosen not to save 
your repository credentials during repository configuration. For a complete 
definition of a repository owner, refer to "Step 3 "Repository Login Information"" on 
page 2-10.

Note: If the ORACLE_HOME environment variable is not set to the 
Oracle home in which the Management Server is running, the 
Management Server will not start correctly because it will try to find its 
class files in the default Oracle home instead of the correct Oracle home. 
For information on setting the Oracle environment, refer to 
"Management Server May Not Run Correctly from a Non-Default Oracle 
Home" on page D-11.
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Checking the Status of the Management Server
To quickly check whether the Management Server is up or down, at any operating 
system prompt, enter: 

% oemctrl ping oms

To check the status of the Management Server, at any operating system prompt, 
enter: 

% oemctrl status oms

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-7. 

You will also need to provide the hostname for the machine running the 
Management Server if you are checking the status of a remote Management Server. 

The following information is provided when you check the status of the 
Management Server:

■ overall status of the Management Server

■ length of time the Management Server has been running

■ statistics regarding the performance of the Management Server 

An example of the output is shown below:

OEMCTRL for Windows NT: Version 2.2.0.0.0
Copyright (c) 1998, 2000, Oracle Corporation.  All rights reserved.
Oracle Server Version null
Loaded njssl8 shared object

Loading njssl8 dll

In OracleSSLSocketImpl Static portion

The Oracle Management Server on host [pjlee-pc2.us.oracle.com] is functioning 
properly.

  The server has been up for 0 09:08:37.734

  Target database session count: 1 (session sharing is off)
  Operations queued for processing: 0
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  Number of OMS systems in domain: 1 (pjlee-pc2)
  Number of administrators logged in: 1
  Repository session pool depth: 15
  Repository session count: 7 in-use and 3 available, pool efficiency: 100%

For information about the parameters, refer to the section below.

■ Target database session count

The target database session count indicates the number of target databases in 
the session.

■ Operations queued for processing

The operations queued for processing indicates the number of activities waiting 
for processing.

■ Number of OMS systems in domain

The number of OMS systems in domain indicates the number of Management 
Servers running in the enterprise.

■ Number of administrators logged in

The number of administrators logged in indicates the number of Enterprise 
Manager administrators logged into the system.

■ Repository session pool depth

The session pool depth indicates the number of sessions the Oracle 
Management Server is using. The overall status of the system is dependent 
upon the number of users and the activity on a system. 

By default, the Console consumes up to a maximum of 3 sessions. With a count 
of 3, you can generally perform an operation (submit jobs/events) without 
having to wait for sessions to release them.

The number of sessions available that can be used by the Console to connect to 
the Management Servers is 15. Since each Console connection requires 3 
sessions, the session pool depth of 15 will allow 5 Console connections, each of 
which consumes 3 sessions.  If the number of Console connections decreases, 
the session pool depth limit will remain at 15.  If the number of Console 
connections increases, the session pool depth limit increases internally.
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To determine the optimal value for the number of overhead sessions, use the 
formula documented below.

As the number of concurrent users increases, the number of sessions available 
should increase. The formula to use to calculate the number of sessions is 

1.1 x 3 x  number users actively performing operations

1.1 is a factor to use in order to calculate additional breathing space so that it is 
not an absolute number of 3 

3 is the overhead number you would want.

number users actively performing operations is the number of concurrent 
users.

For example: for 1 user, the formula comes to: 1.1 x 3 x 1 = 3.3 or 3 sessions are 
enough.

For 4 users, the formula comes to 1.1 x 3 x 4 = 13.2. 13 is how many overhead 
sessions you would want if the users are all constantly registering events or 
jobs. If not, the overhead of 3 is sufficient.

■ Repository session count

The number of repository sessions.
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Stopping the Management Server

To stop the Management Server, perform the following steps: 

On Windows NT or Windows 2000:
1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>ManagementServer service.

3. Click the Stop push-button to stop the Management Server. 

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-7. 

On UNIX:
At the command line, enter

% oemctrl stop oms

You will be prompted to enter the username and password of an Oracle Enterprise 
super administrator. For a complete definition of an Oracle Enterprise Manager 
super administrator, refer to "What is an administrative user?" on page 1-7. 

Note: Stopping a Management Server that is not local to your machine 
(i.e., a remote Management Server) is not supported.
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Tuning the Management Server
There may be special circumstances which require specific tuning of the 
Management Server to improve performance such as when the enterprise is 
managing a large number of nodes.   Tuning can be perform by setting the 
following Management Server configuration parameters: 

■ oms.vdp.ping_interval 

■ oms.vdg.max_out_conns 

■ oms.vdg.max_in_conns 

■ oms.repository.connect_timeout 

■ oms.repository.connect_numTries 

After editing the omsconfig.properties file, you must stop and restart the 
Management Server in order for the changes to take effect. 

Setting the Ping Interval
The Management Server is designed to ping all targets on a pre-defined interval to 
monitor the state of all managed targets.

To manage the interval between pings, you can use the following property in the 
omsconfig.properties file to set the ping interval:

oms.vdp.ping_interval=<integer; time in minutes; default 2>

Note that the interval set determines the interval (time in number of minutes) at 
which the Management Server tests for node up/down, regardless of the polling 
frequency that you have set in the event which contains a node up/down test.

The default for the time is 2. For Management Servers managing a large number of 
nodes (more than 64 nodes), you can adjust this parameter to provide the 
Management Server enough time to ping all the nodes. 
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Setting the Maximum Connections Out
The Management Server is designed to maintain a certain number of outgoing 
connections toward different Intelligent Agents simultaneously.

To manage the number of simultaneous outgoing connections, you can use the 
following property in the omsconfig.properties file:

oms.vdg.max_out_conns =<integer; default 64>

The default is 64. Oracle recommends that this value to be greater or equal to the 
number of nodes managed by the Management Server in order to avoid 
performance degradation. If the maximum number of managed nodes is less than 
64, Oracle recommends keeping the default value. If the maximum number of 
managed nodes is more than 64, set the value to the number of nodes.

Setting the Maximum Connections In
The Management Server is designed to maintain a certain number of incoming 
connections simultaneously.

To manage the number of simultaneous incoming connections, you can use the 
following property in the omsconfig.properties file:

oms.vdg.max_in_conns=<integer; default 32>

To prevent performance degradation, it is recommended that you set this value to 
be half the value of the oms.vdg.max_out_conns.

Setting the Management Server Retry Interval
The Management Server is designed to retry at a pre-defined intervals.

To specify the interval between retries, use the following properties in the 
omsconfig.properties file to set the retry interval:

oms.repository.connect_timeout=<time in seconds>
oms.repository.connect_numTries=<integer>

oms.repository.connect_timeout is the maximum time (in seconds) the Management 
Server will wait for the repository database to start up.

oms.repository.connect_numTries  is the maximum number of tries the Management 
Server will make to connect to the repository before starting up the Management 
Server services.  
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The retry interval is calculated as the value of 
oms.repository.connect_timeout divided by the value of 
oms.repository.connect_numTries.

By default, the properties are set as follows:

oms.repository.connect_timeout=120
oms.repository.connect_numTries=12

The Management Server will try to establish a repository connection at startup at 10 
second intervals for a total of 12 times.
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Adding Additional Management Servers

In an environment with multiple Oracle Management Servers, a set of Management 
Servers share the same repository.

This chapter describes how to set up or add a Management Server to manage an 
already existing repository and explains why multiple Management Servers may be 
needed.

 

As the number of nodes and managed services in your network increases or if the 
current Management Server is overloaded, you can add more Oracle Management 
Servers to the middle tier to share and balance the workload.

Multiple Oracle Management Servers provide fault tolerance for each other. If an 
Oracle Management Server fails, the other Management Servers continue to 
operate. The clients that registered with the failed Management Server can 
immediately log in again, registering with any of the other Management Servers 
using or sharing the same repository, and work continues with the remaining 
available Oracle Management Servers. Any clients that had been configured to 
register with a different Oracle Management Server than the one that failed are 
unaffected.

If the available Management Servers are CPU-bound (the CPU usage is exhausted), 
adding additional Management Servers is an alterative to increasing the capacity of 
the nodes that run the Management Servers.

Note: If you do not need to set up or add a management server to 
manage an already existing repository, skip this chapter. 
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Installing an Additional Management Server
If you want to run an Oracle Management Server on a specific machine, you must 
first install the Oracle Management Server software on that machine.

Refer to the installation guide provided with the database release for detailed 
instructions.

Setting Up an Additional Management Server
When you add a new management server, you must run the Enterprise Manager 
Configuration Assistant to update the configuration file for that node.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-6.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Edit the Configuration Parameters" from the list of configuration operations 
and press Next to Continue. The "Configuration Parameters" page appears.

Step 2 "Configuration Parameters"
Change the parameters you want.

User Name 
Enter the user name of the existing repository which you wish this machine’s 
Management Server to use. 

Password 
Enter the password for the above user name. The information will be used on the 
next Management Server start up. 

If you change the password, you must also change the Confirm field so that it 
matches the password you changed.

Note: All Management Servers connecting to the same repository must 
reside in the same DNS Domain. 
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Service
Enter the service where the repository resides. 

This information will be used when this machine’s Management Server next starts 
up. If any of the information is invalid, then the Management Server will not start 
successfully.

Do not save username and password
You can choose whether to save the user name and encrypted password in the 
omsconfig.properties file, which is read by the Management Server on 
startup. If the user name and encrypted password are stored in the file, the 
Management Server uses them to login to the repository. 

On Windows NT or Windows 2000, if they are not saved, you can enter them in the 
Control Panel’s Startup Parameters field when you start the Management Server. If 
you do not enter the repository credentials in the Startup Parameters field, you will 
be prompted for them in a dialog.

On UNIX, if they are not saved, the Management Server will prompt you for a user 
name and password before it starts up.

If you do not want to save the user name and password, check the "Do not save 
username and password" checkbox. The option of not storing your repository 
credentials is referred to as the secure Management Server mode.

Step 3 "Modify Configuration Parameters"
The "Modify Configuration Parameters" page provides a summary of all the 
information supplied during the modify configuration parameters wizard 
operation. Click Finish to initiate the change or click Back to return to previous 
pages to change your information.

Note: In order to progress to the next page, you must change at least 
one of the parameters in this page. If the Next button is pressed without 
changing anything, an error message appears: "There were no changes to 
the configuration parameters. Make changes or cancel." In this case, the 
Enterprise Manager Configuration Assistant does not allow navigation 
to the next page.
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Starting and Stopping the Intelligent Agent

Oracle Intelligent Agents are processes running on remote nodes in the network. 
Oracle Enterprise Manager works with Intelligent Agents across the network, to 
discover the services running on the nodes where the Intelligent Agent resides, 
monitor events, run jobs, and collect runtime data for real-time performance 
monitoring and historical analysis. Any platform running an Intelligent Agent can 
be incorportated into the Oracle Enterprise Manager framework, as long as TCP/IP 
communication between the Oracle Enterprise Manager middle tier and the 
Intelligent Agents is possible.

Refer to the Oracle Intelligent Agent User’s Guide for detailed information about 
troubleshooting any Intelligent Agent problems.

Intelligent Agents local to the Management Server will be discovered automatically 
when the Management Server is started as long as the Intelligent Agent local to the 
Management Server has been started. In order to discover distributed services, the 
Intelligent Agents on the nodes where those services reside must be started. 

This chapter discusses the following topics:

■ Starting and Stopping the Oracle Intelligent Agent on Windows NT or 
Windows 2000

■ Starting and Stopping the Oracle Intelligent Agent on UNIX

Please check the Intelligent Agent compatibility matrix in the Oracle Enterprise 
Manager Readme before installing or using Enterprise Manager. emreadme.txt or 
emreadme.html is located in the ORACLE_OEM_HOME\RelNotes\EM directory. 
For example, C:\Oracle\Ora81\RelNotes\EM.
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Starting and Stopping the Oracle Intelligent Agent on Windows NT or 
Windows 2000

This section contains information on controlling the Intelligent Agent through the 
Windows NT or Windows 2000 Control Panel and the command prompt.

Starting the Intelligent Agent on Windows NT or Windows 2000
To start the Intelligent Agent on Windows NT or Windows 2000, perform the 
following steps:

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Start push-button to start the Intelligent Agent.

The Intelligent Agent Startup Type is set to Automatic, which allows the Intelligent 
Agent to start automatically whenever you start the system. If you want the 
Intelligent Agent to be started by a user, set the Startup Type for Manual.

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Startup push-button. A Service Startup dialog box appears.

4. Choose Manual under the Startup Type.

5. Click OK on the Service Startup dialog box.

Stopping the Intelligent Agent on Windows NT or Windows 2000
To stop the Intelligent Agent on Windows NT or Windows 2000, perform the 
following steps:

1. From the Start menu->Settings->Control Panel, double-click the Services icon.

2. Select the Oracle<Oracle_Home_Name>Agent service.

3. Click the Stop push-button to stop the Intelligent Agent.

Note: Oracle Enterprise Manager and the Intelligent Agent use Net8 to 
communicate with the databases. Verify that Net8 can connect to every 
SID in question before attempting to use the Intelligent Agent.
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Verify Intelligent Agent is Running on Windows NT or Windows 2000
To verify that the Intelligent Agent is running, look for its status in the control panel 
services or type net start at a command prompt. 
Oracle<Oracle_Home_Name>Agent should appear in the list of services. 

You may also view the NT Task Manager for the dbsnmp.exe process information.

Starting, Stopping, and Verifying the Status from the Command Prompt
To start or stop the Intelligent Agent from the command prompt, enter the 
appropriate command. From the command prompt, you can also verify that the 
service is running. 

If you want to... Enter the following command

Start the Intelligent Agent from the prompt net start Oracle<Oracle_Home_Name>Agent

Stop the Intelligent Agent from the prompt net stop Oracle<Oracle_Home_Name>Agent

Verify status of the Intelligent Agent from 
the prompt

net start

Note: Do not use the lsnrctl command to start the Intelligent Agent 
for Windows NT or Windows 2000. It is not supported. Use the net 
command for Windows NT or Windows 2000 instead.
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Starting and Stopping the Oracle Intelligent Agent on UNIX
On UNIX, Oracle Enterprise Manager uses the lsnrctl to start and stop the 
Intelligent Agent. The relevant lsnrctl commands to control the UNIX Intelligent 
Agent are listed in the table below.

You can also type ps -ef | grep dbsnmp at the command prompt to verify the 
status of the Intelligent Agent.

If you want to... Enter the command...

Start the Intelligent Agent on UNIX platforms lsnrctl dbsnmp_start

Stop the Intelligent Agent on the UNIX platform lsnrctl dbsnmp_stop

Verify status of the Intelligent Agent lsnrctl dbsnmp_status

Note: You must be the owner of the Intelligent Agent software to 
succesfully stop and start the Intelligent Agent or you may run into 
permission problems when writing the internal Intelligent Agent 
information.
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Setting Up the Console

The Oracle Enterprise Manager Console is a graphical interface for administrators. 
From the Console, you can perform the following tasks:

■ Centrally administer, diagnose, and tune multiple databases

■ Manage Oracle products and services other than databases

■ Effectively monitor and respond to the health of your Oracle family of products 
and third-party services 24 hours a day

■ Schedule jobs on multiple nodes at varying time intervals

■ Monitor networked services for events

■ Customize your display by organizing databases and other services into logical 
administrative groups
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This chapter discusses the topics listed below:

■ Starting the Enterprise Manager Console

■ Discovering Services

■ Creating Administrator Accounts

■ Running Oracle Enterprise Manager from a Web Browser

■ Setting Up the Event System

■ Setting Up the Job System

■ Configuring and Starting the Paging Service

■ Setting Up Email and Paging Notification

■ Configuring the Console If Using a Dialup Line to Connect to the Management 
Server

■ Configuring a Remote Database for Backup or SYSDBA Administration

■ Setting the Format of Dates
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Starting the Enterprise Manager Console
The Console gives you a central point of control for the Oracle environment through 
an intuitive graphical user interface (GUI) that provides powerful and robust 
system management. 

After you have created a repository and started your Management Server and 
Intelligent Agent, you are ready to start the Enterprise Manager Console. 

To start the Enterprise Manager Console, perform the following steps.

1. Start the Enterprise Manager Console. 

■ On Windows platforms:

From the Start menu -> Oracle-<Oracle_Home_Name> -> Enterprise 
Manager, select Console.

You can also start the Console by entering

oemapp console

at the command line.

■ On UNIX:

At the command line, enter

oemapp console

The command string is case-sensitive and must be entered with lowercase 
characters. 

The Oracle Enterprise Manager Login screen appears, prompting you for your 
administrator name and password.

2. If you are logging in to Oracle Enterprise Manager for the first time, type in the 
default credentials (administrator name and password). 

Administrator = sysman 

Note: You can also start Enterprise Manager from a web browser. Refer 
to "Running Oracle Enterprise Manager from a Web Browser" on page 
6-8 for information on installing the Enterprise Manager web site and 
setting up your web browser to run Enterprise Manager.
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Password = oem_temp 

These credentials are for the default Super Administrator account. The first time 
you start Enterprise Manager, you must login as the Super Administrator. After 
other administrator accounts have been created using the Super Administrator 
account, you can login as a different administrator.

3. Select the name of the node where the Management Server is running from the 
pull-down list. The Management Server on the node you select must be one 
which is configured with the repository you want to access.

If the name of the node where the Management Server is running does not 
appear in the pull-down list, follow these instructions below: 

a. Click the Management Servers button, which is located to the right of the 
Management Server field. The Management Servers dialog appears. 

b. Click the Add button. The Add Management Server dialog appears. 

c. Type in the name of the node where the Management Server is running and 
click OK. 

d. Select the name of the node where the Management Server is running from 
the pull-down list.

4. After the initial login, a security login dialog appears where you can change the 
default Super Administrator password. You should change the password 
immediately. 

Note: You must have the Management Server installed and configured 
before performing this step.

Note: Oracle Enterprise Manager may resolve the node name and use 
the "canonical name" of the machine. That name will be used in the 
dialog screens from now on. For example, orange-pc may be changed to 
orange-pc.us.oracle.com.
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If you are starting the Console for the first time, the Discovery Wizard appears to 
facilitate the process of identifying network services and populating the Console 
Navigator tree.

Discovering Services
Oracle Enterprise Manager provides a service Discovery Wizard for identifying 
network services and populating the Console Navigator tree. These services, such 
as databases and listeners, can then be administered with Enterprise Manager 
components. 

During start up of the Console, any manageable services on the machine where the 
Management Server is running are automatically discovered if the Intelligent Agent 
is installed and running on that Management Server machine. The Console 
Navigator then displays all the discovered services on the Management Server 
machine. 

To discover additional nodes: 

1. Select the Discover Nodes item from the Console’s Navigator menu. 

2. When the Discovery Wizard appears, read the introduction text and press Next 
to continue. 

3. When the Specify Nodes page appears, enter the name of the node or the IP 
address in the text window. You can also discover services on multiple nodes at 
one time by entering each node or IP address you want to discover separated by 
a space, comma, tab, or new line within the text window. Then click Next to 
continue.

4. A Progress page appears, showing you the status of the node discovery. A 
checkmark indicates that the node was discovered successfully. An X indicates 
that the discovery has failed. If an error occurs, the error text explaining the 
reason for the error appears, giving you insight on how to continue. After the 
discovery process has completed, press the Finish button. 

5. A Discovery Results dialog appears, telling you which nodes have or have not 
been automatically discovered. Press the OK button to dismiss the dialog. 

Note: Passwords must have no more than 8 characters. 
                                                          Setting Up the Console 6-5



Creating Administrator Accounts
If nodes have failed automatic discovery, you can press the Next button on the 
Progress page. On the Errors page, you will have the option to retry, skip, or 
perform a manual discovery on the failed nodes.

If no Intelligent Agent is running for some nodes which failed to be discovered, 
you can still add the node to the navigator, and add databases to that node 
using manual discovery. Only databases will be added. During manual 
discovery, you will be prompted for the following information:

■ database name

■ SID

■ TCP/IP port to use for the communication

When you manually add a node, no jobs can be scheduled and no events can be 
registered against this node. Information about this node can be gathered using 
a Data Gatherer on another node.

If a node cannot be discovered, check if the node is down or if the node does 
not have an Intelligent Agent running. You can also check if you are using the 
TCP/IP network protocol. Refer to the Oracle Enterprise Manager Administrator’s 
Guide for information on discovering services. 

Creating Administrator Accounts
Enterprise Manager Release 2.2 is a multi-administrator system: every person who 
is administering systems using Enterprise Manager has his or her own 
administrator account which he or she uses to log into the Console.

The installation of Enterprise Manager creates a single Super Administrator named 
sysman. The Super Administrator sysman can create administrators using the 
Manage Administrators item in the System menu. In addition to an administrator 

Note: Manually discovered nodes must be dropped from the Navigator 
tree before they can be automatically discovered.

Note: If you discover two or more services with the exact same name, 
regardless of the service type, only one of the discovered services will 
appear in the navigator.
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name and password, each account can be tagged as a "Super Administrator" 
account or an account to which the administrator has access to only jobs and/or 
events. Differences between the two types of accounts are as follows:

■ Super Administrators automatically have full privileges for all objects in the 
system. Most Super Administrators also have a separate account for daily 
operations but use their Super Administrator account for special operations 
only available to Super Administrators, such as starting and stopping the 
Management Server, creating new Enterprise Manager Administrators, 
configuring paging servers, or checking other administrator’s schedules. Using 
the sysman account for daily administration work is not recommended. The 
Super Administrator account is similar to root on UNIX or Administrator 
on Windows NT or Windows 2000 and is a user which cannot be deleted or 
renamed. It is a user that can perform any task. It should therefore be used only 
for setting up the environment. After the necessary DBA accounts are created, 
sysman should not be used anymore.

■ Regular Administrators can have full access to all other Console operations but 
they will only view or be able to modify those jobs, events, or groups to which 
they have access. 

Typically, all administrators share a single Enterprise Manager, Release 2.2 
repository, which allows administrators to share information. Although you can set 
up multiple repositories, administrators using different repositories will not have 
access to each other’s information; there is no sharing of data between repositories. 
Administrative data stored in the repository is filtered based on administrator 
permissions. 

Preferred Credentials must be set up for each administrator account. When an 
administrator connects through the Navigator or stand-alone application, the 
preferred credentials used are those defined explicitly for that administrator.

Refer to the Oracle Enterprise Manager Administrator’s Guide for information on how 
Enterprise Manager administrators are created, edited, and deleted with the 
Manage Administrators item in the Console System menu. 
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Running Oracle Enterprise Manager from a Web Browser
With Oracle Enterprise Manager Release 2.2, an administrator is not limited to 
managing services from a particular machine. Instead, the administrator has a 
choice to run Oracle Enterprise Manager as a "fat" or "thin" client.

Figure 6–1 Types of Clients

A "fat" client uses Oracle Enterprise Manager files which are installed locally. A 
"thin" client uses a web browser to connect to a webserver where Oracle Enterprise 
Manager files are installed. Functionality available from both types of clients is 
identical. That is, administrators are able to perform the same administrative tasks 
from either a "fat" client or a "thin" client. However, not all components in the 

Note: Browser-based Oracle Enterprise Manager is only supported on 
the following operating systems: Windows 2000, Windows NT, Windows 
95, and Windows 98
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Oracle Enterprise Manager product family support being run in a web browser. 
Refer to the table below for details.

In order to run Oracle Enterprise Manager from a web browser, you must perform 
the following installation and configuration steps.

Step 1  Client Install
Install the web browser.

Supported web browsers are listed below:

■ Netscape Navigator® 4.7 and higher on Windows 2000, Windows NT, Windows 
95, and Windows 98

■ Microsoft® Internet Explorer 5.0 and higher on Windows 2000, Windows NT, 
Windows 95, and Windows 98

Products
Runs in a 
Browser

Does Not Run 
in a Browser

Oracle Enterprise Manager Console X

Oracle DBA Management Pack X

Oracle Advanced Events available with the Oracle Diagnostics Pack or 
the Oracle Management Pack for Oracle Applications

X

Oracle Tuning Pack X

Oracle Diagnostics Pack X

Oracle Change Management Pack X

Oracle Management Pack for Oracle Applications X

Oracle Management Pack for SAP R/3 X

Oracle Standard Management Pack X

Oracle Parallel Server Manager (integrated application) X

Note: Oracle Parallel Server Manager is the only integrated application 
which supports being run from a web browser.
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Step 2  Server-Side Install
1. Check in your Oracle Enterprise Manager home on the node on which you plan 

to run the webserver for a directory or folder called oem_webstage.

If the directory is in the Oracle Enterprise Manager home, you have already 
installed the Enterprise Manager Web Site. If it is not, you will need to perform 
one of the following installations:

■ Oracle8i Enterprise Edition 8.1.7.0.0-> Custom 

■ Oracle8i Management and Integration 8.1.7.0.0-> Oracle Management 
Server 

■ Oracle8i Management and Integration 8.1.7.0.0-> Custom 

Refer to the installation guide provided with the database release.

The files for the Oracle Enterprise Manager Console, DBA Management Pack, 
some integrated applications, Quick Tours, documentation, and readmes are 
installed with the Oracle Enterprise Manager Web Site.

2. If you have installed the Oracle HTTP Server that is packaged with Enterprise 
Manager by default, start it by performing the following steps:

On Windows NT or Windows 2000:

To start the Oracle HTTP Server:

a. From the Start menu->Settings->Control Panel, double-click the Services 
icon.

b. Select the OracleHTTPServer_<Oracle_Home_Name> service.

c. Click the Start push-button to start the Oracle HTTP Server.

On UNIX:

You can start the Oracle HTTP Server from the command line using the 
command:

$Oracle_Home/Apache/Apache/bin/apachectl start

To stop the Oracle HTTP Server, perform the following steps:

Note: Using Microsoft® Internet Explorer when it is run from a 
Microsoft® Active Desktop is not supported.
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On Windows NT or Windows 2000:

To stop the Oracle HTTP Server on Windows NT or Windows 2000, perform the 
following steps:

a. From the Start menu->Settings->Control Panel, double-click the Services 
icon.

b. Select the OracleHTTPServer_<Oracle_Home_Name> service.

c. Click the Stop push-button to stop the Oracle HTTP Server.

On UNIX:

You can stop the Oracle HTTP Server from the command line using the 
command:

$Oracle_Home/Apache/Apache/bin/apachectl start

3. If you did not install the Oracle HTTP Server that is packaged with Enterprise 
Manager by default, you must install a supported webserver and configure its 
directory mappings.

If you want to use another webserver other than the Oracle HTTP Server, the 
supported webservers are listed below:

■ Apache 1.3.9 and higher on Unix 

■ Internet Information Server (IIS) 4.0 on Windows NT or Windows 2000

For information on configuring the above webservers, refer to Appendix F, 
"Configuring the Webserver and Directory Mapping".

Step 3  Run the Browser-Based Oracle Enterprise Manager
After performing the above steps, you are ready to run the browser-based Oracle 
Enterprise Manager.
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1. Launch your web browser and enter the following URL regardless of which 
webserver you have installed.

http://<webserver hostname>:<port number>/

For example:

http://jfox-sun.us.oracle.com:3339/

The index (EMWebSite.html) page will appear. The index page allows you to 
launch various products, documentation, and web sites.

2. On this index page, enter the machine name for the Management Server to 
which you want to connect and click the application icon or name of the 
application you want to launch.

Note: In order to run Enterprise Manager from a web browser, you 
must remove any proxies that are configured for use by your web 
browser. You can do this by either:

■ Choosing to connect directly to the network using the web browser’s 
proxy setting, or

■ Choosing to manually configure the proxy, but specify not to use the 
proxy for the webserver that runs the Enterprise Manager web site.

If you should experience problems with the proxies, refer to 
"Troubleshooting the Web Browser" on page D-17.

Note: The Oracle HTTP Server port number is 3339.
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Figure 6–2 The EMWebSite.html Page

3. If you are entering the URL for the first time, you must install the Oracle 
JInitiator plug-in Release 1.1.7.30. 

■ On Netscape, you are automatically prompted to install the plug-in. 

■ On Microsoft Internet Explorer, you can click the "Download Plug-in" link 
on the index page to install the plug-in.

4. Follow the instructions on the plug-in page to install the plug-in. Installing the 
plug-in may take several minutes depending on your machine and network 
environment.

5. After installing the java plug-in, launch your web browser and enter the 
following URL:

Note: Once you are prompted to install the plug-in and you exit or 
cancel before installing it, you will no longer be prompted to install it the 
next time you launch the browser-based Enterprise Manager. In this 
situation, to install the plug-in, click the "Download Plug-in" link on the 
index page to download the java plug-in.
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http://<webserver hostname>:<port number>/

The index (EMWebSite.html) page will appear. The index page allows you to 
launch various products, documentation, and web sites.

6. On this index page, enter the machine name for the Management Server to 
which you want to connect and click the application icon or name of the 
application you want to launch.

7. Then a dialog will appear, which explains the following:

■ You will not be able to close the Oracle Enterprise Console 2.2 screen 
without stopping the Console, DBA Studio, or SQL*Plus Worksheet since 
the application has been launched from this browser window. 

■ You can exit the EMWebSite without exiting the Console, DBA Studio, or 
SQL*Plus Worksheet.

Once the java plug-in is installed, the Oracle Enterprise Manager Login dialog 
will appear.

8. If you are logging in to Oracle Enterprise Manager for the first time, type in the 
default credentials (administrator name and password). 

Administrator = sysman 

Password = oem_temp 

These credentials are for the default Super Administrator account. The first time 
you start Enterprise Manager, you must login as this Super Administrator. After 
other administrator accounts have been created using the Super Administrator 
account, you can login as a different administrator.

Note: Launching the browser-based Oracle Enterprise Manager for the 
first time may take several minutes, and if you are running a dial up 
connection, download times will typically be longer and vary based on 
the line speed. A progress dialog will appear the first time you launch 
browser-based Oracle Enterprise Manager.
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You can return to the index (EMWebSite.html) page to launch documentation, 
release notes, Quick Tours, and other web sites, and you can exit the index page 
without closing the Console.

9. Bookmark the URL. 

Note: If you are not able to connect to the Management Server 
specified, you must return to the index (EmWebSite.html) page to enter a 
different Management Server machine name. You cannot simply enter a 
new Management Server machine name at the Oracle Enterprise 
Manager Login screen.

Note: You can access only one URL for running browser-based 
Enterprise Manager applications. You cannot access browser-based 
Enterprise Manager applications from multiple URLs from a single 
machine. 
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Setting Up the Event System
Beginning with Oracle 8.0.6 databases and higher, the OEM_MONITOR role is 
created by the Oracle database creation scripts. This role permits access to database 
functionality within Enterprise Manager running events against a database 
(tablespace full, buffer cache hit ratio) or browsing through the objects in a database 
via the Console Navigator tree. These types of functionality require database 
credentials on which to perform these operations. Rather than granting the 
powerful DBA role to the database credentials, many administrators prefer to 
provide only the necessary privileges required to do these operations. Granting the 
OEM_MONITOR role to the database credentials, ensures that the user has the 
minimum sufficient privileges required for these operations.

For database users on 7.3.x databases, you need to define the OEM_MONITOR role 
manually. 

Here are the steps you need to perform:

1. Create a role called OEM_MONITOR

drop role OEM_MONITOR;
create role OEM_MONTOR:

2. Grant the "connect" role to OEM_MONITOR

grant connect to OEM_MONITOR;

3. Grant the system privileges "analyze any" and "create table" to 
OEM_MONITOR

grant analyze any to OEM_MONITOR;
grant create table to OEM_MONITOR;

4. Create the SELECT_CATALOG_ROLE role as defined in sc_role.sql.

5. Grant the SELECT_CATALOG_ROLE to the OEM_MONITOR role

grant select_catalog_role to OEM_MONITOR;

Note: You need to create the OEM_MONITOR role using the SYS 
account.
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You are now ready to grant the OEM_MONITOR role to the database user that will 
be used as “database preferred credentials” in Enterprise Manager. In addition to 
granting the OEM_MONITOR role to a user, you must also ensure that the QUOTA 
for the user account is set to UNLIMITED. 

The “Continued Row” event test needs to analyze results into a table so it needs 
both the "analyze any" and "create table" privileges. 

Setting Up the Job System
This section includes information about setting up the Console for jobs.

Creating a Windows NT or Windows 2000 User Account for Running Jobs
In order for the Intelligent Agent to execute jobs on a managed node

■ a Windows NT or Windows 2000 user account must exist that has the advanced 
user right, "logon as batch job." The privilege can be assigned to an existing 
local or domain user, or a new Windows NT or Windows 2000 user.

■ the preferred credentials for the node must be set for that user in the Oracle 
Enterprise Manager Console. Refer to "Setting Up Preferred Credentials for 
Managed Services" on page 6-20.

■ the user must have read/write permissions to ORACLE_HOME\NETWORK 
directory as well as read, write, update, and delete permissions to the TEMP 
directory or the ORACLE_HOME directory. 

Creating a Windows NT or Windows 2000 user account is required to permit many 
of the components to allow the Intelligent Agent node to submit jobs to the server 
node.

Note: The "analyze any" privilege is used by the "index rebuild" 
event to compute statistics.  

Note: If you do not set up the "logon as batch job" privilege, you will 
receive the "Failed to authenticate user" message when you try to run 
jobs on the node.
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You must create a Windows NT or Windows 2000 user account for every managed 
node. Follow one of the three procedures listed below.

Creating a New Windows NT or Windows 2000 User Account
To create a new Windows NT or Windows 2000 user account on the Windows NT or 
Windows 2000 machine where the Intelligent Agent is installed and grant the "log 
in as batch jobs" privilege to this user, perform the procedure below.

1. Select the User Manager from the Administrative Tools via the Windows NT or 
Windows 2000 Start Menu. Refer to the Windows NT or Windows 2000 
documentation for information on the tools.

2. Select New User from the User menu and check for the following:

■ The "User Must Change Password at the Next Logon" option box is not 
checked

■ "SYSTEM" or "system" cannot be used for the user name.

3. Under the Policies menu of the User Manager Windows NT or Windows 2000 
utility, select the User Rights option.

4. Check the "Show Advanced User Rights" box.

5. Select "Logon as a batch job" from the list of privileges.

6. Give the selected user this privilege.

Assigning Privileges to an Existing Windows NT or Windows 2000 User Account
Alternately, to assign privileges to an existing local user account, perform the 
following steps.

1. Choose the user on the User Manager panel and check for the following:

■ The "User Must Change Password at the Next Logon" option box is not 
checked

■ "SYSTEM" or "system" is not used for the user name.

2. Under the Policies menu of the User Manager Windows NT or Windows 2000 
utility, select the User Rights option.

3. Check the "Show Advanced User Rights" box.

4. Select "Logon as a batch job" from the list of privileges.

5. Add the advanced user right to this user.
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6. Click the Add button.

a. Fill in the "List Names From" field: (choose your domain)

b. Click Show Users button.

c. In the listbox, choose the domain user.

d. Click Add.

e. Click OK.

7. In the User Rights Policy window, click OK.

Configuring a Windows NT or Windows 2000 Domain User as Your Intelligent 
Agent User

Alternately, to configure a domain user as your Intelligent Agent user, perform the 
following steps.

1. Under the Policies menu of the User Manager Windows NT or Windows 2000 
utility, select the User Rights option.

2. Check the "Show Advanced User Rights" box.

3. Select "Logon as a batch job" from the list of privileges.

4. Click the Add button.

a. Fill in the "List Names From" field: (choose your domain)

b. Click Show Users button.

c. In the listbox, choose the domain user.

d. Click Add.

e. Click OK.

5. In the User Rights Policy window, click OK.

Note: The Windows NT or Windows 2000 Domain User works only if 
the machine is a primary domain controller (PDC); otherwise, jobs will 
fail with VNI-2015 "authentication error." In all non-PDC environments 
the account must be local to the machine.
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Setting Up Preferred Credentials for Managed Services
In order for the Intelligent Agent to execute jobs or monitor events on a managed 
node, each administrator must specify valid credentials for the services running on 
that node. Preferred credentials are set from within the Console for each managed 
service.   

To set preferred credentials in the Console, follow the steps outlined below:

1. Select System > Preferences > Preferred Credentials to view the services 
available for management using the Intelligent Agent. 

2. For each managed service that requires authentication, enter the appropriate 
credentials for the service, such as username, password and role. 

3. If some services of a particular type require the same credentials, use the 
<DEFAULT> credentials selection for that service type to have those credentials 
used by all services of that type. 

For example, if Administrator_1 has a username and password of 
admin1/pass1 on all the databases that he manages, he only needs to enter 
admin1/pass1 as his credentials in the <DEFAULT> database entry. All 
databases administration tasks will use these <DEFAULT> credentials. 

Note: If you have both a local and a domain user with the same name, 
the local user takes precedence.

Note: If you have a domain user set up, you must set the domain 
password to be the same as the local password in order for scheduled 
jobs to run when they are submitted using the domain user account. 

Note: Oracle recommends that all instances of a Parallel server use the 
same preferred credentials as the Oracle Parallel Server.
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Furthermore, if he has just one database which requires different credentials 
from admin1/pass1, he can enter different credentials for that database by 
selecting that specific database. 

The Intelligent Agent authenticates the user name and password for all jobs and all 
events. If you have not set the preferred credentials correctly, jobs and events may 
fail.   

For Windows NT or Windows 2000 users, you must set the preferred credentials for 
the node (where the Windows NT or Windows 2000 Intelligent Agent resides) to be 
the same as the user that is set up to "Logon as a batch job." 

Important: Changes to the Preferred Credentials will not be 
automatically propagated to previously registered jobs and events. 
In order to update these jobs and events with the new preferred 
credentials, you must de-register and subsequently re-register the 
jobs and events.
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Configuring and Starting the Paging Service
If you want to be notified via paging in Oracle Enterprise Manager, you must 
explicitly install the Oracle Enterprise Manager Paging Server. This paging service 
is not installed as part of the base Oracle Enterprise Manager installation; it is 
installed through a Custom installation type. Refer to the installation guide 
provided with the database release for more details.

Only one paging service installation is required if you wish to utilize paging for 
notification purposes within Oracle Enterprise Manager. 

The paging service supports either numeric or alphanumeric pagers and utilizes the 
following paging service protocols (for alphanumeric pagers only).

■ TAP (Telocator Alphanumeric Protocol)

■ GSM (Global System for Mobile Communications)

■ FLEXTD

To use alphanumeric paging, you need a phone number to call for the modem at the 
paging service provider and the pin number for your pager. Contact your paging 
service provider for the phone number to call.  It is the number for the modem for 
sending pages.  

Your paging provider may also have a feature for sending email to your pager.  If 
you have that feature, you can configure an administrator’s preferences for 
notification to use email, and specify your pager as the email receiver. This method 
will also work with many providers for sending notification to a cell phone. 

Configuration of the paging service is not automatic. Follow the steps below to 
configure paging.

Setting Up Paging
On the machine from which you want to run the paging service, follow these 
instructions: 

1. Install a modem. 

Note: The Paging Server is only available on Windows NT or Windows 
2000, but the ability to configure it is available on both Unix and 
Windows platforms.
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2. Specify modem settings. 

a. Go to Start > Settings > Control Panel > Modems. 

b. Specify how your calls are dialed by clicking Dialing Properties from the 
Modems Properties page and then setting the following parameters: 

* From what area code you are dialing 

* From what country you are dialing 

* How you access an outside line. If you are not required to dial a 
number to access an outside line, leave this field blank. 

c. Set the Maximum Speed parameter by clicking Properties from the Modems 
Properties page. Oracle recommends setting this parameter to 9600K Baud; 
however, you should find the baud rate setting optimal for your system. 

3. Install the Oracle Enterprise Manager Paging Server. Refer to the installation 
guide provided with the database release for information. 

4. Start the Paging Service. 

a. Go to Start > Settings > Control Panel > Services. 

b. Select the Oracle<ORACLE_HOME_NAME>PagingService and click Start. 

You can also start the paging service by typing the following at a command 
prompt

oemctrl start paging

Note: You must have a modem installed on the Windows NT or 
Windows 2000 machine that you are running the paging service.

Note: A baud rate higher than 9600 may result in the loss of data with 
the paging service carrier. The baud rate of 9600 for your modem is only 
a recommendation. You must find the baud rate setting which is optimal 
for your system.
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Adding a Paging Server

1. From the Enterprise Manager Console, select Preferences from the System 
menu. The Edit Administrator preferences property sheet appears. Click the 
Notification tab to access the Notification page. 

2. From the Notification page, highlight Paging Servers from the tree list. 

Figure 6–3 Administrator Notification Preferences: Paging Server

3. Right-click Paging Servers to obtain the pop-up menu and choose the Add item 
or click the Add Server icon on the detail view to the right.

4. When the Add Paging Server dialog appears, enter the name of the machine on 
which the paging server runs. 

Note: Only Super Administrators can add a paging server; this 
functionality is not available to regular administrators.
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Figure 6–4 Add Paging Server Dialog

5. Press the OK button.

If the Console is unable to find the paging server with the given hostname, an error 
appears, saying "VD-4362: Could not add paging server, as paging server 
<hostname> could not be reached."

If the paging server is found, a new paging server object is added under the "Paging 
Server" object in the tree list. The new paging server will have no paging carrier. 
You must add at least one paging carrier in order for paging to function.

Adding Paging Carrier

1. From the Notification page, highlight Paging Carriers from the tree list. 

2. Right-click Paging Carriers to obtain the pop-up menu and choose the Add 
Carrier item or click the Add Carrier icon on the detail view to the right.

3. When the Add New Paging Carrier dialog appears, fill in the fields. 

Note: Only Super Administrators can add a new paging carrier; the 
functionality is not available to regular administrators.
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Figure 6–5 Add Paging Carrier Dialog

Once defined, you can view the paging carriers by expanding the appropriate 
paging server and carrier objects in the tree list.

■ Name

Paging carrier name. Field accepts alphanumeric characters and 
underscores.

■ Type

Type of paging carrier. Enterprise Manager supports alphanumeric or 
numeric.

■ Protocol

TAP, FLEXTD, or GSM. Protocol selection is only available if the carrier 
type is Alphanumeric.

■ Connection Properties

* Country Code: The country code used to dial the pager if the call is 
international. 

* Area Code: Area code used the by country in which the pager is 
located. 

* Number: Local dialing number of the pager. 
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* Suffix: Permits identification of voice messages from a paging carrier 
and allows the person being paged to choose from several options 
when using a touch tone phone. For example, commas can be used as 
pauses. The Suffix field accepts the following characters: integers, 
commas, pound sign, and the star (asterisk). 

■ Dialing Properties

* Timeout (in seconds): Maximum dialing time allowed for a successful 
page. 

* Delay (in seconds): Time delay before dialing. 

4. Press the OK button.

Specifying Paging Notification Preferences
While the Super Administrator configured the paging server and its carrier(s), all 
administrators who want page notifications must specify their own notification 
preferences by following the steps below:

1. Log on to the Console. 

a. Go to System > Preferences > Notification. Then highlight Paging on the 
tree list to view Paging Preferences on the detail view to the right.

b. Select a paging service carrier from the drop down list. 

c. Enter the Pin number for your alphanumeric pager. If you have a numeric 
pager, leave this field blank.

d. Test the paging notification by clicking the Test button. 

2. Set your notification schedule. If you neglect to do so, you will not receive page 
notifications. 

a. Within the Console go to System > Preferences > Schedule 

b. Choose when you want to be notified by paging. If you do not select any 
days/hours to be notified by paging, you will never receive a page. 

Note:  This option is only available if the paging carrier type is set to 
Numeric.
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Refer to the Oracle Enterprise Manager Administrator’s Guide for instructions on 
how to set up the notification schedule.

Other Paging Server Operations

Removing a Paging Server

1. From the Notification page, highlight the paging server object you want to 
remove from the tree list. 

2. Right-click the paging server object to obtain the pop-up menu and choose the 
Remove item or click the Remove Server icon on the detail view to the right.

A warning dialog appears, saying "Remove Paging Server <servername>?"

3. Click "yes". The Console will check if anyone is currently using any carrier from 
the paging server. If not, all paging carriers will be removed, and the paging 
server will be removed as well. Otherwise an error dialog appears, saying "The 
paging server cannot be removed because at least one carrier is being used.

Viewing Information on Paging Server

From the Notification page, left-click the paging server object. 

The detail view to the right will show information about that paging server such as 
the paging carrier names, the pager types, the protocol, and whether or not they are 
in use.

Note: Only Super Administrators can remove a paging server; the 
functionality is not available to regular administrators.

Note: Only Super Administrators can view information on a paging 
server; the functionality is not available to regular administrators.
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Pinging a Paging Server

To check the status of the paging server, follow the steps below:

1. From the Notification page, highlight the paging server you want to ping. 

2. Right-click the paging server object to obtain the pop-up menu and choose the 
Ping item or click the Ping Server icon on the detail view to the right.

Querying Status of the Paging Service
To check the paging status, right-mouse click the carrier name to access the Ping 
Paging Service item in the context-sensitive menu. 

Stopping the Paging Service
Stop the paging service from the Windows NT or Windows 2000 Services Control 
Panel.

You can also stop paging service by typing

oemctrl stop paging

Removing a Paging Carrier

1. From the Notification page, highlight the paging carrier object you want to 
remove from the tree list. 

2. Right-click the paging carrier object to obtain the pop-up menu and choose the 
Remove item or click the Remove Carrier icon on the detail view to the right.

A message appears, saying "Remove Paging carrier <carrier name>?"

Note: Only Super Administrators can ping a paging server; the 
functionality is not available to regular administrators.

Note: Only Super Administrators can remove a paging carrier; the 
functionality is not available to regular administrators.
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3. Click "yes." The Console checks if anyone is current using the carrier. If not, it 
will be removed and the notification tree updated.

Editing a Paging Carrier

1. From the Notification page, select the paging carrier object. The paging carrier 
information appears in the detail view to the right.

2. Make the changes.

3. Click the OK button.

The Console will validate all the carrier information, update the notification 
tree. All administrators who have selected to use this carrier will automatically 
inherit the new changes.

If the validation fails, an error dialog appears stating which entry failed to 
validate and what type of input is expected. When you click the "OK" button in 
the error dialog, all the paging carrier’s entries are set back to their original 
values.

Viewing Information about a Paging Carrier
From the Notification page, select the paging carrier object. The paging carrier 
information appears in the detail view to the right.

Testing a Paging Carrier
1. Right-click the paging carrier object and choose the "Test" menu item. A dialog 

appears, asking for the PIN. 

2. Enter the PIN if your pager is an alphanumeric pager and click "OK" to 
continue. If it is a numeric pager, leave this field blank.

Note: Only Super Administrators can edit a paging carrier; the 
functionality is not available to regular administrators.
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Setting Up Email and Paging Notification

Setting Up the SMTP Gateway
Oracle Enterprise Manager supports sending email notifications using SMTP. To 
allow administrators to use email for notification, the Super Administrator must 
specify the SMTP mail gateway that is used for the SMTP email system. 

SMTP is a TCP/IP-based mail protocol and requires that TCP/IP services are set up 
on the Console machine.

From the Enterprise Manager Console, the Super Administrator must select 
Configure SMTP Gateway from the System menu and supply the following 
information. 

If the Super Administrator does not specify the above information, when any 
administrator tries to configure his email notification, an error message will appear.

Setting Up Email and Paging Notifications
Then, each administrator must define preferences for his or her own email or 
paging notifications. From the Enterprise Manager Console, select Preferences from 
the System menu. The Edit Administrator preferences property sheet appears. Click 
the Notification tab to access the Notification page.

The Notification page allows you to set up paging and email notification methods 
for the administrator. This page consists of a hierarchical tree list and a detail view 
area that changes according to the object selected in the navigator. The tree list 
consists of three to four top-level objects, depending on the type of user that is 
logged in:

■ Filters (Selected by default)

■ Email 

Field Description

SMTP Mail Gateway: Enter the name of the machine on which the SMTP mail gateway 
resides, such as mailserver.company.com.

Sender’s SMTP Mail 
Address:

Enter the sender name you want to identify yourself as, such as 
Enterprise Manager Mail. Note: Some SMTP servers cannot 
process spaces. If that is the case with your environment, then 
use quotes, such as "Enterprise Manager Mail". The name 
specified will then appear as the sender of the email notification.
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■ Paging 

■ Paging Servers (available only to Super Administrators)

Figure 6–6 Administrator Notification Preferences

Filters
Notification filters allow each administrator to specify when to send an email 
notification as opposed to a page notification as a result of a job or event status 
change. 

■ Event Notification Filter: The Event Notification Filter allows you to filter 
email/pages sent to an administrator according to the event’s level of severity. 
Filtering is set at the user level by checking or unchecking the Email/Page 
options on this property sheet page. You can select any combination of the 
following levels of event severity. For example, you can set filtering so that an 
administrator is notified via email if there is a warning and notified via the 
paging system if there is an alert. Selecting all levels of severity provides no 
filtering.

■ Alert

■ Warning
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■ Clear

■ Node Down

■ Reassign

Job Notification Filter  The Job Notification Filter allows you to filter email/pages sent 
to an administrator according to job status. As with the Event Notification Filter, 
filtering is set at the user level by checking or unchecking the desired option. 
Selecting all job statuses provides no filtering. 

■ Start

■ Complete

■ Fail

■ Delete (Job removed)
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Email
This page allows you to specify notification parameters for email. 

Figure 6–7 Administrator Notification Preferences: Email

■ Receiver’s Email: Enter the email address of the administrator to whom the 
mail is being sent.

■ Subject Prefix: Enter an optional prefix that is appended to the E-mail subject. 
That allows administrators to quickly identify messages from Enterprise 
Manager in their mail. 

■ Limit message length: Allows you to specify the maximum message body 
length of an E-mail notification. By default, this length is unlimited. 

■ Current Definition: Displays the current settings for format and content of 
E-mail notifications. To set or change the default parameters, expand the Email 
object in the tree list. You can select format and content options for the Subject 
line and Message Body. You can further expand the Message Body object to 
specify options at the Per Event Test level. 

■ Test: Click the Test button to check the validity of E-mail configuration. A 
message displays to inform you of the status of the test email. 
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Email Subject Definition  This page allows you to select the content and format of the 
email subject line. By default, Type, Name, and Status are selected. You use the 
left/right arrows to move items back and forth between the Available and Selected 
lists.

Once an item has been selected, you can control the order in which the item appears 
by selecting it in the list and using the up/down arrows (located to the immediate 
right of the Selected list) to reposition the item within the list. 

■ Available: Lists available content.

■ Selected: Lists currently selected content and the order in which the content 
should be displayed. 

■ Use Abbreviated Format: For Type (Job or Event), Status, and Target Type, you 
can select the Use Abbreviated Format option. The following abbreviations are 
used by the system:

Target Type

■ DB for Database

■ L for Listener

■ N for Node

Status

■ S for Started

■ CO for Completed

■ F for Failed

■ D for Deleted

■ W for Warning

■ A for Alert

■ C for Cleared

■ NU for Node Unreachable

Note: The following information also applies to inserting content 
into the Email/Paging message body.
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■ R for Reassign

Timestamp Format

This option is available if Timestamp is chosen from the Selected list. You use the 
pull-down menu to select one of the pre-defined formats.

Do not include titles

When selected, classification titles such as Status, Service Name, and Timestamp are 
omitted from the message. 

Append job output

When selected job output is appended to the end of the notification. For instances 
where job output is large, you may want to specify a limit to the message length. If 
the job output pushes the notification length past the specified limit, then the job 
output will be truncated, not the message itself.
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Paging
This page allows you to specify notification parameters for paging. 

Figure 6–8 Administrator Notification Preferences: Paging

■ Carrier: After a paging server is specified by a Super Administrator and the 
name of the paging carrier service and the corresponding paging carriers have 
been configured, select the name of the paging carrier service from the 
pull-down list.

■ PIN: Enter the PIN for your paging carrier. This entry is only required for 
alphanumeric pagers. 

■ Limit message length: Allows you to specify the maximum message length of 
paging notifications. By default, this length is set to 256 characters.

■ Current Definition: Displays the current settings for format and content of 
paging notifications. To set or change these parameters, expand the Paging 
object in the tree list. You can select format and content options for the Message 
Body. You can further expand the Message Body object to specify options at the 
Per Event Test level. 
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■ Test: Click the Test button to check the validity of the paging configuration. For 
alphanumeric pagers, enter the PIN number. For numeric pagers, the message 
"700" is sent. 

Click on the Send button to send a test page to the specified pager. A message 
informs you of the status of the test page.

If the test fails, check the log file. If tracing is enabled for paging, you can also 
view the paging trace log file in the ORACLE_HOME\sysman\log directory on 
the machine which has the paging server. 

Paging Status Codes for Numeric Pages
Numeric pages need to be interpreted as follows: 

For job notifications, you will receive a 3 digit number which indicates the job 
status. 

For event notifications you will receive the status code. 

The event status and job status codes are listed as follows:

100 = Job Started 

200 = Job Completed

300 = Job Failed

400 = Job Deleted

500 = Event Cleared

600 = Event Warning

700 = Event Alert

800 = Event Node Down

900 = Event Unknown

1000 = Event Assignee Changed

Email/Paging Message Body Definition
This page allows you to select the content and format for the body of the email or 
page message. By default, Name, and Status are selected. You use the left/right 
arrows to move items back and forth between the Available and Selected lists. 
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Figure 6–9 Administrator Notification Preferences: Email/Paging Body

Expanding the Message Body object in the navigator and selecting per Test allows 
you to use a subset of the following option settings on a per test basis. Refer to 
"Email Subject Definition" on page 6-35 for more information on manipulating 
message content. 

■ Available: Lists available content.

■ Selected: Lists currently selected content.

■ Use Abbreviated Format: For Type (Job or Event), Status, and Target Type, you 
can select the Use Abbreviated Format option. The following abbreviations are 
used by the system:

Target Type

■ DB for Database

■ L for Listener

■ N for Node

Status

■ S for Started

■ CO for Completed
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■ F for Failed

■ D for Deleted

■ W for Warning

■ A for Alert

■ C for Cleared

■ NU for Node Unreachable

■ R for Reassign

Timestamp Format

This option is available if Timestamp is chosen from the Selected list. You use the 
pull-down menu to select one of the pre-defined formats.

Do not include titles

When selected, classification titles such as Status, Service Name, and Timestamp are 
omitted from the message. 
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Paging Server
The paging server object is available only to Super Administrators.

This page lists all available paging servers currently recognized by Enterprise 
Manager. The multi-column list consists of two columns: the name of the paging 
server and whether the paging server is currently being used.

Figure 6–10 Administrator Notification Preferences: Paging Server

Refer to the "Configuring and Starting the Paging Service" on page 6-22 for more 
information about the following topics: 

■ Adding a Paging Server

■ Adding Paging Carrier

■ Removing a Paging Server

■ Viewing Information on Paging Server

■ Removing a Paging Carrier

■ Editing a Paging Carrier

Except for the Add Paging Server icon, the icons are grayed out unless a specific 
paging server is selected from the list. 
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Configuring the Console If Using a Dialup Line to Connect to the 
Management Server 

When the Console connects over a dialup line, the Console machine obtains a 
dynamic IP address. This dynamic IP address needs to be sent by the operating 
system (Windows 2000, Windows NT, Windows 95, Windows 98) to the application 
(Console). 

In order for the operating system to return the correct IP address, the network 
communication protocol (TCP-IP) needs to be configured to obtain the IP address 
using the Dynamic Host configuration protocol. This setting is specified as follows: 

1. Go to Start menu-> Settings

2. Select Control Panel -> Network 

3. Select Protocols 

4. Double-click TCP-IP Protocol.

IMPORTANT: You must make note of your previous settings in order to return to 
those settings when you connect the same machine to the network via ethernet. 
Copy the Settings specified in IP Address, Subnet Mask and Default Gateway to a 
file. 

5. On the IP Address page, select "Obtain an IP address from a DHCP Server." 

6. Click the OK button. 

7. Connect to the network via your dial-up line. You will now be successfully able 
to launch the Console. 

Note: Dynamic IP addresses attributed by DHCP are not supported on 
nodes running the Management Server or an Intelligent Agent. DHCP is 
supported only on Enterprise Manager clients.

Note: If you are not running from a web browser, you may need to 
restart your system after making the changes.
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Configuring a Remote Database for Backup or SYSDBA Administration
Before using one of the backup management wizards or starting up or shutting 
down a database through Oracle Enterprise Manager, you need to set up your 
database for remote SYSDBA management. 

The following procedure outlines the operations you may need to perform on both 
the server and client if they have not been performed already through the Database 
Configuration Assistant. 

Additional Information: Refer to the operating system-specific documentation for 
your Oracle database for the exact name of the password file creation utility for 
your system.

Server Side (Windows NT or Windows 2000)
1. From the command prompt, run the ORAPWD executable to create a new 

password file.

For example,

$ORACLE_HOME\bin\orapwd file=<fname> password=<password> entries=<users>

where

fname is the name of password file (mandatory),

password is the password for SYS (mandatory),

entries is the maximum number of distinct DBAs and OPERs (optional),

There are no spaces around the equal-to (=) character.

The <fname> will be created in the Oracle_Home/Database directory. 

Note: The name of the ORAPWD executable depends on the database 
version.

■ Oracle 7.3.X: ORAPWD73

■ Oracle 8.0.X: ORAPWD80

■ Oracle 8.1.X: ORAPWD
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2. Edit the init.ora file located in the Oracle_Home/Admin/<SID>/pfile 
directory. Add or change the following parameter 
remote_login_passwordfile=exclusive in the init.ora file. 

3. Shut down your database and then restart it from Control Panel > Services.

4. Grant SYSDBA and/or SYSOPER roles to users who will be performing remote 
DBA operations.

5. Check which users are defined in the password file by using the 
V$PWFILE_USERS view. The view will show which users are currently present 
in the password file.

Server Side (UNIX)
1. Login as the owner of the software (for example, Oracle) and set your 

environment variables. The following is a CSH example.

setenv ORACLE_HOME  the_database_home
setenv ORACLE_SID   the_database_sid

2. Change to the dbs directory in your Oracle home.

cd $ORACLE_HOME/dbs

3. Edit the init.ora file. Add or change the following parameter 
remote_login_passwordfile=exclusive in the init.ora file. 

4. Shut down your database and then restart it. 

a. Start SQL*Plus Worksheet. 

b. Log in as a user with the SYSDBA role.

c. Type

shutdown immediate 

Note: The grant is necessary even if the user already has this privilege 
set. The GRANT command will flush the username and the password to 
the password file if one is defined. After each reset/recreate of the 
password file, grants for all users with SYSOPER and SYSDBA have to 
be reset to ensure that the password file has all the necessary usernames 
stored.
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startup

Shutting down the database is necessary for the database to pick up the changes 
in the init.ora file.

5. Run the ORAPWD executable to create a new password file.

For example,

$ORACLE_HOME/bin/orapwd file=<fname> password=<password> entries=<users>

where fname is the name of password file (mandatory), 

password is the password for SYS (mandatory), 

entries is the maximum number of distinct DBAs and OPERs (optional). 

There are no spaces around the equal-to (=) character. 

The <fname> will be created in the $Oracle_Home/dbs directory. 

6. Grant SYSDBA and/or SYSOPER roles to users who will be performing remote 
DBA operations

Note: The name of the ORAPWD executable depends on the database 
version.

■ Oracle 7.3.X: ORAPWD73

■ Oracle 8.0.X: ORAPWD80

■ Oracle 8.1.X: ORAPWD

Note: The grant is necessary even if the user already has this privilege 
set. The GRANT command will flush the username and the password to 
the password file if one is defined. After each reset/recreate of the 
password file, grants for all users with SYSOPER and SYSDBA have to 
be reset to ensure that the password file has all the necessary usernames 
stored.
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7. Check which users are defined in the password file by using the 
V$PWFILE_USERS view. The view will show which users are currently present 
in the password file.
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Setting the Format of Dates
To set up how the order of the date elements are to be displayed in the Oracle 
Enterprise Manager Console and DBA Studio, you must set the following 
environment variables:

■ NLS_DATE_FORMAT for the month, date, and year

mm-dd-yyyy

■ NLS_TIMESTAMP_FORMAT for the date and time

mm-dd-yyyy hh:mi pm

Windows Platforms
To set the environment variable:

set NLS_DATE_FORMAT = mm-dd-yyyy
set NLS_TIMESTAMP_FORMAT = mm-dd-yyyy hh:mi pm

UNIX
To set the environment variable:

setenv NLS_DATE_FORMAT mm-dd-yyyy
setenv NLS_TIMESTAMP_FORMAT mm-dd-yyyy hh:mi pm

Note: You can only set up the order in which the elements are to be 
displayed; you cannot set up what is to be displayed.
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Migrating a Release 1.x Repository to a

Release 2.2 Repository

The Oracle Enterprise Manager Migration Assistant supports migrating data for 
both Oracle Enterprise Manager and the Oracle Enterprise Manager Management 
Packs. 

This chapter describes methods for migrating multiple Release 1.x repository 
schemas into an existing single "shared" Release 2.2 repository schema. 

An Oracle Enterprise Manager Release 1.x repository schema is not the same as an 
Oracle Enterprise Manager "shared" Release 2.2 repository schema. In Enterprise 
Manager Release 1.x, each administrator had a separate repository schema which 
contained the current view of the network and user-specific information. In 
Enterprise Manager Release 2.2, administrators have accounts within a single 
shared repository schema, and all individual preferences are stored in the 
administrator’s account.

A Release 2.2 repository may not coexist with a Release 1.x repository in the same 
schema. A Release 2.2 repository and a Release 1.x repository may reside in the 
same database, but in a different schema.

Note: Migration requires that you first create a Release 2.2 repository 
using the Enterprise Manager Configuration Assistant. Migration is 
performed from a Release 1.x repository into an already existing Release 
2.2 repository.
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The Migration Assistant supports the migration of the following information into 
an existing Release 2.2 repository:

■ discovery information

■ preferred credentials

■ job information

■ event information

■ groups

Note: If you do not have a Release 1 repository, skip this chapter.

Note: The Migration Assistant only runs on Windows NT, but it can 
migrate repository data from any Release 1.x repository to Release 2.2 
regardless of the source and destination repository database platforms.
7-2 Oracle Enterprise Manager Configuration Guide                             



Important Notes
Important Notes

Phases of Migration
The phases for migrating a Release 1.x repository are listed below:

1. Preparing for Repository Migration

a. Create New Release 2.2 Administrators

b. Refresh All Services in the Release 1.x Console

c. Check the Information Currently in the Release 1.x Repository

d. Back Up the Existing Release 1.x Repository

2. Migrating the Repository Using the Migration Assistant

3. Deleting and Deregistering All Active Jobs and Events from the Release 1.x 
Console.  If you do not delete and deregister active jobs and events from the 
Release 1.x Console, there could be duplicate jobs running at the Intelligent 
Agent. Events will fail to register due to "not unique" errors. 

4. Confirming a Successful Migration

Note: Before you start migration, you must back up the database and 
the Release 1.x repository to ensure that the current Release 1.x Oracle 
Enterprise Manager environment and Release 2.2 environment can be 
recovered in the event of an unexpected failure.

Note: If you perform any work with Release 2.2 after you have fully 
migrated your Release 1.x repository to Release 2.2, you cannot go back 
to using that repository with Release 1.x. Rolling back to Release 1.x due 
to problems during repository migration to Release 2.2 is supported only 
if you perform the complete set of pre-migration steps and you do not 
begin work in the Release 2.2 environment.
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How the Differences Between Release 1.x and Release 2.2 Impact 
Migration

The repository migration operation changes the existing Release 1.x repository in 
several ways.

Refer to Release 1.x Objects Reference on page 7-24 for a comprehensive list of the 
Release 1.x objects and whether or not they can be migrated to Release 2.2.

Repository
The Oracle Enterprise Manager Migration Assistant migrates Release 1.6.5 
repositories to Release 2.2. If the Oracle Enterprise Manager Migration Assistant is 
run against a release earlier than 1.6.5, that repository is first upgraded to 1.6.5 in 
place, and then the upgraded repository is migrated to 2.2. Oracle Enterprise 
Manager Release 1.2 is the earliest version supported for in-place upgrades to 
version Release 1.6.5. If the target repository version is less than 1.6.5, then after the 
migration it is no longer functional with Oracle Enterprise Manager Release 1.x. 
Before beginning the migration of any repository, first back up the schema and/or 
tablespace.

Preferred Credentials
Username, passwords, and roles are migrated. When migrating multiple Release 1.x 
repositories to a single Release 2.2 repository with one administrator, the first 
preferred credentials migrated for a service which existed in more than one Release 
1.x repository will be the preferred credentials from the first Release 1.x repository 
migrated. 

Groups
In Release 1.x, jobs and events can be registered against a group appear as a single 
job or event on the Console. In Release 2.2, when a job or event is registered against 
a group, a separate job/event object appears in the Console for each service on 
which the job/event is registered. When migrating a job/event registered against a 
group in Release 1.x to Release 2.2, a separate job or event object will appear in the 
Release 2.2 Console for each service within that Group on which the job/event is 
registered.
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Jobs
■ Only active jobs that are not "fixit" jobs and active jobs that fall within the 

Release 2.2 frequency limitations will be automatically submitted to the Oracle 
Enterprise Manager Job System. 

■ If a job named NAME was migrated to a target database where a job was 
already named NAME, it would be renamed to NAME(1) during migration. If 
there already was a NAME(1), it would be renamed to NAME(2), and so on. 

Backup Jobs
If a backup job is running in Release 1.x and you migrate the data, the job appears 
as a tcl job in Release 2.2. Note: Backup jobs in the job library will not be migrated. 
Backup Manager Jobs differ significantly from Backup Tablespace Jobs in the Oracle 
Enterprise Manager Console.

Fixit Jobs
Release 1.x fixit jobs are migrated to the Release 2.2 job library, but are not 
automatically submitted. The Release 2.2 fixit jobs must be resubmitted from the 
Release 2.2 job library manually after migration. A Release 1.x event associated with 
a Release 1.x fixit job is separated and placed in the Release 2.2 event library and 
Release 2.2 job library respectively (not submitted). After migration, you must edit 
the Release 2.2 event in the Release 2.2 event library and reassociate it with the "V2 
manually resubmitted" fixit job. 

Events
■ Only registered events that are not associated with "fixit" jobs and events that 

fall within the Release 2.2 frequency limitations will be automatically 
submitted.

■ If an event named NAME was migrated to a target database where an event 
was already named NAME, it would be renamed to NAME(1) during 
migration. If there already was a NAME(1), it would be renamed to NAME(2), 
and so on. 

■ The Event "Destination Type" must be the same in Release 2.2 to associate a fixit 
job with an event. For example, if you created a Release 1.x event with a 
"Service Type"  "Database" and you had associated it with a Release 1.x Fixit Job 
such as a "Broadcast Message" of "Service Type"  "Node". The Release 1.x event 
and Release 1.x fixit job with different "Service Types" can be associated and 
registered together. In Release 2.2 the "Destination Type" must be the same as 
the fixit job "Destination Type" to associate and register them together. 

If you migrate an event and a fixit job like the above example, you must 
perform a "Create Like..." on the Release 1.x fixit job and change the Release 2.2 
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"Destination Type" of this job to match the "Destination Type" of the Release 2.2 
event.

Event Sets
■ With the Release 1.x architecture, an "event set" is a collection of individual 

events which were registered to a discovered service. In the Release 2.2 
architecture, an "event" is the collection of individual tests. The Release 2.2 
"event" is similar to the Release 1.x "event set." In Release 2.2, the individual 
Release 1.x "events" are now called "tests." Each "test" still has the same 
possibilities and settings as the Release 1.x Events, and an Event can be defined 
in the same way as a Release 1.x Event Set. When migrating Release 1.x Event 
Sets, each Release 1.x event within the event set is migrated to Release 2.2 as a 
separate event.

■ For Release 2.2 Events, frequency, frequency units, and fix it jobs are assigned at 
the "Event" (or top) level. These items were assigned at the Release 1.x "Event" 
(or low) level. If these items are not the same for all Events in a Release 1.x 
Event Set, each Event in the Release 1.x Event Set will be migrated to a separate 
Release 2.2 Event. If these items are the same for all Events in a Release 1.x 
Event Set, the entire Release 1.x Event Set will be migrated to a single Release 
2.2 Event.

Frequency
Frequency options for jobs and events in Release 2.2 differ from those in Release 1.x. 
Jobs or events that have a frequency that is supported in Release 1.x but not 
supported in Release 2.2 must be submitted or scheduled again in the Release 2.2 
environment. For example: Release 2.2 events support polling intervals of 23:59 
hours or less. Release 1.x supports polling intervals greater than 23:59 hours.

Performance Manager/Capacity Planner 
Any number of Release 1.x Performance Manager/Capacity Planner repositories 
can be migrated to the Release 2.2 repository, but each must be associated with its 
own unique Release 2.2 administrator. 

Change Management Pack
■ CAUTION: If you are migrating a Change Manager Release 1.5.5 repository, the 

migration process will first upgrade it to Release 1.6.5 before migrating it. This 
upgrade cannot be reversed, and you will be unable to use Change Manager 
Release 1.5.5 with this repository. You may therefore want to back up the 
Release 1.5.5 repository, and restore it after the migration, in order to continue 
using it with Change Manager Release 1.5.5.

■ Each Oracle Change Management Pack Release 1.x repository that you migrate 
must be migrated to a Release 2.2 repository that contains no change plans or 
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baselines for any of the administrators. If any change plans or baselines exist for 
any administrator, you must delete the plans or baselines before starting the 
Change Management Pack Release 1.x repository migration. If you do not, the 
Change Management Pack migration fails. In this situation, the 
sysman\temp\vobmgr.log file contains messages that identify which 
administrators in the Release 2.2 repository have plans or baselines that must be 
deleted. Use Plan Manager to delete change plans and DB Capture to delete 
baselines.

Expert
The Oracle Expert Release 1.x repository tables are migrated to a Release 2.2 
repository using an Oracle Expert tuning session export/import methodology. All 
tuning sessions under all databases in the Release 1.x repository are exported into 
.xdl files (one per database) and then imported into the Release 2.2 repository under 
the selected Oracle Enterprise Manager user. 

Paging Services
■ Schedule information for a Release 1.x user will not be migrated to a Release 2.2 

Administrator. Each user must define a new paging schedule in the Release 2.2 
environment. 

■ Paging configuration information will not be migrated to Release 2.2. Each user 
must define new paging confirmation information in the Release 2.2 
environment. 

Email Services
■ Schedule information for a Release 1.x user will not be migrated to a Release 2.2 

Administrator. Each user must define a new email schedule in the Release 2.2 
environment. 

■ Email configuration information will not be migrated to Release 2.2. Each user 
must define new email confirmation information in the Release 2.2 
environment. 

Manually Discovered Nodes and Manually Added Services
Manually discovered nodes and manually added services will not be migrated.
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Preparing for Repository Migration
To prepare for a successful migration, you must complete the following procedures:

■ Install Oracle Enterprise Manager Release 2.2. Refer to the installation guide 
provided with the database release for detailed information.

■ Create New Release 2.2 Administrators

■ Refresh All Services in the Release 1.x Console

■ Shut Down the Release 1.x Console and the Release 2.2 Management Server

■ Check the Information Currently in the Release 1.x Repository

■ Back Up the Existing Release 1.x Repository

Create New Release 2.2 Administrators
Using the Migration Assistant, you can migrate a single Release 1.x repository to a 
single Release 2.2 repository or migrate multiple Release 1.x repositories to a single 
Release 2.2 repository.

For both cases, you must first create the new administrators which will have 
Release 1.x repository information migrated to their Release 2.2 account.

Each Enterprise Manager administrator is a separate user in the repository database 
account.

To create new administrators, follow the steps below:

1. Start the Management Server.

Refer to Chapter 3, "Controlling the Management Server" for detailed 
information on starting the Management Server.

2. Log into the Oracle Enterprise Manager Console Release 2.2 using the SYSMAN 
account. Refer to Chapter 6, "Setting Up the Console" for detailed information 
on starting the Enterprise Manager Console.

Note: If you do not create new Release 2.2 administrators, all objects 
migrated are migrated to the SYSMAN account. The SYSMAN account is 
the default super administrator account provided when you install 
Oracle Enterprise Manager Release 2.2.
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3. Select Manage Administrators from the Console’s System menu. The Manager 
Administrator Accounts dialog appears.

4. Click the Add button in the Manage Administrator Accounts dialog. The Create 
Administrator Account dialog appears.

5. Enter a unique username and password for the Enterprise Manager 
administrator and check the access available to the administrator:

For more information on managing Enterprise Manager Administrators, refer to the 
the Oracle Enterprise Manager Administrator’s Guide.

Refresh All Services in the Release 1.x Console
Before migration, you must make sure that all services that need to migrate have 
been successfully refreshed by the Release 1.x Console. 

Any service that has not been successfully refreshed will not migrate. 

Shut Down the Release 1.x Console and the Release 2.2 Management Server
Shut down the Release 1.x Console and the Management Server, if running. The 
remote Intelligent Agents are left running and existing queue files are left intact. 
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Check the Information Currently in the Release 1.x Repository
To ensure that no information is lost during migration, check the information 
currently in the Release 1.x repository. Later, you will use this information as a 
guide to verify whether the information is present after the migration to Release 2.2.

In the V.1x repository, check for the following information:

1. For discovery information, count the number of discovered hosts and services 
in the Release 1.x environment 

2. View the credential information for at least one node

3. For job information, relevant information to note includes the following:

■ number of jobs

■ type of job

■ job state

■ job history information

4. For event information, note relevant information such as the following:

■ number of event groups

■ number of events in each group

■ nodes where each group is registered

■ current state of the event
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Back Up the Existing Release 1.x Repository
The Migration Assistant does not support automatic recovery when an unexpected 
error occurs during the migration. To ensure that the current Release 1.x Oracle 
Enterprise Manager environment and Release 2.2 environment can be recovered in 
the event of an unexpected failure, you should backup both the Release 1.x 
repository and the Release 2.2 repository.

To backup the repository, you may use Enterprise Manager’s Export wizard or the 
EXPORT utility, a base utility shipped with the Oracle database server. For 
information about using Data Management wizards, refer to the Oracle Enterprise 
Manager Online Help.

The following example is from an NT environment running an 8.0 server.

exp80 user/password@service owner=oemv1schema file=oemv1.dmp

where USER is the username for the Oracle Enterprise Manager repository to be 
migrated and PASSWORD is the password for the user.

In this example, the saved repository is written to oemv1.dmp.

A message appears at the end of the export, telling you whether the export 
completed successfully:

Export terminated successfully without warnings.

For detailed information about the Export utility, refer to Oracle8i Release 2 (8.1.6) 
Utilities.

Note: A repository created under the SYS user cannot be exported. 
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Migrating the Repository Using the Migration Assistant
Follow the instructions for each database in the Release 1.x Oracle Enterprise 
Manager environment you want to migrate.

Start the Enterprise Manager Migration Assistant from the Windows NT Start 
Menu.
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Step 1 "Introduction"
After launching the Migration Assistant, the “Introduction” page appears, 
providing important information about the purpose of the Migration Assistant and 
any preconditions that are required for the migration to be successful. 

Figure 7–1 Introduction

Read the introduction; then, press Next to continue. 

If you have one or more system management packs installed, proceed to Step 2 
"Component Selection" on page 7-14.

If you do not have any system management packs installed, proceed to Step 3 
"Source Repository Login" on page 7-15.
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Step 2 "Component Selection"

Choose the repository components that you want to migrate. 

Only installed components are available for selection. If a valid target repository 
does not exist for the component, one will be created.

Figure 7–2 Component Selection

After you have made your selection, press the Next button to continue.

Note: The Component Selection page only appears if you have one or 
more system management packs installed.
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Step 3 "Source Repository Login"
Login to the database where the Release 1.x repository is located.

Figure 7–3 Source Repository Login

Username and Password: You must provide a valid username for the database where 
the Release 1.x repository is located.

Service: Use the standard SQL*Net V2 or Net8 syntax. The service name is the name 
of the database as it appears in the tnsnames.ora file.

Connect As: Connect as "Normal." 

Press Next to continue.

If the information supplied is valid and a valid Release 1.x repository is present, 
proceed to Step 4 "Target Repository Login" on page 7-16.
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Step 4 "Target Repository Login"
Provide the username, the password, and the service name for the new Release 2.2 
repository. 

Figure 7–4 Target Repository Login

Username and Password: The Oracle Enterprise Manager username must be the same 
as the username under which the Release 2.2 repository is created. In other words, 
these are the repository schema owner’s credentials. The Oracle Enterprise Manager 
Release 2.2 repository is an Oracle database schema. The user name and password 
is not the Oracle Enterprise Manager user logon.

Service: Use the standard SQL*Net V2 or Net8 syntax. The service name is the name 
of the database as it appears in the tnsnames.ora file.

Press Next to continue.

If you have provided a valid repository name, password, and service for a valid 
Release 2.2 repository, proceed to Step 5 "Administrator Data" on page 7-18. The 
Oracle Enterprise Manager Migration Assistant also informs you through a dialog if 
7-16 Oracle Enterprise Manager Configuration Guide                             



Migrating the Repository Using the Migration Assistant
the information to be migrated already exists in the Release 2.2 repository and if the 
format of the information is different from the format of the Release 1.x information 
and how this information has been converted. 
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Step 5 "Administrator Data"
Specify the Release 2.2 administrator where the information will be migrated. 

Figure 7–5 Version 2.2 Administrator Data

Click Finish to initiate the migration process or click Back to return to previous 
pages to change the information.

Note: If you have not created additional Release 2.2 administrator 
accounts, all object migrated will be migrated to the SYSMAN 
administrator account.
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Work in Progress
A Work in Progress window appears, showing your progress. All information in the 
Work in Progress window is logged into the vobmgr.log file, which is located in 
the %oracle_home%\sysman\temp directory.

Note: If you are migrating a Release 1.x repository with the Change 
Management Pack installed but have not yet used a Change 
Management Pack application, the Change Management objects will 
automatically be created in the new Release 2.2 repository.
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Deleting and Deregistering All Active Jobs and Events from the Release 
1.x Console

The repository migration from Release 1.x into the Release 2.2 environment must be 
coordinated. Part of the migration process is to delete and deregister all active 
Release 1.x jobs and events by hand. 

Job and event information defined in the Release 1.x repository is copied to the 
Release 2.2 repository. 

After performing the repository migration, follow the steps outlined below:

1. Start the Release 1.x Console, connecting to the Release 1.x repository that was 
just migrated. 

2. Delete/deregister all active jobs and events manually. If you do not delete and 
deregister active jobs and events, there could be duplicate jobs running at the 
Intelligent Agent. Events will fail to register due to "not unique" errors. 

3. Shut down the Release 1.x Console(s). 

4. Start the Management Server. 

Note: If you migrate information and do not start the Release 1.x 
Console and remove jobs and events before starting the Management 
Server; then, the initial start will attempt the registration of events and 
submission of jobs. Jobs will register, but events may fail as the event is 
already registered with the Intelligent Agent from the Release 1.x 
Console (Intelligent Agent’s restriction on uniqueness of events). 

The failure will be presented at the Console. You can de-register the 
Release 1.x event and attempt the re-registration via Create Like... from 
the failed event registration on the Release 2.2 Console.

Note: You must repeat the same steps to migrate each of the Release 1.x 
repositories into the single Release 2.2 repository.
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Confirming a Successful Migration
After the Migration Assistant has moved the Release 1.x repository information into 
the specified Release 2.2 administrator, login to the Release 2.2 Console as that 
administrator and confirm the migration. 

You must ensure that all information is present after repository migration by 
checking that the discovery, preferred credentials, job and event information has 
migrated successfully.

1. For discovery information, check that the hosts and services are represented 
after migration via the Console navigator.

2. Credential information for at least one node should be viewed by using the 
Release 2.2 Console navigator to access the database using the migrated 
credentials.

3. For job information, relevant information to check include the number of jobs, 
the type of job, and the job state, and relevant job history information. Certain 
Release 1.x jobs contain tasks which do not migrate into Release 2.2. These need 
to be taken into account as well. Refer to Release 1.x Objects Reference on page 
7-24 for job tasks that do not migrate.

4. For event information, relevant information to note includes the number of 
events, the number of tests in each event, the nodes where each group is 
registered, and the current state of the event. Refer to Release 1.x Objects 
Reference on page 7-24 for event tests that do not migrate.

5. For the number of Performance Manager recordings and user-defined charts 
which were successfully migrated, check the migration log file, 
sysman\temp\vobmgr.log.

Note: The Migration Assistant does not migrate any manually 
discovered targets.

Note: If the Release 2.2 Console is unable to match the migrated service 
name with the service name stored in the credentials table that the 
Release 1.x Console used, you must reenter the preferred credentials 
through the Release 2.2 Console after migration for the affected service.
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6. For information about the Oracle Expert migration process, check the 
sysman\temp\vobmgr.log file and the more detailed 
sysman\temp\xpomigr.log file.

7. For Change Management you need to count the number of baselines and 
change plans in PlanMan and Capture in Release 1.x and compare the number 
to the number migrated in Release 2.2.
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Backing out of a Migration
In the event of an unexpected problem during the migration, you may need to 
restore the Oracle Enterprise Manager environment to its previous state. To restore 
the Oracle Enterprise Manager environment:

1. Drop the old Release 1.x repository user using DBA Studio’s Security 
Management. Refer to the Oracle Enterprise Manager Online Help for detail 
information about Security Management.

2. Import the saved Release 1.x repository user using Import wizard or the 
IMPORT utility, a base utility shipped with the Oracle database server. The user 
is recreated when you import. For information about using Import wizard, refer 
to the Oracle Enterprise Manager Online Help. The following example uses the 
IMPORT utility.

imp user/password@service file=oemv1.dmp

Importing the schema will "recreate" the Release 1.x repository as it was before 
migration.

For detailed information about the Import utility, refer to Oracle8i Utilities.

Note: Jobs and events must be reregistered if they have been 
deregistered. 
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Release 1.x Objects Reference
Refer to the sections below for a comprehensive list of the Release 1.x objects and 
whether or not they can be migrated to Release 2.2.

Release 1.x Objects Which Will Migrate to Release 2.2
The following Release 1.x objects can be migrated to Release 2.2:

Preferred Credentials
Username, passwords, and roles are migrated. When migrating multiple Release 1.x 
repositories to a single Release 2.2 repository with one administrator, the first 
preferred credentials migrated for a service which existed in more than one Release 
1.x repository will be the preferred credentials from the first Release 1.x repository 
migrated. 

Services
Databases, Nodes and Listeners are migrated if the status of the last 
discovery/refresh of these services was successful. 

Groups: In Release 1.x, jobs and events are registered against groups as a single 
object. If a job or event is registered to a group in Release 1.x; then, the job or event 
is migrated to Release 2.2 by creating a separate job or event for each service on 
which the job or event is registered. 

The job or event is not migrated to a group since groups are not migrated as a 
logical entity. No group will exist on the Release 2.2 side. All of the Release 1.x 
group members will migrate individually to Release 2.2. The group will need to be 
recreated in Release 2.2, and the migrated members must be added again.
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Jobs

Fixit Jobs

Events

Others

Run DBA Script Startup Database Run TCL

Run SQL * Plus Broadcast Message Shutdown Listener

Shutdown Database Run OS Command Startup Listener

All Schedule Information Override Preferred Credentials Job History

Dependent Jobs Job Library Active Jobs

Alert Probe UpDown 
(Database)

Buffer Cache

Data Dictionary Cache Disk I/O Library Cache Net I/O

SysStat Table SysStat Table Delta Datafile Limit Lock Limit

Process Limit Session Limit User Limit Archive Full

Chunk Small Dump Full Maximum Extents User Blocks

Continued (chained) 
Row

UpDown 
(listener/sqlnet)

UpDown (node) CPU Paging

CPU Utilization Disk Full Swap Full Archiver Hung

Broken Jobs Data Block Corruption Deferred 
Transactions

Error Transactions 

Failed Jobs Session Terminated Unscheduled Jobs Free Buffer

In Memory Sorts Index Rebuild Redo Log 
Allocation

Roll Back Contention

Alert File Large Fast Segment Growth Multiple Extents Snapshot Log Full 

Tablespace Full User Audit Data Gatherer 
Alert

Data Gatherer 
UpDown

Event Set Library Registrations Third Party Events

Fixit Jobs Associated with Triggered Events Frequency Pack Repositories
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Release 1.x Objects Which Need to be Re-created
The following objects need to be re-created:

Jobs

Others

Release 1.x Objects Which No Longer Exist
Release 1.x objects which no longer exist in Release 2.2 are listed below:

Jobs

Events

Others
Maps

Backup Tablespace from 
Oracle Enterprise 
Manager Jobs

Export

Import Load

SNMP Traps Paging Services Email Services

Administrator Lists manually added services manually discovered targets

Deinstall Products Delete Package

Distribute Package Install Package

Rdb Database Events Rdb Services Events

Event History Outstanding Events
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Setting Up DBA Studio

The DBA Management Pack features DBA Studio and SQL*Plus Worksheet. 

DBA Studio combines the functionality of multiple database tools and master view 
detail so that you can access database administration features and manage multiple 
databases from one tool. DBA Studio consists of:

■ Instance Management: Start or shut down a database, edit database 
initialization parameters, manage resource allocations and users’ sessions.

■ Schema Management: Create, edit, and examine schema objects.

■ Security Management: Administer users, privileges, and profiles.

■ Storage Management: Administer tablespaces, datafiles, rollback segments, and 
redo logs. You can also view controlfile and archive log information.

■ Replication Management: Enables an administrator to quickly set up, configure, 
and manage an Oracle replication environment.

■ JServer Management: Enables you to manage the namespace, browse CORBA 
and EJB components published in the namespace, change permissions on the 
published components, and execute the main() method in schema-resident Java 
classes and view the output.

■ Cache Management: Enables you to set up, manage, and monitor caches created 
by Oracle8i Cache. Oracle8i Cache increases the capacity of applications, such 
as Web applications, enterprise resource planning (ERP) applications, and 
vertical applications, by adding intelligent middle-tier caching. Use Oracle8i 
Cache to cache frequently used data on the middle-tier node, increasing the 
number of requests that your environment can process.

In previous releases of Enterprise Manager, there were individual database tools 
(Instance Manager, Schema Manager, Storage Manager, Security Manager, and 
Replication Manager). With the exception of Replication Manager and Cache 
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Manager, should you want to continue using separate independent tools rather than 
the well-integrated DBA Studio, you must install them through a custom install 
option.

DBA Studio can be used to perform your database administration tasks and 
supports versions of Oracle databases back to 7.3.4. 

Analyze, Backup Management, Data Management, Dimension Creation, Summary 
Advisor, Create Table, and Create View wizards are also available.

 

Note: To use any DBA Studio and DBA Management Pack applications 
other than SQL*Plus Worksheet as a non-DBA user, you must have been 
granted the SELECT_CATALOG_ROLE. The SELECT_CATALOG_ROLE 
is only available for Oracle8 and above databases. For information about 
creating the SELECT_CATALOG_ROLE, refer to "Giving Non-DBA 
Users Access to DBA Studio Against a 7.3.4 Database" on page 8-20.
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Figure 8–1 DBA Studio

 

This chapter discusses the topics listed below:

■ DBA Studio in Standalone or Oracle Management Server (OMS) Mode

■ Setting Up DBA Studio in Standalone Mode

■ Setting Up DBA Studio in OMS Mode

■ Other DBA Studio Procedures

Note: If any two objects are edited at the same time, the last edit 
committed will overwrite the previously committed changes without 
warning. 
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DBA Studio in Standalone or Oracle Management Server (OMS) Mode
When you start DBA Studio, you can connect either directly to the databases (in 
standalone mode) or through an Oracle Management Server (in OMS mode). 

Direct Connection to Databases
Run DBA Studio in standalone mode if you want to perform basic administrative 
tasks that do not require the job, event, or group system. If you connect in 
standalone mode, DBA Studio has access to the databases you have set up in a local 
record of databases.

Connection through the Oracle Management Server
Run DBA Studio in OMS mode if you want to:

■ use the Oracle Enterprise Manager framework

■ perform basic administrative tasks that require events, jobs, or groups (for 
example, using the backup and data management wizards)

■ access all databases previously discovered from the Console

■ run DBA Studio through a web browser

If you connect to an Oracle Management Server, DBA Studio has access to all 
databases on the discovered nodes. The Oracle Management Server must be 
running for DBA Studio to connect to it. 

Note: A Management Server and repository are not required if you 
only plan to run DBA Studio connected directly to the databases (in 
standalone mode).
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Setting Up DBA Studio in Standalone Mode
To run DBA Studio in standalone mode, you do not have to have an Oracle 
Enterprise Management Server or repository set up.

To set up DBA Studio in standalone mode, you must perform the following tasks:

■ start DBA Studio

■ select or add which databases you want to manage to the DBA Studio navigator 
tree

Starting DBA Studio in Standalone Mode
1. Start the DBA Studio.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> Database 
Administration->DBA Studio.

You can also start the DBA Studio from the command line using the 
command:

oemapp dbastudio

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

2. When the login dialog appears, choose Connect directly to databases and press 
OK. 

If you are starting DBA Studio for the first time, the left panel of DBA Studio is 
empty because you have not yet added the databases you want to manage. The 
Add Database To Tree dialog appears automatically so that you can add them to the 
navigator tree. 
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Adding Databases to the Tree in DBA Studio Standalone Mode
The Add Database To Tree dialog appears automatically when you start DBA 
Studio for the first time; it is also available from the File menu.

Figure 8–2 Add Database to Tree

The Add Database To Tree dialog allows you to manually enter the Net service 
names or add them from the local tnsnames.ora file.

Add a database manually
You can add databases to the DBA Studio navigator tree by manually filling in the 
following fields:

■ SID: the database system identifier, usually the instance name, such as ORCL

■ Hostname: the machine or node name where the database is located
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■ Port Number: the database listener port address, usually 1521 or 1526

■ Net Service Name: A name which uniquely identifies a database when 
connecting to a machine. It is usually the global database name. For example: 
ORCL.world. 

. 

Add selected databases from your local tnsnames.ora file 
You can populate the DBA Studio navigator tree by reading the database service 
names from the local tnsnames.ora file located in your Oracle Enterprise Manager 
home. The Add Database To Tree dialog displays a list of databases identified in 
you tnsnames.ora file from which you can select or deselect. Click the column 
header to the left of Service Name to either select or deselect all the databases. If 
you have deselected all the databases, you can choose specific databases by 
selecting their checkboxes.

Note: Adding a database manually automatically updates 
the local tnsnames.ora file located in your 
<Oracle_Enterprise_Manager_Home>/network/admin 
directory.

Note: Currently only TCP/IP service names can be added manually 
for DBA Studio. If the network protocols are required, add them by 
entering them in the tnsnames.ora file using the Net8 Configuration 
Assistant. All protocols are supported when you import selected 
services from your tnsnames.ora file.
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Connecting to a Database in DBA Studio Standalone Mode
There are four ways to connect to a database for DBA Studio:

■ Click the plus symbol next to the DBA Studio navigator tree container. The 
preferred credentials are used if the connection information have not been set 
previously.

■ Double-click the database icon in the DBA Studio navigator tree. The preferred 
credentials are used if the connection information have not been set previously.

■ Select the database and then select the Connect item from the File menu. 

■ Select the database and then select the Connect icon from the toolbar.

If no preferred credentials are set in the Oracle Enterprise Manager Console, the 
Database Connection Information dialog box appears. If preferred credentials are 
already set, you will connect to the database using this login information.

In the Database Connect Information dialog, enter the following information to 
connect to the database.

Username
Your Oracle username for the database to which you are connecting.

For example: system

Password
Your Oracle password for the database to which you are connecting.

For example: manager

Connect As
You can select from a pull-down list whether you want to connect to the database 
with NORMAL, SYSOPER, or SYSDBA privileges. Select NORMAL to connect to 
the database as an ordinary user. Select SYSOPER to connect to the database with 
special operator privileges, such as capabilities to shut down and start up the 
database. Select SYSDBA to connect to the database as a user with full database 
privileges such as the capability to grant any privileges to any user.

To use SYSOPER and SYSDBA privileges, a password file or OS group 
authentication must be created and set up for your database.
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Save As Local Preferred Credentials
Saving preferred credentials is an option which enables you to store login 
information in a local file, such as username, password, and role (NORMAL, 
SYSOPER, or SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established for the database 
instead of having to type a username and password each time.

You can set preferred credentials by selecting the Save As Local Preferred 
Credentials checkbox or you can use the Edit Local Preferred Credentials dialog 
available from the File menu.

The checkbox is not selected by default. 

Editing Local Preferred Credentials in DBA Studio Standalone Mode
Saving or editing preferred credentials is an option which enables you to store login 
information, such as username, password, and role (NORMAL, SYSOPER, or 
SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established to the database 
instead of having to type a username and password each time.

DBA Studio stores a list of databases that are displayed in the DBA Studio navigator 
tree. If preferred credentials are specified for any of these databases, the username, 
encrypted password, and role are added to a local file.

DBA Studio maintains a local record of login credentials separately from the Oracle 
Management Server. 

To save or edit the local preferred credentials of a service, you can perform the 
following steps:

Note: The passwords are encrypted in the local file so that they 
cannot be copied to another machine and used by a different user.

Note: If you cannot edit the local preferred credentials, check if you are 
in DBA Studio standalone mode.
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1. From the File menu, select the Edit Local Preferred Credentials item. The Edit 
Local Preferred Credentials dialog displays a list of services.

Figure 8–3 Edit Local Preferred Credentials

2. In the Edit Local Preferred Credentials dialog, select the service name of the 
database and enter or update the preferences for connection to that database.

■ Username: Enter the username. This field is required if a password has been 
entered.

■ Password: Enter the password. You can leave this blank if you want to be 
prompted for a password when you connect to the database.

■ Confirm: Confirm the password.

■ Role: Select the role from the pull-down list. You need to login with the 
SYSDBA or SYSOPER role to start up or shut down a database.
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3. Click the OK button at the bottom of the Edit Local Preferred Credentials dialog 
to save your updates. 

Setting Up DBA Studio in OMS Mode
To run DBA Studio in OMS mode, you must already have the following:

■ a repository and a Management Server set up 

■ Intelligent Agents started on the nodes where your distributed services reside

■ your databases started and discovered

Setting Up DBA Studio to Connect to a Management Server
To set up DBA Studio to connect to an Oracle Management Server, follow the 
instructions below:

1. Ensure that the Oracle Intelligent Agents are started on the nodes you want to 
manage. Refer to Chapter 5, "Starting and Stopping the Intelligent Agent" for 
information on starting your Intelligent Agents.

2. Ensure that the Oracle Management Server is started. Refer to Chapter 2, 
"Creating a Release 2.2 Repository" for detailed information on setting up a 
repository and Management Server and Chapter 3, "Controlling the 
Management Server" for detailed information about starting the Management 
Server.

3. Start the Console. Refer to Chapter 6, "Setting Up the Console" for information 
on starting the Console.

Use the Discovery Wizard to discover the nodes where the desired databases 
reside. Refer to Chapter 6, "Setting Up the Console" for information on 
discovering nodes. DBA Studio will then have access to these discovered 
databases.

Note: You can save or overwrite the preferred credentials by selecting 
the "Save As Local Preferred Credentials" checkbox in the Database 
Connection dialog.
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4. Exit the Oracle Enterprise Manager Console. 

Starting DBA Studio in OMS Mode
1. Start DBA Studio.

■ On Windows NT:

You can start DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> Database 
Administration->DBA Studio.

You can also start DBA Studio from the command line using the command:

oemapp dbastudio

■ On UNIX:

You can start DBA Studio from the command line using the command:

oemapp dbastudio

2. When the login dialog appears, choose Login to the Oracle Management Server.

Note: If you want to add databases to the navigator tree for DBA 
Studio connected to an Oracle Management Server, you must use the 
Discovery Wizard from the Oracle Enterprise Manager Console. The 
navigator tree is populated from the repository and cannot be modified 
using DBA Studio.
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Figure 8–4 Oracle Enterprise Manager Login

3. Enter the credentials for the Enterprise Manager user account: 

Administrator: sysman or the Enterprise Manager user that the super 
administrator has created for you

Password: oem_temp or the new password if you have changed it

Management Server: the name of the node where the Oracle Management 
Server is running

4. Press the OK button. DBA Studio appears. The navigator tree is populated with 
the databases discovered through the Oracle Enterprise Manager Console.
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Connecting to a Database in DBA Studio OMS Mode
There are four ways to connect to a database for DBA Studio:

■ Click the plus symbol next to the DBA Studio navigator tree container. The 
preferred credentials are used if the connection information have not been set 
previously.

■ Double-click the database icon in the DBA Studio navigator tree. The preferred 
credentials are used if the connection information have not been set previously.

■ Select the database and then select the Connect item from the File menu. 

■ Select the database and then select the Connect icon from the toolbar.

If no preferred credentials are set in the Oracle Enterprise Manager Console, the 
Database Connection Information dialog box appears. If preferred credentials are 
already set, you will connect to the database using this login information.

If the Database Connect Information dialog appears, enter the following 
information to connect to the database.

Username
Your Oracle username for the database to which you are connecting.

For example: system

Password
Your Oracle password for the database to which you are connecting.

For example: manager

Connect As
You can select from a pull-down list whether you want to connect to the database 
with NORMAL, SYSOPER, or SYSDBA privileges. Select NORMAL to connect to 
the database as an ordinary user. Select SYSOPER to connect to the database with 
special operator privileges, such as capabilities to shut down and start up the 
database. Select SYSDBA to connect to the database as a user with full database 
privileges such as the capability to grant any privileges to any user.

To use SYSOPER and SYSDBA privileges, a password file or OS group 
authentication must be created and set up for your database.
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Save As Preferred Credentials
Saving preferred credentials is an option which enables you to store login 
information in the repository, such as username, password, and role (NORMAL, 
SYSOPER, or SYSDBA). Passwords are always stored in encrypted format. 

This login information is used when a connection is established for the database 
instead of having to type a username and password each time.

The checkbox is not selected by default. 
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Other DBA Studio Procedures
This section discusses the topics listed below:

■ Accessing the Quick Tour in DBA Studio

■ Connecting to the Database As a Different User

■ Viewing Which Role You Are Connected As In DBA Studio

■ Removing a Database from Tree in DBA Studio Standalone Mode

■ Removing a Database from the Navigator in OMS Mode

■ Adding Databases to the Navigator Tree For DBA Studio OMS Mode

■ Changing from OMS Mode to Standalone Mode

■ Changing from Standalone Mode to OMS Mode

■ Connecting to JServer

■ Giving Non-DBA Users Access to DBA Studio Against a 7.3.4 Database

Accessing the Quick Tour in DBA Studio
To access the Quick Tour in DBA Studio, you must first highlight a database or any 
of the nodes and click the Quick Tour button in the right-hand window.

Connecting to the Database As a Different User
In DBA Studio you do not have to disconnect in order to reconnect as a different 
user.

If you are already connected to a database and you want to reconnect as a different 
user

■ Right-click the database icon and select Connect from the context-sensitive 
menu. 

■ Select the Connect item from the File menu. 

■ Click the Connect icon from the toolbar.

When the Database Connect Information dialog appears, enter a different username 
and press OK.

You will automatically be disconnected and reconnected.
8-16 Oracle Enterprise Manager Configuration Guide                             



Other DBA Studio Procedures
Viewing Which Role You Are Connected As In DBA Studio
When a connection is made to a database, a connection icon is displayed on top of 
the database icon in the DBA Studio tree. 

Next to the database name, you can see the username and role you are connected as 
if you have connected with the SYSDBA role. For example, sys AS SYSDBA.

Removing a Database from Tree in DBA Studio Standalone Mode
To remove a database from the DBA Studio navigator tree, follow the steps below:

1. Highlight the database you want to remove.

2. From the File menu, choose Remove Database from Tree item.

3. A message appears, saying, "Remove the <name> database from tree. Are you 
sure?" Click the Yes button. 

Note: Removing the database removes the entry from the DBA 
Studio Navigator tree. It does not remove the entry from the 
tnsnames.ora file or physically remove the database. If required, you 
have the option of adding the database to the navigator tree again.

Note: You can only remove databases from the navigator tree if you 
are connected to DBA Studio in standalone mode.
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Removing a Database from the Navigator in OMS Mode
To remove a database from the navigator tree for DBA Studio connected to an 
Oracle Management Server, you must remove the database from the Oracle 
Enterprise Manager Console.

1. Start the Oracle Enterprise Manager Console.

2. Highlight the node where the database you want to remove resides. 

3. Select the Remove Database item from the Navigator menu. 

4. Exit the Oracle Enterprise Manager Console. 

5. In DBA Studio, choose the Refresh item from the View menu. The node where 
the desired databases reside should disappear in the navigator tree.

Adding Databases to the Navigator Tree For DBA Studio OMS Mode
If you want to add databases to the navigator tree for DBA Studio connected to an 
Oracle Management Server, you must use the Discovery Wizard from the Oracle 
Enterprise Manager Console.

1. Start the Oracle Enterprise Manager Console.

2. Choose the Discover Nodes item from the Navigator menu to launch the 
Discovery Wizard. For more information about service discovery, refer to the 
Oracle Enterprise Manager Administrator’s Guide.

3. Specify the nodes where the desired databases reside and discover them. DBA 
Studio will have access to these databases.

4. Exit the Oracle Enterprise Manager Console. 

5. In DBA Studio, choose the Refresh item from the View menu. The nodes where 
the desired databases reside should appear in the navigator tree.

Note: Do not stop the Oracle Management Server or the Oracle 
Intelligent Agent.
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Changing from OMS Mode to Standalone Mode
When DBA Studio is connected to an Oracle Management Server, the DBA Studio 
navigator tree is populated with the discovered databases from the Enterprise 
Manager Console. 

The following steps describe how to copy these databases so they can be used in 
standalone mode.

The databases displayed in the navigator tree can be added to the tnsnames.ora file 
and their associated preferred credentials saved to a local file:

1. Use the Update tnsnames.ora File dialog from the File menu to select which 
services to copy to the local tnsnames.ora file.

2. If you want to save the preferred credentials to a local file, select the "Save 
Preferred Credentials Locally" checkbox in the Update tnsnames.ora File dialog. 

To make these databases available in standalone mode, you can perform the 
following steps:

1. Start DBA Studio connected directly to databases.

2. From the File menu, select the Add Database To Tree item.

3. In the Add Databases to Tree dialog, select the Net service names to add from 
the local tnsnames.ora file.

Note: The passwords are encrypted in the local file to prevent the file 
from being used on other machines.
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Changing from Standalone Mode to OMS Mode
If you have been using DBA Studio in standalone mode, the list of databases 
displayed in the navigator tree is retrieved from a local file. 

At some stage in the future, you may decide to administer jobs, events, and groups; 
run DBA Studio through a web browser; or perform backup and data management 
tasks. These tasks require you to run DBA Studio connected to an Oracle 
Management Server.

If you now decide to run DBA Studio connected to an Oracle Management Server, 
the databases displayed in the navigator tree may be different than those in 
standalone mode, because the list of databases is retrieved from the repository and 
not from a local file. 

To add the databases that were available from DBA Studio in standalone mode, you 
will need to discover the services from the Oracle Enterprise Manager Console if the 
databases are not already available from DBA Studio connected to the Oracle 
Management Server. For more information about service discovery, refer to the 
Oracle Enterprise Manager Administrator’s Guide. 

Connecting to JServer 
If your JServer is configured for a port other than 2481, the JServer container will 
not expand until you have changed the port number in the JServer URL 
Configuration dialog. 

To access the dialog, right click the container and select the "Connect JServer" menu 
item. Then select the connection button. When the JServer URL Configuration 
dialog appears, fill in the correct GIOP Port Number.

Giving Non-DBA Users Access to DBA Studio Against a 7.3.4 Database
To use any DBA Studio and DBA Management Pack applications other than 
SQL*Plus Worksheet as a non-DBA user, you must have been granted the 
SELECT_CATALOG_ROLE. The SELECT_CATALOG_ROLE is only available for 
Oracle8 and above databases. 

Note: To switch modes from DBA Studio in standalone mode to 
OMS mode, you need to close and restart DBA Studio.
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To create the SELECT_CATALOG_ROLE on Oracle databases prior to Oracle8, run 
the script documented below. 

To create the script easily, you can cut and paste the script text from the online help.

sc_role.sql
CREATE ROLE SELECT_CATALOG_ROLE NOT IDENTIFIED;
grant select on SYS.V_$CONTROLFILE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LOG to SELECT_CATALOG_ROLE;
grant select on SYS.V_$THREAD to SELECT_CATALOG_ROLE;
grant select on SYS.V_$PROCESS to SELECT_CATALOG_ROLE;
grant select on SYS.V_$BGPROCESS to SELECT_CATALOG_ROLE;
grant select on SYS.V_$SESSION to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LICENSE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$TRANSACTION to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LOCKED_OBJECT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCH to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCH_CHILDREN to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCH_PARENT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCHNAME to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCHHOLDER to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LATCH_MISSES to SELECT_CATALOG_ROLE;
grant select on SYS.V_$RESOURCE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$_LOCK to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LOCK to SELECT_CATALOG_ROLE;
grant select on SYS.V_$SESSTAT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$MYSTAT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$SYSSTAT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$STATNAME to SELECT_CATALOG_ROLE;
grant select on SYS.V_$ACCESS to SELECT_CATALOG_ROLE;
grant select on SYS.V_$OBJECT_DEPENDENCY to SELECT_CATALOG_ROLE;
grant select on SYS.V_$DBFILE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$FILESTAT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LOGFILE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$ROLLNAME to SELECT_CATALOG_ROLE;
grant select on SYS.V_$ROLLSTAT to SELECT_CATALOG_ROLE;
grant select on SYS.V_$SGA to SELECT_CATALOG_ROLE;
grant select on SYS.V_$PARAMETER to SELECT_CATALOG_ROLE;
grant select on SYS.V_$SYSTEM_PARAMETER to SELECT_CATALOG_ROLE;

Note: This script will have to be run as SYS in order to grant privileges 
to the SELECT_CATALOG_ROLE.
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grant select on SYS.V_$ROWCACHE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$ENABLEDPRIVS to SELECT_CATALOG_ROLE;
grant select on SYS.V_$LIBRARYCACHE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$TYPE_SIZE to SELECT_CATALOG_ROLE;
grant select on SYS.V_$ARCHIVE to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$CIRCUIT to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$DATABASE to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$INSTANCE to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$DISPATCHER to SELECT_CATALOG_ROLE;                       
grant select on SYS.V_$LOGHIST to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$SQLAREA to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$SQLTEXT to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$SQLTEXT_WITH_NEWLINES to SELECT_CATALOG_ROLE;            
grant select on SYS.V_$SQL to SELECT_CATALOG_ROLE;                              
grant select on SYS.V_$DB_PIPES to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$DB_OBJECT_CACHE to SELECT_CATALOG_ROLE;                  
grant select on SYS.V_$OPEN_CURSOR to SELECT_CATALOG_ROLE;                      
grant select on SYS.V_$PQ_SYSSTAT to SELECT_CATALOG_ROLE;                       
grant select on SYS.V_$PQ_SLAVE to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$QUEUE to SELECT_CATALOG_ROLE;                            
grant select on SYS.V_$MTS to SELECT_CATALOG_ROLE;                              
grant select on SYS.V_$DBLINK to SELECT_CATALOG_ROLE;                           
grant select on SYS.V_$PWFILE_USERS to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$REQDIST to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$SGASTAT to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$WAITSTAT to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$SHARED_SERVER to SELECT_CATALOG_ROLE;                    
grant select on SYS.V_$TIMER to SELECT_CATALOG_ROLE;                            
grant select on SYS.V_$RECOVER_FILE to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$LOG_HISTORY to SELECT_CATALOG_ROLE;                      
grant select on SYS.V_$RECOVERY_LOG to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$DATAFILE to SELECT_CATALOG_ROLE;                         
grant select on SYS.V_$FIXED_TABLE to SELECT_CATALOG_ROLE;                      
grant select on SYS.V_$FIXED_VIEW_DEFINITION to SELECT_CATALOG_ROLE;            
grant select on SYS.V_$INDEXED_FIXED_COLUMN to SELECT_CATALOG_ROLE;             
grant select on SYS.V_$SESSION_CURSOR_CACHE to SELECT_CATALOG_ROLE;             
grant select on SYS.V_$SESSION_WAIT to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$SESSION_EVENT to SELECT_CATALOG_ROLE;                    
grant select on SYS.V_$SESSION_CONNECT_INFO to SELECT_CATALOG_ROLE;             
grant select on SYS.V_$SYSTEM_EVENT to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$EVENT_NAME to SELECT_CATALOG_ROLE;                       
grant select on SYS.V_$EXECUTION to SELECT_CATALOG_ROLE;                        
grant select on SYS.V_$SYSTEM_CURSOR_CACHE to SELECT_CATALOG_ROLE;              
grant select on SYS.V_$SESS_IO to SELECT_CATALOG_ROLE;                          
grant select on SYS.V_$COMPATIBILITY to SELECT_CATALOG_ROLE;                    
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grant select on SYS.V_$COMPATSEG to SELECT_CATALOG_ROLE;
grant select on SYS.V_$RECOVERY_STATUS to SELECT_CATALOG_ROLE;                  
grant select on SYS.V_$RECOVERY_FILE_STATUS to SELECT_CATALOG_ROLE;             
grant select on SYS.V_$SHARED_POOL_RESERVED to SELECT_CATALOG_ROLE;             
grant select on SYS.V_$SORT_SEGMENT to SELECT_CATALOG_ROLE;                     
grant select on SYS.V_$SQL_CURSOR to SELECT_CATALOG_ROLE;                       
grant select on SYS.V_$SQL_BIND_METADATA to SELECT_CATALOG_ROLE;                
grant select on SYS.V_$SQL_BIND_DATA to SELECT_CATALOG_ROLE;                    
grant select on SYS.V_$SQL_SHARED_MEMORY to SELECT_CATALOG_ROLE;                
grant select on SYS.DBA_ROLES to SELECT_CATALOG_ROLE;                           
grant select on SYS.DBA_PROFILES to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_CATALOG to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_CLUSTERS to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_CLU_COLUMNS to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_COL_COMMENTS to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_COL_PRIVS to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_DB_LINKS to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_EXP_OBJECTS to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_EXP_VERSION to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_EXP_FILES to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_INDEXES to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_IND_COLUMNS to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_OBJECTS to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_ROLLBACK_SEGS to SELECT_CATALOG_ROLE;                   
grant select on SYS.DBA_ROLE_PRIVS to SELECT_CATALOG_ROLE;                      
grant select on SYS.DBA_SYS_PRIVS to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_SEQUENCES to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_SYNONYMS to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_TABLES to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_TAB_COLUMNS to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_TAB_COMMENTS to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_TAB_PRIVS to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_TS_QUOTAS to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_USERS to SELECT_CATALOG_ROLE;                           
grant select on SYS.DBA_VIEWS to SELECT_CATALOG_ROLE;                           
grant select on SYS.DBA_CONSTRAINTS to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_CLUSTER_HASH_EXPRESSIONS to SELECT_CATALOG_ROLE;        
grant select on SYS.DBA_CONS_COLUMNS to SELECT_CATALOG_ROLE;                    
grant select on SYS.SYSCATALOG_ to SELECT_CATALOG_ROLE;                         
grant select on SYS.PSS1$ to SELECT_CATALOG_ROLE;                               
grant select on SYS.PS1$ to SELECT_CATALOG_ROLE;                                
grant select on SYS.DBA_2PC_PENDING to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_2PC_NEIGHBORS to SELECT_CATALOG_ROLE;                   
grant select on SYS.DBA_UPDATABLE_COLUMNS to SELECT_CATALOG_ROLE;               
grant select on SYS.DBA_OBJ_AUDIT_OPTS to SELECT_CATALOG_ROLE;                  
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grant select on SYS.DBA_STMT_AUDIT_OPTS to SELECT_CATALOG_ROLE;                 
grant select on SYS.DBA_PRIV_AUDIT_OPTS to SELECT_CATALOG_ROLE;                 
grant select on SYS.DBA_AUDIT_TRAIL to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_AUDIT_SESSION to SELECT_CATALOG_ROLE;                   
grant select on SYS.DBA_AUDIT_STATEMENT to SELECT_CATALOG_ROLE;                 
grant select on SYS.DBA_AUDIT_OBJECT to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_AUDIT_EXISTS to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_ERRORS to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_SOURCE to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_TRIGGERS to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_TRIGGER_COLS to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_DEPENDENCIES to SELECT_CATALOG_ROLE;                    
grant select on SYS.CODE_PIECES to SELECT_CATALOG_ROLE;                         
grant select on SYS.CODE_SIZE to SELECT_CATALOG_ROLE;                           
grant select on SYS.PARSED_PIECES to SELECT_CATALOG_ROLE;                       
grant select on SYS.PARSED_SIZE to SELECT_CATALOG_ROLE;                         
grant select on SYS.SOURCE_SIZE to SELECT_CATALOG_ROLE;                         
grant select on SYS.ERROR_SIZE to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_OBJECT_SIZE to SELECT_CATALOG_ROLE;                     
grant select on SYS.DBA_JOBS_RUNNING to SELECT_CATALOG_ROLE;                    
grant select on SYS.DBA_JOBS to SELECT_CATALOG_ROLE;                            
grant select on SYS.ORA_KGLR7_OBJECTS to SELECT_CATALOG_ROLE;                   
grant select on SYS.SYS_OBJECTS to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_SEGMENTS to SELECT_CATALOG_ROLE;                        
grant select on SYS.DBA_EXTENTS to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_FREE_SPACE to SELECT_CATALOG_ROLE;                      
grant select on SYS.DBA_FREE_SPACE_COALESCED_TMP1 to SELECT_CATALOG_ROLE;       
grant select on SYS.DBA_FREE_SPACE_COALESCED_TMP2 to SELECT_CATALOG_ROLE;       
grant select on SYS.DBA_FREE_SPACE_COALESCED to SELECT_CATALOG_ROLE;            
grant select on SYS.DBA_DATA_FILES to SELECT_CATALOG_ROLE;                      
grant select on SYS.FILEXT$ to SELECT_CATALOG_ROLE;                             
grant select on SYS.DBA_TABLESPACES to SELECT_CATALOG_ROLE;                     
grant select on SYS.SM$TS_AVAIL to SELECT_CATALOG_ROLE;                         
grant select on SYS.SM$TS_USED to SELECT_CATALOG_ROLE;                          
grant select on SYS.SM$TS_FREE to SELECT_CATALOG_ROLE;                          
grant select on SYS.SM$AUDIT_CONFIG to SELECT_CATALOG_ROLE;                     
grant select on SYS.SM$INTEGRITY_CONS to SELECT_CATALOG_ROLE;                   
grant select on SYS.DEFSCHEDULE to SELECT_CATALOG_ROLE;                         
grant select on SYS.DEFERROR to SELECT_CATALOG_ROLE;                            
grant select on SYS.DEFERRCOUNT to SELECT_CATALOG_ROLE;                         
grant select on SYS.DEFTRAN to SELECT_CATALOG_ROLE;                             
grant select on SYS.DEFTRANDEST to SELECT_CATALOG_ROLE;                         
grant select on SYS.DEFDEFAULTDEST to SELECT_CATALOG_ROLE;                      
grant select on SYS.DBA_SNAPSHOTS to SELECT_CATALOG_ROLE;                       
grant select on SYS.DBA_SNAPSHOT_LOGS to SELECT_CATALOG_ROLE;                   
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grant select on SYS.DBA_RCHILD to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_RGROUP to SELECT_CATALOG_ROLE;                          
grant select on SYS.DBA_REFRESH to SELECT_CATALOG_ROLE;                         
grant select on SYS.DBA_REFRESH_CHILDREN to SELECT_CATALOG_ROLE;
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Directory Structure

This appendix describes the directory structure that is created when Oracle 
Enterprise Manager Release 2.2 is installed.
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Directory Structure of Oracle Enterprise Manager Release 2.2
The following directories are created when Oracle Enterprise Manager Release 2.2 is 
installed.

Directory Structure for $ORACLE_HOME\sysman
The directory structure for $ORACLE_HOME\sysman is listed below: 

■ $ORACLE_HOME\sysman\admin 

■ $ORACLE_HOME\sysman\config 

■ $ORACLE_HOME\sysman\dbapp

■ $ORACLE_HOME\sysman\doc\readme

■ $ORACLE_HOME\sysman\log 

■ $ORACLE_HOME\sysman\mesg

■ $ORACLE_HOME\sysman\temp 

■ $ORACLE_HOME\sysman\ifiles 

■ $ORACLE_HOME\sysman\report

■

$ORACLE_HOME\sysman\admin
The $ORACLE_HOME\sysman\admin directory contains SQL scripts and registry 
files that are used by the Enterprise Manager Configuration Assistant. The contents 
must not be altered. 

$ORACLE_HOME\sysman\config
The $ORACLE_HOME\sysman\config directory contains several configuration 
files. Only the following files should be altered by the user:

■ clientconfig.properties

■ dbappscfg.properties

■ omsconfig.properties

■ paging.cfg.template

Any other files in this directory must not be altered. 

Tracing information for the Oracle Enterprise Manager Release 2.2 components is 
stored in the omsconfig.properties and clientconfig.properties files. 
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The dbappscfg.properties file contains settings for SQL*Plus worksheet. 

The dbappscfg.properties is used to specify additional environment variables 
for SQL*Plus. 

By default, the following is set: 

SQLPLUS_ENDOFBUFTOKEN=OEM_sqlplus_input_finished 

The paging.cfg.template file enables tracing for the Oracle Enterprise 
Manager Paging Server 2.2.

$ORACLE_HOME\sysman\ifiles 
When you save init.ora parameters to a file while using Instance Management tool, 
the files are saved to the $ORACLE_HOME\sysman\ifiles directory by default.

$ORACLE_HOME\sysman\log 
The $ORACLE_HOME\sysman\log directory contains the output of traces that are 
redirected to disk. This directory contains the oms.log and oms.nohup files. The 
oms.nohup file contains Management Server error messages which appear before 
the Management Server starts up. The oms.log file contains messages generated 
when the Management Server is starting and running.

$ORACLE_HOME\sysman\mesg
The $ORACLE_HOME\sysman\mesg directory contains message files.

$ORACLE_HOME\sysman\doc\readme
The $ORACLE_HOME\sysman\doc\readme directory contains readmes.

$ORACLE_HOME\sysman\report
The ORACLE_HOME\sysman\report directory contains reports generated on the 
fly.

$ORACLE_HOME\sysman\temp 
The $ORACLE_HOME\sysman\temp directory contains temporary files that may be 
created in the course of processing management operations.
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Other Important Directories
Other important directories include:

$ORACLE_HOME\RelNotes\EM
All readmes that ship with Enterprise Manager are installed in this directory. 

$ORACLE_HOME\Doc\EM
Documentation in html and PDF formats that ship with Enterprise Manager are 
installed in this directory. For Unix and Windows platforms, the documentation is 
on a separate CD and is not installed when you install Enterprise Manager software.
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Configuration Assistant Operations

The Enterprise Manager Configuration Assistant is used to create, remove, and 
upgrade repositories, and to maintain the configuration parameters for the local 
Management Server. 

Repository creation is described in "Creating a Release 2.2 Repository" on page 2-1.

 This appendix discusses: 

■ how to upgrade a Release 2.0 or 2.1 repository to a Release 2.2 repository

■ how to drop a repository

■ how to redirect the local Management Server to use a different repository or to 
respond to changes in the repository user’s password

It also includes information about repository creation and parameters configuration 
when the omsconfig.properties file is inaccessible.

If you are using a previous Enterprise Manager Release 1.x release and want to 
migrate your 1.x repository or repositories directly to a Release 2.2 repository, you 
will need to perform additional steps using the Enterprise Manager Migration 
Assistant after creating your Release 2.2 repository. Refer to Chapter 7, "Migrating a 
Release 1.x Repository to a Release 2.2 Repository" for information about migrating 
one or more Release 1.x repositories into the shared Release 2.2 repository schema.

Upgrade a Release 2.0 or 2.1 Repository to a Release 2.2 Repository
If you plan to upgrade your repository from Release 2.0 or 2.1 to Release 2.2, you 
must first upgrade all your Oracle Enterprise Manager products other than the 
Intelligent Agent to Release 2.2 before upgrading your repository. 
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The Oracle Enterprise Manager Configuration Assistant takes an existing repository 
and upgrades it directly. After the upgrade, the repository is at the newer version.

Because an Enterprise Manager repository is shared, it is important to coordinate 
your repository upgrade with the installation of the new Oracle Enterprise Manager 
software on all the machines that share the repository. If you do not upgrade your 
repository, the new version of the software will not operate with that older 
repository. 

However, if you do upgrade your repository, the older version of the software will 
not operate with that newer repository. 

Remember that both the base Oracle Enterprise Manager system, which includes 
the Management Server, and the Oracle Enterprise Manager packs share a 
repository, so if you want all your users to continue to perform their work, you 
must ensure that the repository upgrade is coordinated with the software upgrades 
on all relevant machines.

 In order to upgrade a repository, you must connect to the database as a user with 
DBA privileges. 

Note: For guidelines to upgrading your Oracle Enterprise Manager 
framework and Management Packs from previous 2.x releases to Release 
2.2, refer to "Upgrading Your Oracle Enterprise Manager Framework and 
Management Packs" on page 1-19. 

Note: The repository must remain in the same schema during upgrade. 
For example, it cannot be exported, and then imported into a different 
schema and upgraded; the credentials will be unusable in this case.
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To upgrade the repository, follow the steps outlined in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-6.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Upgrade an existing repository" from the list of configuration operations and 
press Next to continue. The "Select Database for Repository" page appears.

Step 2 "Select Database for Repository"
Log in to the database which contains the repository you want to upgrade. You 
must connect to the database as a user with DBA privileges.

Note: Before you attempt to upgrade the repository, you must first back 
up the database or repository schema. If there is a failure during a 
repository upgrade, the repository will no longer be usable. The failed 
repository no longer appears in the list of available repositories that can 
be upgraded.

Note: Before you attempt to perform an upgrade, you must first stop all 
Management Servers and Oracle Enterprise Manager applications that 
are using this repository. If any Management Server is currently using 
this repository, upgrading the repository causes a server error.

Note: The repository schema user created by the Enterprise Manager 
Configuration Assistant will not have the necessary DBA privileges for 
this step. To avoid potential security issues, do not grant more privileges 
to your repository schema user than is necessary. Connect to the 
database as a different user with DBA privileges instead. For example, 
system/manager.
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For information about logging in to the database which contains the repository, 
refer to Step 2 "Select Database for Repository" on page 2-8.

If you log in successfully, the "Select Repository" page appears.

Step 3 "Select Repository"
If the Enterprise Manager Configuration Assistant detects any previous versions of 
2.x repositories in the specified database, it displays them.  Select the appropriate 
repository and press the Next button to continue."   

If the specified database does not contain any Release 2.x repositories, the list of 
repositories is empty and grayed out, and a note stating that "No repositories were 
found in the database" appears. You may click the Cancel button to exit the 
Enterprise Manager Configuration Assistant or click the Back button to return to 
previous pages to change the information.

Step 4 "Repository Login Information"
In the "Repository Login Information" page, you must supply the repository user 
password. 

During repository creation, a database user (repository schema user) who owns the 
repository was created by the Enterprise Manager Configuration Assistant with the 
username and password you have supplied. 

In order to perform a repository upgrade, it is necessary to logon to the repository 
database as this user. 

The repository user name has been entered into the username field as a result of 
your choice in the previous page. However, you will need to enter the password.

Press Next to continue. The "Upgrade Repository Summary" page appears. 

Note: The Enterprise Manager Configuration Assistant does not 
display Release 2.2 repositories in this situation, because they do not 
need to be upgraded; they are already at the most up-to-date version.
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Step 5 "Upgrade Repository Summary"
The "Upgrade Repository Summary" page provides a summary of all the 
information supplied during the upgrade repository wizard. Click Finish to initiate 
repository upgrade or click Back to return to previous pages to change the 
information.

Step 6 "Configuration Assistant Progress"
When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. Each processing step is shown by a line of text. 

If you want to view detailed information, click the "Show Details" button to expand 
the dialog to show a text area. You can hide the text area by pressing the "Hide 
Details" button. 

The Cancel button changes to a Close button when processing is completed whether 
it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. However, if you cancel the operation, the repository will become unusable.    

Click the Close button when you are finished. 

During the Configuration Assistant upgrade operation, the Oracle Management 
Service will be created, if it does not already exist. 

Note: Before you attempt to upgrade the repository, you must first back 
up the database or repository schema. If there is a failure during a 
repository upgrade, the repository will no longer be usable. The failed 
repository no longer appears in the list of available repositories that can 
be upgraded.
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Drop an Existing Repository
In order to drop a repository, you must connect to the database as a user with DBA 
privileges. 

To drop the repository, follow the steps outlined in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-6.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Drop an existing repository" from the list of configuration operations and 
press Next to continue. The "Select Database for Repository" page appears.

If the Configuration Assistant cannot write to the omsconfig.properties file, 
the "Configuration File Not Accessible" page appears. 

Step 2 "Select Database for Repository"
Log in to the database which contains the repository you want to drop. You must 
connect to the database as a user with DBA privileges.

Note: Before you attempt to drop the repository, you must first stop all 
Management Servers and Oracle Enterprise Manager applications that 
are using this repository. If any Management Server is currently using 
this repository, deleting the repository causes a server error.

Note: The repository schema user created by the Enterprise Manager 
Configuration Assistant will not have the necessary DBA privileges for 
this step. To avoid potential security issues, do not grant more privileges 
to your repository schema user than is necessary. Connect to the 
database as a different user with DBA privileges instead. For example, 
system/manager.
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For information about logging in to the database which contains the repository, 
refer to Step 2 "Select Database for Repository" on page 2-8. If you log in 
successfully, the "Select Repository" page appears.

Step 3 "Select Repository"
If the Enterprise Manager Configuration Assistant detects that Release 2.2 
repositories exist in the specified database, they are displayed. Choose the 
appropriate repository and press the Next button to continue. 

If the specified database does not contain any Release 2.2 repositories, the list of 
repositories is empty and grayed out, and a note stating that "No repositories were 
found in the database" appears. You may click the Cancel button to exit the 
Enterprise Manager Configuration Assistant or click the Back button to return to 
previous pages to change the information.

Step 4 "Select Drop Repository Options"
From the "Select Drop Repository Options" page, you can choose to drop the 
repository user and all its schema objects or merely the repository objects.

If you choose to drop only the repository, you must supply the repository user’s 
password so that the Enterprise Manager Configuration Assistant can connect to 
the repository in order to invoke the Oracle Enterprise Manager Release 2.2 SQL 
drop scripts. Only repository objects are dropped. Other schema objects in the 
repository remain. 

If you choose to drop the repository user and all its schema objects, a password is 
not required. 

If the Configuration Assistant detects that a managed repository is specified in the 
omsconfig.properties file, and you are not dropping that repository, the 
Configuration Assistant will not change the Management Server configuration.

If you are dropping the managed repository, the Configuration Assistant will clear 
the Management Server configuration. 

Note: Make sure that you do not have other objects of value in that 
schema before proceeding with this step. Valuable data may be lost if you 
do not ensure this.
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Press Next to continue. The "Drop Repository Summary" page appears. 

Step 5 "Drop Repository Summary"
The "Drop Repository Summary" page provides a summary of all the information 
supplied during the drop repository wizard. Click Finish to initiate repository 
removal or click Back to return to previous pages to change the information.

Step 6 "Configuration Assistant Progress"
When you click the Finish button, the Configuration Assistant Progress window 
appears, showing the processing performed and the processing steps that comprise 
the operation being performed. Each processing step is shown by a line of text. 

If you want to view detailed information, click the "Show Details" button to expand 
the dialog to show a text area. You can hide the text area by pressing the "Hide 
Details" button. 

The Cancel button changes to a Close button when processing is completed whether 
it is successful or not.

When all of the steps have been completed without error, the "Processing 
completed." message appears.

You can cancel the requested operation before it completes by clicking the Cancel 
button. 

Click the Close button when you are finished.
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Edit Configuration Parameters
Use the Edit Configuration Parameters selection if you want to perform the 
following tasks:

■ set up a Management Server to manage an already existing repository.

■ change the Management Server configuration to use another repository in the 
same or another database.

■ change the password that the Management Server uses to log into the 
repository when it starts. You must change the password if someone has 
changed the repository user password; otherwise, the Management Server will 
fail to start. The Enterprise Manager Configuration Assistant, when editing the 
configuration parameters, only change the omsconfig.properties file; it 
does not change the repository credentials in the database. 

The Configuration Assistant can only set or change configuration parameters 
(omsconfig.properties file) for the machine on which it is running. It does not 
have the ability to change another machine’s configuration parameters; you must 
go to each of the other Management Servers using (sharing) the repository and run 
the Configuration Assistant using the Edit Configuration Parameters option to 
change each machine’s configuration parameters.

You must set up or change the repository connect information (user name, 
password, service) to point to the correct repository. It is important that all the 
Management Server machines that are using (sharing) the same repository have 
consistent configuration parameters.

Note: If you change the password for the database user account which 
owns the repository, you must also change the corresponding 
Management Server configuration parameter for every Management 
Server that uses the repository; otherwise, the next Management Server 
start will fail.
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To edit the Management Server configuration parameters, follow the steps outlined 
in the following sections.

For information about starting the Enterprise Manager Configuration Assistant, 
refer to "Starting the Enterprise Manager Configuration Assistant" on page 2-6.

Step 1 "Configuration Operation"
When you start the Enterprise Manager Configuration Assistant, the "Configuration 
Operation" page appears. 

Select "Edit Configuration Parameters" from the list of configuration operations and 
press Next to Continue. The "Configuration Parameters" page appears.

Step 2 "Configuration Parameters"
Set up or change the parameter you want. This information will be used when this 
machine’s Management Server next initializes. If any of the information is invalid, 
then the Management Server will not start successfully.

User Name 
Enter the repository’s user name to change the Management Server configuration to 
use another repository. The user name is a database username, not an Oracle 
Enterprise Manager administrator name.

Password 
Enter the repository user’s password to change the password that the Management 
Server uses to log into the repository when it starts. 

If you change the password, you must also change the Confirm field so that it 
matches the password you changed.

Service
Enter the service/database where the repository resides to change the Management 
Server to use a repository in another database.

Note: You can change the Management Server configuration 
parameters even when the database is not accessible.
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Note: In order to progress to the next page, you must change at least 
one of the parameters in this page. If the Next button is pressed without 
changing anything, an error message appears: "There were no changes to 
the configuration parameters. Make changes or cancel." In this case, the 
Enterprise Manager Configuration Assistant does not allow navigation 
to the next page.
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Step 3 "Modify Configuration Parameters"
The "Modify Configuration Parameters" page provides a summary of all the 
information supplied during the modify Management Server parameters wizard 
operation. Click Finish to initiate the change or click Back to return to previous 
pages to change your information.

Configuration File Not Accessible
The "Configuration File Not Accessible" page appears when you have chosen to 
create or drop a repository and the omsconfig.properties file was not 
accessible. The omsconfig.properties file may not be accessible because write 
permissions are not available on the file. 

You can continue to perform the repository operation without modifying the 
omsconfig.properties file or you may choose not to continue with the 
operation. 

If you select "Perform the repository operation anyway," the Next button is enabled 
and you are allowed to continue with the normal sequence of creating or dropping 
a repository. However, in this case, the omsconfig.properties file will not be 
modified.

If you are performing a repository creation, the Configuration Assistant creates the 
repository, but not the omsconfig.properties file. You must have write access 
to the file so that the Configuration Assistant can write the configuration properties 
to it. Before the Management Server can start up, the proper parameters must be in 
the file.

Note: When you use the Edit Configuration Parameters to change 
parameters, the Configuration Assistant changes the Management Server 
configuration parameters, which are stored in the configuration file: 
ORACLE_HOME\sysman\config\omsconfig.properties. These 
parameters provide the necessary input to the Management Server, so 
that it may connect to the repository user within the proper database.  
The Configuration Assistant does not change the repository username or 
password in the repository itself once the repository has been created. 
The Configuration Assistant only manipulates the repository user’s 
password at repository creation time when it creates the repository user.
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The summary page will indicate that the configuration file will not be updated, and 
"Set Configuration Parameters" will not appear as a processing step in the 
Configuration Assistant Progress window." 

Later, when you have gained write access to the omsconfig.properties file, you can 
use the "Edit Configuration Parameters" option to enter the database username, 
password and service information for the repository that the Management Server 
will use. Once the configuration file has been updated, you will be able to start the 
Management Server.

If you select "Do not perform the repository operation," the "Configuration File Not 
Accessible" page becomes the last page. The Next button is disabled. No changes 
are performed. In this case, you can either go back to the previous page, or cancel.
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Upgrading the Intelligent Agent and Data

Gatherer

Upgrading the Intelligent Agent
Each release of the Intelligent Agent improves Agent performance, functionality, 
and reliability. We therefore recommend upgrading your Intelligent Agent to the 
latest version available for your platform.  As an integral part of your Enterprise 
Manager environment, certain steps must be followed to make sure the transition to 
a newer Agent does not affect your Enterprise Manager jobs and/or events.

Agent Upgrade Guidelines for Enterprise Manager Version 2
1. Install the latest Intelligent Agent under a new Oracle Home.

2. Make sure that any jobs or events you wish to keep have been saved in the job 
or event library respectively. To add a job/event to a job/event library, select the 
job/event from the job/event pane, click on the desired entry using the right 
mouse button and select Copy to Library from the context-sensitive menu.

3. Move any event alerts to event history.  You can save the contents of the history 
pane or clear them.

Note: If you have events registered against multiple targets, use 
the Create Like menu option to create individual events for each 
target and save these events to the Event Library.
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4. From the Enterprise Manager Console, de-register any existing events and 
remove any active jobs scheduled against the node on which you ar upgrading 
the agent.

5. Shut down the old Agent.

6. Start the new Agent

7. From the OEM Console, refresh the node in the Navigator.

8. Resubmit the saved jobs and events to the new Agent.

Migrating Enterprise Manager Jobs/Events from an 8.1.5 or 8.1.6 Agent to an 8.1.7 
Agent

If you have existing jobs/events submitted against an 8.1.5/8.1.6 Intelligent Agent, 
and want to upgrade to an 8.1.7 Agent without having to re-submit jobs or 
re-register events, you must migrate all existing jobs/events using the following 
procedure. 

1. Install the 8.1.7 Agent in a separate ORACLE_HOME.

2. Type lsnrctl dbsnmp_stop at the command line to stop the older 8.1.x 
Agent.

3. Copy all files ( *.q files, *.inp files, tcl* files) from the older Agent’s  
ORACLE_HOME/network/agent directory to the 8.1.7 Agent's 
ORACLE_HOME/network/agent directory. Do not copy the directories. These 
files should now be owned by the user who installed the 8.1.7 Agent. Check the 
ownership of these files in the newer Agent's directory.

4. Type lsnrctl dbsnmp_start to start the 8.1.7 Agent.

5. Make sure that the services (databases, listeners etc.)  discovered by the new 
Agent are identical to those discovered by the older Agent. 

A quick comparative check between service names and definitions in the older 
Agent's ORACLE_HOME/network/agent/services.ora file and that of the 
newer Agent, is highly recommended.

6. From the Enterprise Manager Console, refresh the Agent's node.

After migration, all previous jobs/events should continue to run as before.
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Upgrading From a Previous Version of the Data Gatherer
It is possible to install the new version of the Oracle Data Gatherer into a different 
Oracle Home than the previous version. If you plan to do this, follow these steps:

1. Stop the previous version of the Oracle Data Gatherer. See "Controlling 
Operations of the NT and UNIX Data Gathering Service" in the Oracle Intelligent 
Agent’s User’s Guide for more information on stopping the Oracle Data Gatherer.

2. Install the new version of the Oracle Data Gatherer, but do not start it.

3. Move the Capacity Planning configuration files (state files) and data files 
associated with the previous version of Oracle Data Gatherer to the Oracle 
Home where you have installed the new version of Oracle Data Gatherer.

The Oracle Data Gatherer state and data files are located in the 
$ORACLE_HOME/odg/reco directory. You need to copy the files into the new 
$ORACLE_HOME/odg/reco directory before you use Oracle Capacity Planner 
to connect to the new version of the Oracle Data Gatherer and set up any new 
collections.

If you do not move these files, the following problems will occur:

a. Binary data is not loaded.

Any binary data files created by Oracle Data Gatherer which have not yet 
been loaded into the Capacity Planner database will not be loaded.

b. Data collection definitions are not maintained.

You will need to redefine your Capacity Planner data collections.

If you have installed the new version of Oracle Data Gatherer into the same 
Oracle Home as the previous version or if you do not currently use the Oracle 
Capacity Planner, do not move the state and data files.

4. Start the new version of the Oracle Data Gatherer. See "Controlling Operations 
of the NT and UNIX Data Gathering Service" in the Oracle Intelligent Agent’s 
User’s Guide for more information about starting the Oracle Data Gatherer.
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                                                            Troublesho
D

Troubleshooting

Please check the compatibility matrix in the Oracle Enterprise Manager Readme 
before installing or using Oracle Enterprise Manager. emreadme.txt or 
emreadme.html is located in the ORACLE_HOME\RelNotes\EM directory. For 
example, C:\Oracle\Ora81\RelNotes\EM.

This chapter describes possible troubleshooting issues. 

■ Reporting Problems to Oracle Support

■ Setting Up Logging and Tracing

■ Troubleshooting the Management Server

■ Troubleshooting the Paging Service

■ Troubleshooting the Web Browser

■ Resetting the Password

■ Troubleshooting the Enterprise Manager Configuration Assistant

■ Changing the Permissions on the omsconfig.properties File

■ Determining the SGA Size

■ Troubleshooting Job Notifications
oting D-1
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Reporting Problems to Oracle Support
When you use Oracle Enterprise Manager and encounter problems, you can turn to 
many sources for help.

Before you contact Oracle Technical Support, please take the time to consult your 
manuals and the Oracle Enterprise Manager Readme. A list of Oracle Enterprise 
Manager manuals are listed in the Preface under Documentation Set on page xv.

Manuals
Manuals of particular interest are listed below:

■ The Oracle Enterprise Manager Readme Release 2.2 provides important notes on 
updates to the software and other late-breaking news, as well as any differences 
between the product’s behavior and how it is documented.

■ The Oracle Intelligent Agent Users Guide describes how to administer the Oracle 
Intelligent Agent and provides troubleshooting information.

■ The Oracle Enterprise Manager Messages Manual Release 2.2 contains probable 
causes and recommended actions for Oracle Enterprise Manager errors.

MetaLink
In addition to the manuals and online help, Oracle offers OracleMetaLink, an 
electronic support service available to Oraclemetals (Gold, Silver, Bronze) 
customers, 24 hours a day, seven days a week. Customers can register on-line 
through http://www.oracle.com/support. 

MetaLink 2.0 includes the following features: 

■ My Headlines

Uses push technology to provide you with proactive notifications. My Headlines 
gives you the ability to customize information in your user profile such that you 
get only the specific information you desire when you access the My Headlines 
section of MetaLink. You can also choose to have this information sent to you 
via email. The information delivered to you falls into the following categories 
and can be personalized by product and platform: News & Notes, Knowledge 
Base, Patches, Bugs, TAR Updates, Product Lifecycle, and Forum Updates. 
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■ User Administration

Gives companies the ability to manage access of MetaLink users at the support 
identifier/CSI level. In situations where you want to restrict the access to 
certain areas of MetaLink to specific users at your site, this feature enables that 
control. For example, only internal help desk employees at your site may be 
allowed to create TARs in MetaLink. 

■ User Profile

You can update your contact information, add and remove support identifiers, 
view other users registered under the same support identifier, customize 
MetaLink, change your password, and view your license information. You will 
now have a choice of languages in which to view the MetaLink interface: 
English, German, or French. 

■ Technical Libraries

Organized by product and platform, these libraries enable you to access 
information that support analysts have determined will aid you in your 
installation and use of Oracle products (documentation, white papers, 
problem/solution articles, and more). 

■ Forums

You can post questions to technical analysts and receive responses within two 
business days. Users also share information and ideas with other Oracle users. 

■ File Access

Previously referred to as Download, this section provides you the ability to 
download patches and patch sets directly from within MetaLink. View the 
Readme files to find out which bugs have been fixed in the patch sets. 

■ Knowledge Base Search

Allows you to do a full-text search against the internal repositories within 
Oracle Support Services. Advanced searching is also available. 

■ Bug Search

Provides you with query access to published header and abstract information in 
the Oracle Bug Database. 
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Oracle Technical Support
If the manuals and MetaLink do not answer your questions, contact Oracle 
Technical Support and provide them with the following information:

1. What is the problem?

2. What were you doing when the problem occurred?

■ In which product or component is the problem occurring?

■ What operations were you performing? Is the problem reproducible? What 
are the steps you took to see the problem?

3. What is your environment?

■ What is your operating system and version?

■ What version of Oracle Enterprise Manager are you using and where is it 
installed?

■ What version of the Intelligent Agent are you using and where is it 
installed?

■ What version of the database are you using and where is it installed?

■ Where is the Management Server installed?

■ What version of the Data Collection Service are you using and where is it 
installed?

■ Provide schema, data, scripts, or any other relevant information about your 
environment. If possible, provide log files to assist in problem reproduction. 

4. What error messages and numbers did you see?

5. Turn on tracing (when available) and provide tracing information.

6. Look at log files (when available) and provide log information.
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Setting Up Logging and Tracing
The Oracle Enterprise Manager Release 2.2 system supports tracing and logging. 
Tracing is the writing of data to a display for informational purposes. Logging is the 
redirection of trace information to a file.

This appendix discusses the following topics:

■ Tracing and Logging for the Management Server

■ Tracing for the Client

■ Tracing for the Web Browser

■ Tracing for Paging

For information about logging and tracing for the Intelligent Agent, refer to the 
Oracle Intelligent Agent User’s Guide.

Tracing and Logging for the Management Server
Logging and tracing of the Management Server is specified in the 
omsconfig.properties file, located in the $ORACLE_HOME\sysman\config 
directory.

Logging and Tracing Properties
The logging and tracing properties are listed below: 

TRACING.ENABLED = <true>|<false>
Activates/deactivates tracing. Default is false.

LOGGING.ENABLED = <true>|<false>
Activates/deactivates logging. Default is false.

LOGGING.DIR = <directory_spec>
Default is $ORACLE_HOME\sysman\log.

 

Note: In order to set LOGGING.DIR to a directory of c:\temp, you 
must use "\\" and set LOGGING.DIR=c:\\temp 

If you do not, the \t in c:\temp is read as a tab character and the 
Management Server fails to start.
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TRACING.LEVEL = <oem_trace_levels> 
Set value to specify the detail of trace information to collect if tracing is enabled. 

Possible values for <oem_trace_levels> are listed below:

■ 5 - user: displays only messages of a critical or error level.

■ 3 - admin: displays user trace level messages and warning messages.

■ 2 - dev: displays all messages from admin trace level as well as informational 
and debug message

LOGGING.FILENAME = <filename>
Defaults to oms.log.0, oms.log.1, oms.log.2, and so on.

LOGGING.MAX_SIZE = <integer>
Controls the total maximum size of the log files. The value you specify for the 
LOGGING.MAX_SIZE property is in MB. Its default value is 50 and will result in 
two log files of max size 25MB. Setting the parameter to 0 indicates that a single log 
file will be used with no limit.

LOGGING.MAX_FILE_CNT = <integer>
Defines the maximum number of files the log will span at any given time. The 
cumulative size of all the files would be less than or equal to LOGGING.MAXSIZE.

Default value is 2.

If LOGGING.MAX_SIZE=0 (unlimited log size), LOGGING.MAX_FILE_CNT will 
not make sense and hence ignored.

 

LOGGING.SAVE_PREVIOUS_LOG = <true>|<false>
A true value indicates that the Management Server is to rename any existing log 
files from a previous Management Server invocation. Such log files would be 
appended with a timestamp (format: yyyyMMddHHmmss) when they are renamed.

Default value is false.

Note: LOGGING.MAX_SIZE and LOGGING.MAX_FILE_CNT control 
how much disk space is used for the Management Server log files. You 
can affect the size and disk usage of the log files with these parameters.
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Management Server Logs
The Management Server places all its trace messages in Management Server log 
files (oms.log.0, oms.log.1, oms.log.2, and so on). It writes to one log file, 
and when the log file is full, it writes to the next file, recycling the last two files.

The Management Server’s log files have size limits. By default, when the 
Management Server starts, it can only create log files with a size of 25 MB. The 
initial log file name is oms.log.0. If the file reaches its 25 MB limit, a separate log file 
is created. The separate log file name is oms.log.1. If that file reaches its 25 MB 
limit, the oms.log.0 file is deleted and a new log file, oms.log.2, is created. The 
last two log files are kept.

 

Tracing for the Client
To activate client tracing of all client applications integrated with Enterprise 
Manager, add and save the following parameters and values for the 
clientconfig.properties file, located in the 
$ORACLE_HOME\sysman\config directory. 

TRACING.ENABLED=TRUE 
TRACING.LEVEL=2 
 

In addition, for Windows NT only, open a DOS window and set the following 
environment variable: 

C:\>SET ORACLE_OEM_CLIENTTRACE=TRUE

Then start a client application from the command line using the OEMAPP script. 

For example

oemapp console

Note: When you enable logging and tracing, you automatically enable 
Backup and Data Management logging and tracing.

Important Note: When the Management Server starts, all previous log 
files of the name oms.log.* are automatically deleted. 
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Tracing for the Web Browser 
If you encounter problems bringing up Oracle Enterprise Manager in a browser, 
collect tracing information before reporting the problem to Oracle Support Services. 

To set up tracing for your browser perform the following steps: 

1. Exit your browser session 

2. Start the Java plug-in Console. 

From the Windows Start menu, click Programs-> JInitiator Control Panel. A 
window appears. 

a. Check the "Show Java Console" checkbox. 

b. In the Java Run Time Parameters box, append the following to the end of 
the line:

-DTRACING.ENABLED = TRUE -DTRACING.LEVEL = 2

c. Click the Apply button. 

d. Close the Oracle JInitiator Properties panel.

3. Restart your browser and reload Oracle Enterprise Manager. 

The Java Console window appears, showing the Java classes loaded by the 
plugin as well as any exceptions that may occur. If no exceptions are displayed, 
clear the screen (by clicking the Clear button) every 3rd or 4th screen-full of 
displayed information. 

4. If an exception appears in the Java Console window, please cut and paste it into 
a file and send it to Oracle Support Services along with a description of your 
problem. 

Note: You cannot start an application using icons or shortcuts if you 
want to trace it and redirect its output to a file.
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Tracing for Paging
The paging service can be debugged and traced separately from the Management 
Server. Tracing for the paging server is disabled by default. If tracing is enabled, the 
server writes trace statements for all telephone line handling and any successes or 
failures. Since information is logged whenever a page is sent, the log file grows 
proportionally to the number of pages sent. To delete a tracing file, you must shut 
down the paging server and delete the file.

The installation of the Oracle Enterprise Manager Paging Server provides a 
template configuration file, paging.cfg.template, located in the 
ORACLE_HOME\sysman\config directory.

1. Copy the paging.cfg.template file to the paging.cfg file, which is also 
located in the ORACLE_HOME\sysman\config directory. 

Oracle recommends copying this file (not renaming it) to retain information. If 
you do not copy this file, all comments concerning paging configuration will be 
removed. In addition, when updates to Enterprise Manager software are made, 
any configuration will be lost and not retrievable. 

2. Based on the instructions in the paging.cfg.template file, modify the 
paging.cfg file according to your tracing needs and save it. 

In the paging.cfg file, the following parameters influence the tracing:

TRACING.ENABLED
Set value for debugging purposes; paging service will then track what paging is 
occurring by writing trace statements for all telephone line handling and any 
successes or failures. 

The value can be either TRUE or FALSE. If the value is set to TRUE, you must 
specify a value for TRACEFILENAME and a value for TRACING.LEVEL. If the value 
is set to FALSE, you need not specify values for TRACEFILENAME and 
TRACING.LEVEL.

TRACING.LEVEL
Set value to specify the detail of trace information to collect if tracing is enabled.

Value can be either 5 (user level which collects critical messages and error 
messages), 3 (administrator level which collects critical, error, and warning 
messages) or 2 (developer level which collects maximum trace information).
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TRACEFILENAME
Set value for where to write tracing output if tracing is enabled. 

Oracle recommends setting the value to PAGING_LOG.TRC. By default, this file is 
located in the Paging Server’s ORACLE_HOME\SYSMAN\LOG directory.

If you specify a different directory, you must specify 
<Drive_Letter>:\\<directory_path>\paging_log.trc.  For example, if you want the 
tracing file stored in C:\temp\, set the value to C:\\temp\paging_log.trc.
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Troubleshooting the Management Server
This section contains the following topics:

■ Management Server May Not Run Correctly from a Non-Default Oracle Home

■ Management Server Does Not Start

■ Error Messages When Starting the Management Server

■ Changing Your Management Server for Client Access

Management Server May Not Run Correctly from a Non-Default Oracle Home
On Unix, if the ORACLE_HOME environment variable is not set to the Oracle home 
where the management server is running, the management server will not start 
correctly. It will try to find its class files in the default Oracle home instead of the 
correct Oracle home.

csh
To set the environment variable:

setenv ORACLE_HOME ’/usr/local/oracle’

ksh/sh
To set the environment variable:

ORACLE_HOME = ’/usr/local/oracle’
export ORACLE_HOME

On UNIX systems, the Oracle environment can also be set by calling coraenv (for 
the CSH) or oraenv (for any other shell). This shell script sets the oracle 
environment for a given identifier. This identifier can be a specific database or it can 
point to an ORACLE_HOME which contains the Management Server software. These 
scripts can be customized to include specific machine or server based settings. 

Refer to the specific operating system’s Oracle Administration documentation for 
more information about the coraenv and oraenv scripts. 
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Management Server Does Not Start
For information to troubleshooting the Management Server if it does not start, refer 
to the following resources:

■ the oms.log file

■ the oms.nohup file

■ the Windows NT Event Log (for Windows NT)

■ OEMCTRL batch file

oms.log File
The $ORACLE_HOME\sysman\log directory contains the output of traces that are 
redirected to disk. This directory contains the oms.log and oms.nohup files. 

The Management Server places all its trace messages in oms.log file. The oms.log 
file contains messages generated when the Management Server is starting and 
running.

oms.nohup File
The oms.nohup file in the $ORACLE_HOME/sysman/log directory contains 
Management Server error messages which appear before the Management Server 
starts up and critical messages during its run. 

Windows NT Event Log 
To access the Windows NT Event Log to view the events logged by the 
Management Server. 

1. From the Start menu->Programs->Administrative Tools (Common), select the 
Event Viewer item or search for eventvwr.exe.

2. Select Application from the Log menu.

3. When the log screen appears, double-click any event logged by the 
Oracle<Oracle_Home_Name>ManagementServer service which has red 
octagonal stop signs next to them. These will be the errors reported by the 
Management Server, if any. 
D-12 Oracle Enterprise Manager Configuration Guide                             



Troubleshooting the Management Server
Events and event numbers which the Management Server can log in the event 
viewer are listed below:

Errors will only be reported in the Event Viewer if the Management Server is 
voluntarily shutting down.

Event Number Message Meaning

101 (OracleEM22ManagementServer) could not 
be found. It contains the following insertion 
string(s): OracleEM22ManagementServer.

Problem starting service. 
Look at log and trace files 
for more information

105 The service was started. Informational message

108 The service was stopped Informational message

110 The service is entering production run 
mode

Informational message

112 The service has terminated abnormally. See the oms.log file for 
more information.

113 Fatal error

Process terminated abnormally

See log file for more 
information.
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OEMCTRL Batch File
To obtain more information for debugging, you can change the JRE startup 
command in the OEMCTRL script. 

■ On Windows, change

SET JRE=jre -nojit -mx32m

to

SET JRE=jre -nojit -mx32m -verbose

■ On Unix, change

JRE="jre -native -nojit -mx32m "

to

JRE="jre -native -nojit -mx32m -verbose "

Performing this procedure enables you to identify class loading problems caused by 
environmental or installation problems. When you have collected the data from the 
batch file, send the information to Oracle Support Services. 

Note: If you encounter problems starting the Management Server, turn 
on tracing for the Console first. If you still cannot determine what the 
cause is, perform other troubleshooting procedures before using the 
OEMCTRL batch file procedure.
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Error Messages When Starting the Management Server
If you receive the following error when starting the Management Server, refer to the 
solutions below:

Could not start the Oracle<ORACLE_HOME_NAME>ManagementServer service on <HOST 
NAME>.  
Error 0203:  The system could not find the environment option that was entered.

■ The Management Server has been installed but not configured. You must run 
the Enterprise Manager Configuration Assistant to create a new repository or to 
edit an existing repository. 

For Windows NT: The Enterprise Manager Configuration Assistant has been 
run, and you have chosen to not save the repository connection’s username and 
password to a file (in secure Management Server mode). You must select the 
Oracle<ORACLE_HOME_NAME>ManagementServer service and then enter 
the username and password in the Control Panel’s Startup Parameters' field or 
you must enter the repository credentials when you are prompted for them in a 
dialog. 

Changing Your Management Server for Client Access
If a Management Server fails in a multi-Management Server environment, it only 
affects the clients connected to it. Each Management Server is independent of the 
other Management Servers connected to the repository.

To change your Management Server node to another node where a Management 
Server is still running, follow the procedure below. 

1. In the Oracle Enterprise Manager login, select a node that has a Management 
Server which is configured with the repository you want to access from the 
Management Server pull-down list. 

If the node name where the Management Server is running does not appear in 
the pull-down list, follow the instructions below: 

a. Click the Management Servers button. The Management Servers dialog 
appears. 

b. Click the Add button. The Add Management Server dialog appears. 

c. Type in the name of the node where the Oracle Management Server is 
running that is configured with the repository you want to access and click 
OK. 
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d. Select the node where the Oracle Management Server is running from the 
pull-down list.

2. On each machine which runs Oracle Enterprise Manager through a web 
browser, return to the EmWebSite.html page to change the machine name to 
point to the node where a management server is running. You cannot simply 
enter a new Management Server machine name at the Oracle Enterprise 
Manager Login screen.
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Troubleshooting the Paging Service

Page Notification Fails 
If a page notification fails, the paging service will try to resend the page three more 
times. The interval of time between these retries is a value that can be altered. By 
default, the interval of time between retries is 1 minute. You can change this default 
setting by editing the OMSCONFIG.PROPERTIES file located in the Management 
Server’s ORACLE_HOME\sysman\config directory. Users can add the property 

OEM.PAGING.RETRYINTERVAL=<integer> 

to the OMSCONFIG.PROPERTIES file and replace <integer> with the number of 
minutes between retries. 

Troubleshooting the Web Browser
If you start the web browser, log in to the Console, but the Console hangs, and the 
following is displayed in JInitiator Console:

@org.omg.CORBA.INITIALIZE[completed=MAYBE, reason=java.net.BindException: 
Cannot assign requested address]

You must perform the following steps:

1. Check that the JInitiator uses browser settings for the proxy. 

a. From the Windows Start menu, click Programs-> JInitiator Control Panel. A 
window appears. 

b. Choose the Proxies tab. 

c. View the contents.

2. Append the domain name to the webserver address you type in the browser, 
e.g. @.us.oracle.com

3. Edit the browser settings and add that domain to "no proxy settings for" or edit 
the browser settings and choose Direct Connection to Internet.
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Resetting the Password
If you forget your SYSMAN password and need to reset it to oem_temp, follow the 
instructions below:

You must first be connected to the Management Server repository (via SQL*Plus) 
before using the reset_sysman() procedure.

1. Start SQL*Plus from the command line by typing:

sqlplus

2. When you are prompted for the connection information, type:

<emrepository>/<emrepository-pwd>@<em-repository> 

to connect to the database.

For example: 

mynode/mypassword@mynode.world

since the default repository name is the hostname.

3. Then type: 

execute smp_maintenance.reset_sysman(); 
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Troubleshooting the Enterprise Manager Configuration Assistant

Enterprise Manager Configuration Assistant Errors 
This section describes the Enterprise Manager Configuration Assistant error 
messages and their probable causes, and provides the actions recommended to 
correct them.

Configuration File Not Accessible
If the omsconfig.properties file is not writable, the "Configuration File Not 
Accessible" page appears. Please refer to Configuration File Not Accessible on page 
B-12 for more information. 

The Database User You Chose Does Not Have the Necessary DBA Privileges
When you login as a DBA user on a selected database, the Configuration Assistant 
checks whether the user has the necessary privileges. If the user does not have the 
necessary DBA privileges, a message appears: "The database user you chose does 
not have the necessary DBA privileges. Logon to the database as a user with DBA 
privileges." Click OK to dismiss the message box. You must enter the proper 
credentials in order to continue. Enter the credentials and try again.

Select Database for Repository Login is Unsuccessful
If you have entered an invalid username, password, or service, an error message 
indicating the failure appears. For example: "Connection failed ORA-01017: Invalid 
username/password; logon denied" message appears. Click OK to dismiss the 
message box. Enter the data and try again.

The User Already Exists
The user already exists, and already contains an incomplete Enterprise 
Management Release 2 repository. A repository create, drop, or upgrade operation 
may be in progress, or a previous operation may have failed. Continuing the current 
operation can replace incomplete components and create missing components in the 
repository. 

What would you like to do? 

■ Select another user. 

■ Continue and use the selected repository. 

If a repository operation is already actively in progress elsewhere, do not continue. 
Attempting to perform simultaneous operations on the same repository may cause 
repository corruption. 
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The user "<username>" already contains a complete and up-to-date Enterprise 
Manager V2 repository
The user "<username>" already contains a complete and up-to-date Enterprise 
Manager Release 2 repository. If you wish to overwrite the existing repository, first 
use the Drop option. 

The User Already Exists and Contains a V1 Repository
If the Oracle Enterprise Manager Configuration Assistant detects that the chosen 
repository name is the name of an already existing user/schema in the database and 
that it contains an Oracle Enterprise Manager Release 1.x repository, a message 
appears: “The user already exists and contains a V1 repository. A V2 repository may 
not coexist with a V1 repository in the same schema. Please choose another user 
name.”

The User Already Exists in this Database
If the Oracle Enterprise Manager Configuration Assistant detects that the chosen 
repository name is the name of an already existing user/schema in the database, 
and that it contains neither an Oracle Enterprise Manager Release 2.x nor Release 
1.x repository, a message appears: "The user already exists in this database. Do you 
wish to create the repository within this user’s schema anyway?" 

If you choose no, you may select a different user name. 

If you choose yes, the "Create Repository Summary" page appears. Refer to Step 5 
"Create Repository Summary" on page 2-16 for more information.

The Management Server on this Machine is Currently Managing a Repository 
Owned by user <user_name> on service <service_name>
During create repository, if the Configuration Assistant detects that a managed 
repository is already specified in the omsconfig.properties file, and you are 
creating a repository that is different from the managed repository, a message 
appears: "The Management Server on this machine is currently managing a 
repository owned by user <user_name> on service <service_name>. Would you like 
to change it to now manage the repository owned by user <user_name> on service 
<service_name>?" 

If you choose yes, the configuration will be updated. The Management Server must 
be stopped and restarted in order for the changes to the configuration file to take 
effect. If you choose no, the configuration will not be updated. The “Create 
Repository Summary” page and the steps in the Configuration Assistant Progress 
Window will reflect your choices. 
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You have chosen the user’s default or temporary tablespace to be SYSTEM.
Note that the Configuration Assistant, when it creates the user for an Oracle 
Enterprise Manager repository, asks you for the default and temporary tablespaces 
to use. If you choose SYSTEM for either of these, Configuration Assistant puts up 
the following warning: "You have chosen the user’s default or temporary tablespace 
to be SYSTEM. We recommend the SYSTEM tablespace be used only for data 
dictionary tables and the SYSTEM rollback segment. Are you sure?" Pick another 
tablespace. 

The Default Tablespace for the Repository Does Not Contain Enough Free Space
If the Oracle Enterprise Manager Configuration Assistant detects that the default 
tablespace for the repository does not contain enough free space, the following 
message appears: "The default tablespace for the repository does not contain 
enough free space." Refer to Repository Database Default Tablespace Does Not 
Contain Enough Free Space on page D-22 for information for possible solutions.
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Repository Database Default Tablespace Does Not Contain Enough Free Space
The Configuration Assistant checks that the selected default tablespace for the 
repository has the appropriate attributes/characteristics, but if it does not contain 
enough free space, the following message appears: "The default tablespace for the 
repository does not contain enough free space."

Use the OEM_REPOSITORY tablespace if it exists. It is the default tablespace for 
Enterprise Manager. 

If you are creating a repository in a new user, the Configuration Assistant’s Select 
Repository User Tablespaces screen strongly encourages you to create an 
OEM_REPOSITORY tablespace. Using the Enterprise Configuration Assistant to 
create the OEM_REPOSITORY tablespace ensures that the tablespace has 
appropriate attributes/characteristics.

However, if you prefer, you can create another tablespace, or use an existing 
tablespace. If you decide to use an existing tablespace, you may have to increase its 
size.

Refer to Appendix E, "Repository Sizing" to determine storage requirements and 
disk space allocation for your Oracle Enterprise Manager repository.

Creating an OEM_REPOSITORY Tablespace if One Does Not Exist
If the OEM_REPOSITORY tablespace has not been created for you, the "Create a new 
OEM_REPOSITORY tablespace (recommended)" option is available on the "Select 
Repository User Tablespaces" page of the Enterprise Manager Configuration 
Assistant.

Select this option if you want to create the OEM_REPOSITORY tablespace. Using 
the Enterprise Manager Configuration Assistant to create the OEM_REPOSITORY 
tablespace gives that tablespace appropriate attributes/characteristics. Then use it 
as the user's default tablespace. 

Note: You do not have to exit from the Configuration Assistant when 
using DBA Studio’s Storage Management tool to create another 
tablespace or increase the size of an existing tablespace.
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Creating Another Tablespace
Using the Configuration Assistant is the preferred method for creating a tablespace 
since it creates the tablespace with the proper attributes in any of the supported 
databases. The attributes of the default tablespace depend on the database version. 

To use DBA Studio’s Storage Management tool to create a new tablespace, follow 
the procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> Database 
Administration->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases and press 
OK. 

2. Double-click the database node in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Select Create from the Object menu, then Tablespace, and click Create. The 
Create Tablespace property sheet appears.

4. In the Create Tablespace Property Sheet’s General page, enter the name of the 
new tablespace and specify that the tablespace will be used to hold permanent 
database objects.

5. In the Datafile section, enter the size of the new datafile. The File Name and File 
Directory columns should already contain default entries. 

6. Right-click the "+" sign which appears next to the name of the datafile 
(<name>.ora) and choose Edit, double-click the datafile row, or choose the Edit 
button (pencil icon). The Create Datafile property sheet appears.

7. In the Create Datafile’s Storage page, select the "Automatically extend datafile 
when full (AUTOEXTEND)" box so that the datafile will automatically increase 
in size when more space is needed in the database. 

8. Click the OK button in the Create Datafile property sheet.
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9. In the Create Tablespace Property Sheet’s Storage page, choose a method of 
space management. You cannot alter the method at a later time. 

10. Click the Create button in the Create Tablespace Property Sheet.

Increasing the Size of an Existing Tablespace
Using the Configuration Assistant is the preferred method for creating a tablespace 
since it creates the tablespace with the proper attributes in any of the supported 
databases. The attributes of the default tablespace depend on the database version. 

To use DBA Studio’s Storage Management tool to increase the size of an existing 
tablespace, follow the procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> Database 
Administration->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases and press 
OK. 

2. Double-click the database node in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Expand the Storage Management node.

4. Double-click the datafile you want to increase from the Datafiles folder. The 
General page of the Datafile property sheet appears, allowing you to edit the 
file size of the datafile. 

5. Click the Apply button in the General page.

6. Click on the Storage tab. The Storage page of the Datafile property sheet 
appears.

7. Check the "Automatically extend datafile when full (AUTOEXTEND)" box and 
click the Apply button.
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Database Parameters Not Large Enough for Repository Operation
An Oracle Management Server will open a number of repository database sessions 
while processing work on behalf of clients and managed nodes. 

The number of sessions required by a single Management Server generally ranges 
from 3 to 5, depending on the load placed on the Management Server. More 
repository database sessions may be required under the following circumstances: 

■ many Consoles are actively submitting jobs/registering events 

■ multiple Management Servers are concurrently using the same repository 

■ many Intelligent Agents are sending notifications back to the Management 
Servers

If other applications are accessing the same database used for the Enterprise 
Manager Repository this will increase the session load on the database and should 
be considered when setting up the database. 

If your processes setting is too low for Oracle Enterprise Manager, you will receive 
an error message similar to the following in the oms.log file located in the 
Oracle_OEM_Home/sysman/log directory.

can’t open a session

For large workloads, or for cases where multiple applications are accessing the 
database where the repository resides, you can increase the processes parameter in 
the database init.ora to accommodate the workload. 

To use Instance Management tool to change your database parameters, follow the 
procedure described in this section:

1. Start the DBA Studio in standalone mode.

■ On Windows NT:

You can start the DBA Studio from the Windows Start 
Menu->Programs->Oracle-<Oracle_Home_Name>-> Database 
Administration->DBA Studio.

■ On UNIX:

You can start the DBA Studio from the command line using the command:

oemapp dbastudio

When the login dialog appears, choose Connect directly to databases, and press 
OK. 
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2. Double-click the database node in the DBA Studio navigator tree and connect to 
the database as a user with the SYSDBA privilege.

3. Expand the Instance Management node.

4. Click the All Initialization Parameters button in the Database Property Sheet’s 
General page. 

5. Change the value of the parameter.

6. Click Save As button on the All Initialization Parameters page. The Save 
Initialization Parameters dialog appears.

7. Enter the complete directory path and a file name or use the Browse button to 
find a location on your local operating system to place the file and enter the file 
name.

8. Press OK to save the file.
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Changing the Permissions on the omsconfig.properties File
If you have chosen to store your repository credentials in the 
omsconfig.properties file during repository creation, you may want to change 
the permissions on the file to restrict who can view it. 

If you change the file permissions, other users cannot view the file. 

UNIX:
To change the file permissions, at the command prompt, enter:

$ chmod 600 omsconfig.properties 

This command sets the read and write permissions only for the owner of the file.

Windows NT:
To change the file permissions, perform the following steps.

1. From the Start menu->Programs, select the Windows NT Explorer item.

2. From Oracle_Home/sysman/config directory, select the 
omsconfig.properties file.

3. Right-click the selected file, and then choose the Properties item in the resulting 
pop-up menu.

4. Select the Security tab from the Properties dialog. Note: This step only applies 
to NTFS file systems.

5. Press the Permissions push-button on the Security page to display the File 
Permissions dialog. The default is "Everyone" has Full Control (All). The type of 
Access is Full Control. 

6. Click the Remove button to remove this entry. 

7. Click the Add button to display the Add Users and Groups window. 

8. Click the Show Users button to view all users. 

Note: The repository credentials stored in the 
omsconfig.properties file do not expose plain text passwords. The 
password, if present, is encrypted in that file.
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9. Select the user who starts the Management Server regularly and uses the 
Enterprise Manager Configuration Assistant for the "type of access" field and 
select "select full control" from the drop down list. 

10. Click the OK button to dismiss the Add Users and Groups dialog. 

11. Click the OK button to dismiss the File Permissions dialog.

12. Click the OK button to dismiss the file Properties dialog.

You can provide access to multiple usernames.
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Determining the SGA Size
The two primary factors in determining SGA size are: 

■ amount of RAM available to the instance, and 

■ the amount of activity you expect on the instance. 

The amount of RAM available to the instance is memory dedicated to the 
repository’s instance. This must not include memory needed for other instances and 
applications on the repository host node. The amount of activity includes all active 
(submitted) jobs, active (registered) events, hosts monitored, and connected 
administrators. As activity increases, so will the demands on the instance.

If the instance is dedicated to the Management Server repository, the basic 
minimums are listed below:

db_block_size = 2048             # EM is a strict OLTP application

db_block_buffers = 2048           # **May need increase under heavy load**

sort_area_size = 128000           # **May need increase under heavy load**

sort_area_retained_size = 128000  # **May need increase under heavy load**

log_buffer = 64000               # **May need increase under heavy load**

The Management Server repository transactions tend to be short, so rollback space 
usually is not a problem. Watch your redo log size and log_buffer size if a high 
transaction (activity per above) rate is expected.
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Troubleshooting Job Notifications
Problem
The job notifications are not being delivered and the Console status remains in 
scheduled. Sometimes the jobs work and sometimes the jobs fail. Resubmitting one 
of the jobs results in a "job already submitted" error.

Solution
The Intelligent Agent may be delivering job status/output for the job to two 
different Consoles operating at different IP addresses. 

Another Enterprise Manager installation is probably running on another node with 
the same repository name as the first node. Some job notifications are delivered to 
the first node and some notifications to the second node, depending on which 
machine last registered itself. You must check what is running on the nodes and 
decide which one is your Management Server. 
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Repository Sizing

This appendix provides guidelines for determining storage requirements and disk 
space allocation for your Oracle Enterprise Manager repository.

Space requirements can vary greatly as a result of what Oracle Enterprise Manager 
tools you are licensed to use and the amount of data generated by the work you 
perform. In addition, the growth of the repository could vary slightly depending 
upon the database version (release 8.1.6 versus release 8.0.6, etc.) in which the 
repository is created. 

If you choose to create a new repository from a typical installation session and 
accept the default configuration for that new repository; then, a new tablespace is 
generated labeled OEM_REPOSITORY. The OEM_REPOSITORY tablespace 
contains repository objects for the Oracle Enterprise Manager Console, DBA 
Management Pack and all separately licensable Packs regardless if you have 
installed or purchased licenses for them. In addition, depending on the database 
version in which the repository is created, the repository could initially allocate 
between 6 - 26 MB of hard disk space.

Depending on how you actually use Oracle Enterprise Manager products, the 
repository size may increase. To determine by how much your repository could 
grow, refer to the table below. To accommodate an increase in repository size, the 
default OEM_REPOSITORY tablespace is automatically configured to autoextend. 
For example, if you have created the default OEM_REPOSITORY tablespace which 
allocates 4 MB for using Capacity Planner for a single, small database, but you 
actually plan to use Capacity Planner on a more regular basis - for example, for 
three large databases - then you should expect the size of your repository to 
increase by approximately 16 MB. In such situations, the tablespace would 
autoextend automatically to accommodate the increase. 
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If you choose to create a new repository from a typical installation session and want 
to use an existing tablespace, follow these steps to determine how much disk space 
the repository will use:

1. Review the "Product" column to find the products you are using.

2. Identify those actions you perform with each product in the "If you…" column.

3. Add the corresponding hard disk space requirements for those actions from the 
"then allocate…" column. The total of these requirements is the expected size of 
your repository.

Product If you... Then allocate...

Oracle Enterprise 
Manager Console and 
DBA Management Pack

■ use only the Console 
and DBA Management 
Pack

■ save little (if anything) 
in job history

4 - 9 MB

Oracle Diagnostics Pack ■ collect less than 4 MB 
of Trace Data

■ use Capacity Planner 
for a single, small 
database over a few 
days 

8 MB

■ collect between 4 - 20 
MB of Trace Data

■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

30 MB

■ collect between 20 - 60 
MB of Trace Data

■ use Capacity Planner 
for up to three large 
databases over several 
months

80 MB
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Oracle Tuning Pack save less than:

■ 50 tuned SQL 
statements

■ 5 scoped tuning 
sessions

■ 10 tablespace jobs in job 
history

less than 15 MB

save between:

■ 50 - 150 tuned SQL 
statements

■ 5 - 15 scoped tuning 
sessions

■ 10 - 30 tablespace jobs 
in job history

15 - 45 MB

save more than:

■ 150 tuned SQL 
statements

■ 15 scoped tuning 
sessions

■ 30 tablespace jobs in job 
history

more than 90 MB

Oracle Change 
Management Pack

■ for a schema with 
approximately 500 
objects:

1 baseline, with 2 saved 
versions of baseline

1 saved comparison

1 change plan 
(propagate the schema)

10 MB

Product If you... Then allocate...
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■ for a schema with 
approximately 500 
objects

2 baselines, with 2 
saved versions of 
baseline

2 saved comparisons

■ 5 change plans

25 MB

■ for a schema with 
approximately 500 
objects

5 baselines, with 2 
saved versions of 
baseline

5 saved comparisons, 
with 2 versions each

■ 10 change plans

50 MB

Oracle Management Pack 
for Oracle Applications

■ use Capacity Planner 
for a single, small 
database over a few 
days

4 MB

■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

10 MB

■ use Capacity Planner 
for up to three large 
databases over several 
months

20 MB

Oracle Management Pack 
for SAP R/3

■ use Capacity Planner 
for a single, small 
database over a few 
days

4 MB 

Product If you... Then allocate...
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■ use Capacity Planner 
for a single, 
medium-sized database 
over several months

10 MB

■ use Capacity Planner 
for up to three large 
databases over several 
months

20 MB

Oracle Standard 
Management Pack1

■ for a schema with 
approximately 500 
objects:· 

1 baseline, with 2 saved 
versions of baseline· 

1 saved comparison

10 MB

■ for a schema with 
approximately 500 
objects· 

2 baselines, with 2 
saved versions of 
baseline· 

2 saved comparisons

20 MB 

■ for a schema with 
approximately 500 
objects· 

5 baselines, with 2 
saved versions of 
baseline· 

5 saved comparisons, 
with 2 versions each

40 MB

1 While the other separately licensable Packs are available with Oracle8i Enterprise Edition, the Oracle 
Standard Management Pack is only available with Oracle8i standard edition.

Product If you... Then allocate...
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For example, if you: 

■ use the Console and DBA Management Pack regularly but typically do not save 
large output to the job history (approximately 7 MB)

■ collect approximately 45 MB of Trace Data (approximately 45 MB)

■ use Capacity Planner very little (approximately 4 MB)

■ save approximately 100 tuned SQL statements, 11 scoped tuning sessions and 
25 tablespace jobs in job history (approximately 32 MB)

The total of all these space allocations (7 MB + 45 MB + 4 MB + 32 MB) is 88 MB. 
Thus, you can expect to allocate approximately 88 MB for your repository.

Important: This is only a guideline based upon default configuration of 
the Oracle Enterprise Manager environment; any custom configuration 
done may significantly affect repository sizing requirements. What 
applications you are actually using in the Console and the various Packs; 
how you have configured certain parameters, etc., all will affect how 
much disk space the repository will require. For instance, the default 
sampling frequency for Oracle Diagnostics Pack is five minutes. If you 
reduce the sampling frequency then you will need to allocate more disk 
space. How much you save in the job history will also affect the amount 
of space necessary for the repository. If you have large outputs of 40-50 
MB and you save those in job history, then you should allocate an 
additional 40-50 MB of disk space.
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Configuring the Webserver and Directory

Mapping

If you are installing the Oracle Enterprise Manager Web Site without the Oracle 
HTTP Server that is packaged with Enterprise Manager by default, configure your 
supported webserver with the instructions below.

■ Apache 1.3.9 and higher on Unix

■ Internet Information Server (IIS) 4.0 on Windows NT or Windows 2000
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Apache 1.3.9 or Higher on Unix
1. Install the Enterprise Manager web site without the Oracle HTTP Server. 

2. Install Apache 1.3.9 or higher. Consult your Apache-specific configuration 
documentation for detailed information.

3. Edit the httpd.conf in the Apache home -> conf ->httpd.conf/. Stop and 
restart the web listener.

4. ScriptAlias controls which directories contain server scripts. ScriptAliases are 
essentially the same as Aliases, except that documents in the realname directory 
are treated as applications and run by the server when requested rather than as 
documents sent to the client. 

The same rules about trailing "/" apply to ScriptAlias directives as to Alias. 

ScriptAlias /oem_webstage/cgi-bin
"/private/oemv2/oem_webstage/cgi-bin"

5. Add as many aliases as you need (with no limit). The format is 

Alias fakename realname

Note that if you include a trailing "/" on fakename, then the server requires that 
it is present in the URL. In this example, "/icons" is not aliased.  "/icons/" is 
aliased. 

Alias /icons/ "/usr/local/apache/icons/" 
Alias /oem_webstage "/private/oemv2/oem_webstage/" 

6. Change "/apache/cgi-bin" to where your ScriptAliased CGI directory exists, if 
you have that configured. 

<Directory "usr/local/apache/cgi-bin"> to

<Directory "/oem_webstage/cgi-bin">

AllowOverride all 

Note: /private/oemv2/ is your Oracle Home.

Note: /private/oemv2/ is your Oracle Home.
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Allow from all 
</Directory> 

AddHandler allows you to map certain file extensions to "handlers", actions 
unrelated to filetype. These can be either built into the server or added with the 
Action command. 
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Internet Information Server (IIS) 4.0
To use the Internet Information Server, you will need to create three virtual 
directories pointing to the oem_webstage directory and two subdirectories inside of 
that directory. The oem_webstage directory is created automatically by the 
installation procedure when you install the Oracle Enterprise Manager Web Site 
components during one of the following installations:

■ Oracle8i Enterprise Edition 8.1.7.0.0-> Custom 

■ Oracle8i Management and Integration 8.1.7.0.0-> Oracle Management Server 

■ Oracle8i Management and Integration 8.1.7.0.0-> Custom 

1. Install the Enterprise Manager web site without the Oracle HTTP Server. 

2. Install Internet Information Server (IIS) 4.0. Consult your 
Internet-Information-Server-specific configuration documentation for detailed 
information.

3. From the Windows NT Program Start Menu, select Microsoft Internet 
Information Server 4.0->Internet Service Manager to configure the Internet 
Information Server. The "Microsoft Internet Service Manager" screen is 
displayed. 

4. Click on "Default Web Site" and right mouse-click to display the associated 
submenu. 

5. Click on "Properties" to display the Properties sheet of the Default Web Site. 

6. Verify that the IP address of the node is correctly set in the Properties sheet. 
Then click "Ok". 

7. Select New, Virtual Directory.

8. Enter the name of the virtual directory. For example, oem_webstage. 

9. Specify the following settings:

Alias: /oem_webstage

Path: ORACLE_HOME\oem_webstage

Access: Read, Execute

10. After saving the settings, expand the "Default Web Site" to display the new 
virtual directory.

11. Select the new oem_webstage virtual directory.
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12. Click on the Action button, select New, Virtual Directory to create a additional 
virtual directory with the following settings:

Alias: cgi-bin

Path: ORACLE_HOME\oem_webstage\cgi-bin

Access: Read, Execute

13. Create an additional virtual directory with alias "\oem_webstage\java-plugin" 
and directory ORACLE_HOME\oem_webstage\java-plugin with the 
following settings:

Alias: java-plugin

Path: ORACLE_HOME\oem_webstage\java-plugin

Access: Read-only

Note: Make sure you do not enable execute permissions; otherwise, you will not 
be able to download the plug-in.
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Keyboard Shortcuts

This appendix provides a list of general Windows keyboard shortcuts. For a 
complete list of Windows keyboard shortcuts and navigation, refer to your 
operating system documentation.
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Figure G–1 General Windows Keyboard Shortcuts

Key Action

F1 Displays Help information for the active object or the window as a whole.

WINDOWS LOGO KEY OR CTRL+ESC Opens the Start menu located on the taskbar.

CTRL+ALT+DELETE In Microsoft Windows, opens the Close Program dialog box, which 
contains a list box of applications to be closed and the command buttons 
End Task, Shut Down, and Cancel.

In Microsoft Windows NT, opens the Windows NT Security dialog box, 
with the following options: Lock Workstation, Logoff, Shut Down, Change 
Password, Task Manager, and Cancel. If you are not logged on, opens the 
logon dialog box.

DELETE Deletes the selected item(s). If the items are files, moves them to the 
Recycle Bin.

SHIFT+DELETE Delete the selected item(s). If the items are files, destroys them 
immediately without moving them to the Recycle Bin.

CTRL+N Opens the New dialog box. (You also can choose the New command from 
the File menu.)

CTRL+O Opens the Open dialog box. (You also can choose the Open command from 
the File menu.)

CTRL+P Opens the Print dialog box. (You also can choose the Print command from 
the File menu.) 

CTRL+S Opens the Save dialog box. (You also can choose the Save command from 
the File menu.)

CTRL+X Cuts the selected item(s) to the Clipboard. (You also can choose the Cut 
command from the Edit menu.)

CTRL+INSERT OR CTRL+C Copies the selected item(s) to the Clipboard. (You also can choose the Copy 
command from the Edit menu.)

SHIFT+INSERT OR CTRL+V Pastes the copied items(s) from the Clipboard. (You also can choose the 
Paste command from the Edit menu.)

ALT+BACKSPACE OR CTRL+Z Undoes the last action. Note that not all actions, such as shutting down, 
can be undone. (You also can choose the Undo command from the Edit 
menu.)

ALT+SHIFT+BACKSPACE Redoes the previously undone action. (You also can choose the Redo 
command from the Edit menu.)
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WINDOWS LOGO KEY+M Minimizes all open windows. The keyboard focus goes to the least recently 
selected icon on the desktop. Add SHIFT to expand previously opened 
windows and return focus to the most recently used application. 

Key Action
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differences between Release 1.x repository and 
Release 2.2 repository, 7-4

important notes, 7-3
migration phases, 7-3
preparing for repository migration, 7-8
starting, 7-12

migration phases, 7-3

O
OEM_REPOSITORY tablespace, 2-14, D-22
oem_temp password, 1-7
oemapp console command, 6-3
oemclient.properties, A-2
oemctrl start oms command, 3-4
oemctrl status oms command, 3-5
oemctrl stop oms command, 3-8
omsconfig.properties file, 2-4, A-2, B-12, D-5
Oracle Enterprise Manager

admin directory, A-2
architecture, 1-2
config directory, A-2
Console, 1-6, 1-8, 6-1, 6-3, 6-17
dbapp directory, A-2
directory structure, A-1
ifiles directory, A-2
Intelligent Agent, 1-6, 1-8
log directory, A-2
management server, 1-8, 3-1, 3-2, 3-5, 3-8
mesg directory, A-2
readme directory, A-2
report directory, A-2
repository, 1-7
repository owner, 1-7
system and hardware requirements, 1-11
temp directory, A-2
tracing and logging, D-5

Oracle HTTP Server, 6-11
Oracle Support, reporting problems to, D-2

P
paging configuration properties

TRACEFILENAME, D-10
TRACING.ENABLED, D-9
TRACING.LEVEL, D-9

paging notification preferences, specifying, 6-27
paging service

querying status, 6-29
setting up, 6-22
stopping, 6-29

paging status codes for numeric pages, 6-38
paging.cfg, D-9
paging.cfg.template, A-2, D-9
                                                                      Index-3



password file, 6-43
password, resetting, D-18
preferred credentials

definition, 1-10
preferred credentials for managed services, setting 

up, 6-20
preferred credentials, setting local, 8-9

R
readme directory, A-2
remote SYSDBA access, 6-43
report directory, A-2
reporting problems to Oracle Support, D-2
repository

definition, 1-7
sizing, E-1

Oracle Change Management Pack, E-3
Oracle Diagnostics Pack, E-2
Oracle Enterprise Manager Console and DBA 

Management Pack, E-2
Oracle Management Pack for Oracle 

Applications, E-4
Oracle Management Pack for SAP R/3, E-4
Oracle Standard Management Pack, E-5
Oracle Tuning Pack, E-3

repository credentials, saving, 2-11
repository migration

backing out of, 7-23
backing up existing Release 1.x repository, 7-11
checking information in Release 1.x 

repository, 7-10
confirming a successful migration, 7-21
deleting and deregistering active jobs and 

events, 7-20
differences between Release 1.x and Release 

2.2, 7-4
important notes, 7-3
phases, 7-3
preparing for, 7-8
Release 1.x objects reference, 7-24

repository owner
definition, 1-7

repository, dropping, B-6
resetting password, D-18

S
security login, 6-4
service discovery, 6-5

definition, 1-9
setting up

Console, 6-17
email notification, 6-31
ORACLE_HOME environment variable, 3-4, 

D-11
paging service, 6-22
preferred credentials for managed services, 6-20
tracing and logging, D-5
Windows domain user, 6-19
Windows user account, 6-17

SID (database system identifier), 2-9
SMTP mail

address, 6-31
gateway, 6-31

SMTP mail gateway, 6-31
starting

Configuration Assistant, 2-6
Console, 6-3

from command line, 6-3
from web browser, 6-8
from Windows Start menu, 6-3

DBA Studio, 8-1
Intelligent Agent

UNIX, 5-4
Windows, 5-2

management server, 3-1, 3-2
Migration Assistant, 7-12
Oracle Enterprise Manager from a web 

browser, 6-8
service discovery, 6-5

stopping
Intelligent Agent

UNIX, 5-4
Windows, 5-2

management server, 3-8
paging service, 6-29

Super Administrator, 6-6
sysman account, 1-7
system and hardware requirements

characteristics of best environment, 1-11, 1-12
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running Enterprise Manager components on 
separate machines, 1-11

running the entire Enterprise Manager bundle 
from a single machine, 1-11

T
tablespace

creating, D-23
increasing the size of an existing, D-24
OEM_REPOSITORY, 2-12
ROLLBACK, 2-12
SYSTEM, 2-12
TEMPORARY, 2-12

temp directory, A-2
TRACEFILENAME, D-10
tracing, D-5

for the client, D-7
for the management server, D-5
for the web browser, D-8

TRACING.ENABLED, D-5, D-9
TRACING.LEVEL, D-6, D-9
troubleshooting

changing the permissions on the 
omsconfig.properties file, D-27

Configuration Assistant, D-19
database parameters not large enough for 

repository operation, D-25
determining the SGA size, D-29
job notifications, D-30
management server, D-11

changing for client access, D-15
management server does not start from the 

Windows Start Menu, D-12
management server may not run correctly 

from a non-default Oracle Home, D-11
setting the ping interval, 3-9

paging service
page notification fails, D-17

providing Oracle Technical Support with 
information, D-4

reporting problems to Oracle Support, D-2
repository database default tablespace does not 

contain enough free space, D-22
resetting password, D-18

tracing and logging for the management 
server, D-5

tracing for client applications integrated with 
Enterprise Manager, D-7

using MetaLink, D-2
web browser, D-17

W
web browsers, supported, 6-9
webservers, supported, 6-11
Windows user account

assigning privileges to, 6-18
creating, 6-17
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